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Declaration of Conformity

Manufacturer’s Name: Fractal Audio Systems, LLC
Manufacturer's Address: 4 Wilder Drive, Plaistow, NH 03865 USA

Declares that the product:
Product name: FM9 Product option: None

Conforms to the following Product Specifications:

Safety: EN60065:2014
EMC: EN55013:2013
EN55020:2007+A11:2011
EN55024:2010
EN61000-3-2:2014
EN61000-3-3:2013

Supplementary Information:
The product herewith complies with the requirements of
the Low Voltage Directive 2006/95/EC
and the EMC Directive 2004/108/EC.

Clifford Chase
President / CEQ
April 5, 2021

EMC/EMI

This equipment has been tested and found to comply with the limits for a Class B Digital device, pursuant
to part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in residential installations. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to
radio communications. There is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can be determined
by turning the equipment off and on, the user is encouraged to try to correct the interference by one or
more of the following measures:

4
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Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.
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Fractal Audio Systems FM9 Owner’s Manual. Contents Copyright © 2021. All Rights Reserved.
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mportant Safety Instructions

WARNING: To reduce the risk of fire or electric shock, do not expose this appliance to rain or
moisture.

CAUTION: To reduce the risk of fire or electric shock, do not remove screws. There are no user
serviceable parts inside. Refer servicing to qualified service personnel.

—_

Obey all warnings on the FM9 chassis and in this User Guide.

Keep away from sources of heat such as ducts, registers or appliances that produce heat.
Do not obstruct or cover over the side or bottom ventilation holes.

Connect only to a standard grounded AC outlet of 100-240V, 47-63 Hz.

Keep the power cord in good condition. Do not kink, bend, or pinch.

If the cord becomes damaged, discard and replace it.

If not using your FM9 for extended periods of time, disconnect from AC power.
Protect the unit from rain and excessive moisture.

Refer servicing to qualified personnel only.

Stop operation of the unit and obtain service if:

- Liquids or excessive moisture enter the unit.

- The unit operates incorrectly or performance is inconsistent or erratic.

- The unit has been dropped and/or the enclosure damaged.

10. Prolonged exposure to high volume levels can cause hearing damage and/or loss.
The use of hearing protection in high volume situations is recommended.

N
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A Manual for Online and Print Use

This manual is intended for use in desktop, tablet, and smart phone readers. It includes clickable links and bookmarks to make navigation
and cross-reference easy. We recommend against printing our manuals, because firmware updates tend to make older versions fall out

of date. That said, considerations have been taken for those who prefer paper. You are granted permission to print this PDF for personal
use. A copy center or online printer can print and bind a book for you from the PDF file. Hopefully those with screen readers can forgive
the changes made herein to accommodate the print version: most links also include a page or section numbers, page spreads have extra
margins towards the binding edge, and blank pages have been included to preserve page and chapter flow.



1 INTRODUCTION

1 INTRODUCTION
WELCOME

The new FM9 from Fractal Audio Systems is an all-in-one amp modeler, effects processor, foot controller, audio interface—
and more—designed for professional stage/studio use and personal enjoyment. With four DSP cores, the FM9 is the most
powerful floor unit ever produced by Fractal Audio, and it features a impressive list of technologies and features from the
award-winning Axe-Fx Ill, FM3, and FC Controllers: our industry-leading amp modeling, UltraRes™ IR speaker cab simulation,
a suite of our legendary stompbox and studio effects, expandable FC foot switching, incredibly flexible I/0, 8x8 USB audio
interface capabilities, a world-class Mac/PC editor, and more.

The centerpiece of the FM9 is “Cygnus”, the latest version of Fractal Audio’s critically acclaimed amp modeling technology.
Cygnus uses Fractal’s proprietary SpectrumTrack™ technology, which improves the response of amp models across the
entire range of input levels, especially for amps with cascaded gain stages. The result is truer and more dynamic “voicing,”
plus exceptionally satisfying “chugs.” The FM9’s two “amp blocks” each have four channels which can run any of 280+
vintage, modern, and original models covering everything from pristine clean, to edge of breakup, from crunchy overdrive to
modern distortion to insane gain. The FM9 also includes the entire Ultra-Res™ speaker cabinet collection from the Axe-Fx
[1I, with 2,200+ “Factory” cabs including selections from the today’s best producers, plus 1,024 “User” locations for loading
your own Impulse Responses (“IRs").

The FM9 is an outstanding multi-effects unit, packed with hundreds of incredible stomp box and studio effects, with
accurate recreations of many classics, plus exciting originals. Selections include 57+ drive pedal models, dozens of delays,
numerous choruses, flangers, phasers, tremolo, and other modulation effects, 50+ reverb types from classic spring to real
spaces and beyond, multiple compressors, wahs, EQs and filters, a 2-minute looper, an entire suite of pitch effects including
detune, harmony, and virtual capo, plus rotary, synth, “plex” effects including shimmer, and much more.

The FM9 features the same audiophile signal path design as the Axe-Fx Il for the utmost in sonic performance and signal
integrity. Physically, it is built tough for the road, with a rugged 16-gauge steel chassis and protective endcaps that double
as feet. The unit is remarkably easy to use, with intuitive and comfortable controls, plus the same large, full-color main
display as the Axe-Fx Il and FM3. Nine on-board footswitches, each with its own vari-color LED ring and mini LCD display,
provide both tap and hold functions that can be customized to control countless aspects of your rig in realtime. “Layouts”
then provide nine different complete sets of footswitch functions. At the same time, a FASLINK Il port allows connecting up
to two more Fractal Audio FC-12 or FC-6 foot controllers for extended foot control real estate or remote control.

The FM9 has numerous inputs and outputs for a great range of different setups. Analog inputs include Fractal Audio’s
“Secret Sauce” 1/4” instrument input, plus two separate stereo pairs of balanced 1/4" jacks for use as “aux” ins or “returns.”
The main stereo output is equipped with both XLR and 1/4” outs, plus a headphones jack. Two additional independent
stereo outputs — one XLR and one 1/4" — can be used as “aux” outs or “sends.” All 1/4" outs feature Fractal Audio’s
Humbuster™ technology to help combat noisy ground loops. Digital I/0 includes 48k SPDIF in and out, plus 5-pin MIDI in
and out/thru. Finally, three on-board jacks each allow you to connect an external switch or expression pedal such as the
Fractal Audio EV-1.

The FM9 also serves as a high-quality USB Audio interface with “8x8" recording and playback capabilities. You can record
processed signals, a “DI” for re-amping, and stereo aux inputs. Audio can be played back directly to the unit’s outputs (for
DAW monitoring or “backing tracks,” for example) or routed through the FM9 for re-amping or for effects processing like a
virtual plugin.

FMO-EDIT, a full-featured software editor, is included free. The FM9 is also fully compatible with Fractal-Bot for preset
sharing, easy backups/restoration, plus firmware updates in the tradition of continual improvement that has become a
hallmark of Fractal Audio.

Above all, the FM9 was designed — “by musicians for musicians” — to deliver Fractal Audio’s uncompromising signature
sound quality, fantastic features, and roadworthy reliability in a highly portable format that we trust you will both appreciate
and enjoy. We thank you as always for choosing Fractal Audio Systems.

Fractal Audio Systems
August 2021
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1 INTRODUCTION

FEATURE SUMMARY

= The new FM9 from Fractal Audio is an all-in-one
amp modeler, effects processor, foot controller, and
audio interface for stage and studio use.

= The FM9 has a durable steel chassis with protective
endcaps designed to withstand the rigors of touring.

= The FM9 is based on an impressive list of advanced
technologies and easy-to-use features inherited
from the award-winning Axe-Fx Ill.

= The centerpiece of the FM9 is Cygnus, the latest version
of Fractal Audio’s industry-leading physical amp modeling.
Presets can use two independent amp blocks, each with four
channels, running your choice of 290+ amp models covering
the essentials and more, from pristine clean to edge of breakup,
crunchy overdrive, modern distortion, or insane gain.

= Two Cabinet Simulator blocks load up to two UltraRes™ impulse
responses each, for extremely accurate sonic performance,
plus dynamic remixing including visual phase alignment.

= 2,048 factory cabs include everything from the Axe-Fx IlI
and FM3, plus all 189 “Legacy” Cabs from the Axe-Fx II/
AX8. 1,024 “User Cab” memory locations allow you to load
Cab Packs and other 3rd party IRs (.wav, ir, .syx). Sixteen
“Scratchpad” memories are provided for experimentation.

= The FM9 is an outstanding multi-FX unit with hundreds of
industry-leading stomp box and studio effects, including
accurate recreations of many classics, plus exciting originals.
Selections include 59+ drive pedal models, dozens of delays,
numerous choruses, flangers, phasers, and tremolo effects,
60+ reverb types from classic springs to real spaces, multiple
compressors, wahs, EQs and filters, an entire suite of pitch effects
including detune, harmony, whammy, and virtual capo, plus
rotary, looper, synth, plex effects including shimmer, and more.

= 512 Preset memories can each store an entire rig with
its own amps, cabs, effects, and much more.

= 14x6 Layout grid, with “Zoom Out” option to show
the entire grid on one page with VU meters.

= Eight nameable “Scenes” per preset eliminate “tap dancing”
and make quick seamless sound changes possible -
including easy “spill-over” of effects like delay and reverb,
plus Scene MIDI messages for complete rig integration.

= “Channels” give each block up to four different sound
settings. One drive block, for example, can provide four totally
different drive pedal sounds without 4x the CPU burden.

= Three pairs of Input and Output blocks (plus USB) provide
incredibly flexible routing, with setup diagrams included
for FRFR, direct FOH plus “live” power amp and guitar cabs,
creating an “FX Loop” for pedals, simultaneous electric and
acoustic/piezo, “four cable method” (4CM), and more.

= FMO features an audiophile quality signal path
with an extremely low noise floor and THD.

= Top panel LED meters and status indicators offer great
visibility of critical information. Onscreen animations
show levels for every block, input, output, and more.

N

FMO features our latest interface and controls, featuring
the same custom color display as the Axe-Fx Ill Mk

I, and five knobs with on-screen labels providing
instant access to turn and push functions.

An easy-to-read, precision full-screen tuner includes
a bar graph and virtual strobe display.

Nine onboard footswitches use our “FC” controller
switching system for extreme flexibility, with nine
layouts containing 12 switch definitions each.

Each footswitch has its own LCD “mini display” to show the
switch function or a custom label, plus a variable-color LED
ring which shows the category and status of the switch.

Every fully-customizable switch has both tap and hold
functions which can change presets, banks, scenes, effects,
channels, operate the looper, tuner, tempo, and much more.

Per-Preset Switches grant the utmost in flexibility:
any preset can override any switch in any
Layout for “one-off” switching needs.

For even more footswitches, connect one or two FC-6 or FC-12
controllers via FASLINK™ Il. These integrate seamlessly with
onboard switches and also offer additional switch/pedal jacks.

Each of three onboard pedal jacks allows
connecting an external switch or an expression
pedal such as the Fractal Audio EV-1 or EV-2.

Input 1is a 1/4" mono Instrument input featuring “Secret
Sauce IV” for ultra-low noise and optimized signal from
your guitar or bass. Two separate stereo pairs of balanced
1/4" jacks serve as as “Aux” ins or “FX returns.”

The main stereo output is equipped with both
XLR and 1/4" outs, plus a headphones out.

Two additional independent stereo outputs — one

XLR and one 1/4" — can be used as “Aux” outs or “FX
sends.” All 1/4" outs feature Fractal Audio Humbuster™
technology to combat the noise of ground loops.

The FM9 is also a robust 8x8 USB Audio Interface, able

to record processed guitar, DI signals for re-amping, and
stereo aux inputs. Computer audio can be played back
directly to the outputs (as “backing tracks,” for example) or
processed for re-amping or effects like a virtual plugin.

Digital 1/0 includes SPDIF in and out plus 5-pin MIDI in and out.

“Client-Server” architecture allows multiple FC foot
controllers and FM9-Edit to control the FM9 while
updating each other seamlessly and instantly.

A connected computer allows the use of FM9-Edit, our
world-class editor for Mac and PC, and Fractal-Bot,
for firmware updates plus backup and restore.

FMO9-Edit also allows the FM9 to load Axe-Fx Ill or FM3
presets (within the limits of local block and CPU resources).

A built-in backup firmware ROM allows recovery
in the event of complications during an update
without the need for professional service.

The FM9 has upgradeable firmware making constant
improvement and innovation possible.



1 INTRODUCTION

THE SETUP MENU

Throughout this manual, you will be directed to use the SETUP menu of the FM9 to make changes to I/0
(Input/Output), MIDI, global settings, and more. To open the setup menu, push HOME and then press knob E.

The SETUP menu includes the following areas:

= FC Controllers/Onboard Switches - includes all settings for the onboard footswitches or a connected
FC controller.

= Global Settings - includes options which govern the global behavior of the FM9.

= 1/0 - contains settings for all inputs and outputs, including levels, audio options, and switches or
expression pedals connected directly to the FM9.

= MIDI/Remote - contains MIDI settings, plus several pages of remote controller assignments for the
many remote-controlled functions of the FM9.

= Utilities - contains readouts, utilities, and a control to adjust screen brightness.

Paths within the setup menu are designated using colons as separators, so for example, the Reset page of
the Utilities menu under SETUP will be notated as SETUP : Utilities : Reset

To access the SETUP menu:
» Press HOME.
» Push the “E” soft knob to open the SETUP main menu.
» Use the NAV buttons to select a submenu and press ENTER to make a selection.
» Use PAGE and NAV buttons to navigate. Use VALUE and knobs A-E to make changes.
» Changes in the SETUP menu take effect immediately and do not need to be stored or saved.

» Press HOME at any time to return home.

Use these hyperlinks to access to the SETUP menu topics in this manual:

SETUP
—— FC Controllers/Onboard Switches p.89
— Global Settings p. 91
— 1/0 p.9%4
—— MIDI/Remote p. 97
—— Utilities p. 101

[ J%]



1 INTRODUCTION

QUICK CONNECT GUIDE

Perhaps the best and most flexible way to enjoy your FM9 is through a full-range system such as studio monitors,
a high-quality PA, or full-range speakers designed specifically for guitar. All of the factory presets are designed for

this type of setup.

The FM9 is incredibly flexible, however, and many other types of setups can be used, including those based on tube

amps, USB recording, 3rd-party outboard equipment, and more.

Find additional setup diagrams in Section 4.

The most basic setup instructions appear below:

o Begin with all level knobs turned down.
Connect your guitar to FM9
Instrument input (Input 1).

The FM9 is also perfect for bass
and other instruments.

IN 1 [INSTR]

B

0 Connect Output 1 to your mixer, studio
monitors, audio interface, PA system, full-range
speakers, power amp inputs, etc. You can use
either the XLR outs or the 1/4" outputs.

= For amono rig, use Out 1 Left.
» For optional stereo, also connect Out 1 Right.

= Use XLR-to-XLR cables or XLR-to-TRS cables
when connecting to balanced inputs.

= Use regular patch cords, XLR-to-1/4" (TS)
cables, or Humbuster™ Cables (see p. 6)
with 1/4" unbalanced inputs.

e Slowly turn up the front panel OUT 1 knob and adjust the
level on your monitors as desired.

* You can use the footswitches to explore factory
Presets and Scenes (see p. 8) or turn VALUE to
select presets and NAV Up/Down for Scenes.

FRFR = "Full Range, Flat Response"

HUMBUSTER™
ouT1
(Use XLR or 1/4")

Use Add
OQut1lL Out1R
for for
Mono Stereo

FRFR speakers, Studio Monitors
Audio Interface or Mixer

The front Out 1 knob adjusts the
level of what you hear in this setup.

FRFR stands for “Full-Range, Flat Response,” a term used to describe a system which aims to accurately
reproduce the entire audio spectrum. In comparison, traditional guitar speakers have limited range lacking
extended lows and highs, and are not at all “flat,” meaning certain frequencies are markedly louder or quieter.
FRFR systems such as studio monitors, high-quality PA speakers, and FRFR speakers designed specifically for
guitar are designed to accurately reproduce anything played through them, making them ideal for a modeling
processor like the FM9. Of course, even these may vary, depending on which FRFR you choose.

4



1 INTRODUCTION

SETTING LEVELS

Setting proper levels is critical, but easy, with abundant meters to inform you about levels on the FM9.

INPUT LEVELS

The FM9 comes ready-to-use for the typical guitar with passive pickups.

Connect a guitar to the Instrument input. Choose your loudest pickup setting and

set all the guitar controls to “wide open.” Play loudly to push the levels as you

watch the front panel INPUT 1 meter LEDs. A red LED on the input meter indicates

a level of -6dB, which is still safely below clipping. Adjust the input trim so your

loudest playing “tickles the red.” It is of course also fine if a lower output guitar

never hits the red. In general, you should set input levels as high as possible without clipping:

» Open SETUP :1/0 : Input page.
» Adjust Input 1/Instrument input levels using the A knob.

Inputs 2 and 3 can be adjusted using the same method. Each has its own Input trim parameter on the Input page
of the 1/0 menu under SETUP.

You can also monitor levels on the Meters page of the Home menu.

Except at the very lowest settings, Input level adjustments do not affect input gain. As you adjust the
input level to the A/D converter, its output is compensated, so the overall level does not change.

OUTPUT LEVELS
Fharler 4
Output levels are easy to monitor by OUT 1 CLIP
paging to the Meters page of the Home ., OUT 2 CLP
page. Should your output levels be too - OUT 3 CLIP

high, the OUT 1 CLIP or OUT 2 CLIP LEDs

on the front panel will light. This is a true indication of
imminent clipping, and unlike inputs, outputs should
NOT “tickle the red.” To lower output levels, you can

adjust the top panel knobs or adjust the level of your ll lI nE
SHE T 11

presets. (Section 7: Leveling Presets is dedicated
to the subject of balancing preset levels.)

Output 1 L/R and Output 2 L/R are ready to be

connected to consumer line level inputs (-10 dbV). If
you are connecting to professional-grade equipment
operating at +4dBu, set the output levels as follows:

» Page SETUP: I/0: Audio
» Set the desired Output Level (1 or 2) to +4dBu.
Learn more about the I/0 Menu on p. 94.

Output 3 is designed so that it operates at unity gain
when the front panel OUT 3 knob is fully clockwise.

The Layout also has a Meters view showing block levels.

lon



1 INTRODUCTION

HUMBUSTER™ CABLES

The 1/4" jacks of Output 1 and Output 3 on the FM9 feature Fractal Audio’s proprietary Humbuster™ Technology,
which can significantly reduce the unwanted hum of ground loops when used with special Humbuster™ cables.

A Humbuster™ cable has one TRS end (like a balanced cable) and one TS end (like a guitar cable). The TRS end
connects to the FM9. The TS end connects to your amp or other device.

Humbuster cables are available from http:/www.fractalaudio.com/cables. You can make your own by following
the diagram below. Be sure to use high-quality connectors and shielded cable.

TIP  SLEEVE TR T SLEEVE TIP

I
RING S S

Note: Use Humbuster cables only when connecting the FM9 to unbalanced 1/4" inputs on other devices. When
connecting to a 1/4" balanced TRS input, use a standard 1/4" patch cable — or better still, connect the balanced
XLR outputs of the FM9 via XLR-to-TRS cables or adapters.

MONO VS. STEREO

Ve The FM9 comes preconfigured for stereo but you can connect it in mono with no issues. If you
9 are NOT running in stereo, you may find that certain presets or settings produce unexpected
\“%  results. For example, a panner sounds like a tremolo when one channel is missing. A ping-pong

“../ delay may “ping” but never “pong.” Stereo enhancers or certain types of modulation may not be
apparent at all. Tone can even change completely if amps or cabs have been hard panned. Here
is an overview of several scenarios, with recommended settings for each.

A

» Stereo: No special settings required.

» Half-Stereo: Leaving the FM9 in its default stereo configuration but connecting
only its left or output results in a “half-stereo” setup. This works fine, aside from the
exceptions mentioned above (ping-pong, panning, etc). No special settings required.

» Dual Mono: If you want to force your rig to mono, dual mono is a good choice. Sonically, this
is identical to half-stereo, with the same limitations, except that mono signal is produced
at both the left and right jacks so you can connect to two monitors. To switch to dual
mono, open SETUP: I/0: Audio and set Mode for the desired output to “COPY L->R".

» Summed Mono: In this setup, left and right channels are added together resulting in an identical
mono signal at both left and right outputs. This has the advantage of not discarding half of
the sound, but summing has its own issues. For example, short delays or phase differences
between channels can result in strange artifacts or even cancellation. To switch to summed
mono, open SETUP: I/0: Audio and set Mode for the desired output to “SUM L+R".

On the FM9, a flexible block-based 1/0 system makes it easy to use different outputs for different
purposes. See the “The Fractal Audio Blocks Guide” for more on Input and Output Blocks.

All options of the 1/0 menu under SETUP are detailed in Section 13: Setup Menu.

6
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1 INTRODUCTION

THE HOME PAGE: PRESETS

Once you have connected your FM9 you can begin to audition factory preset sounds. Of course, the footswitches
provide a convenient way to do this, but you can also operate the unit from its top panel.

Remember that aside from a few templates, the factory presets are designed for use with full-range
speakers / monitors / headphones. (See Section 4 for details on many other types of setups.)

The FM9 contains 512 preset memories. Each preset is a full “rig” with its own amps, cabs, effects, settings,
controllers, and more. When you consider everything that is possible with Scenes and Channels, a single preset
can cover an entire song, or even a whole show.
Here's how to explore the factory presets: Previous Scene
» Press HOME to show the Home page, —
where you can switch presets.

» To change presets, turn the VALUE )
knob or use the NAV buttons. Previous 4 NAV ) Next

» Many factory presets have been set up with Scenes. Preset Preset
You can switch between Scenes using the NAV buttons or by
turning knob A. (See p. 15 for an introduction to Scenes.)

v
Next Scene

OTHER HOME MENU FUNCTIONS

» The push functions of the five knobs on the Home page of the Home menu provide access to other areas:

= Tuner

= Layout grid (p. 14 and p. 40)
= Controllers (p. 67)

= FC Per-Preset (p. 80)

= Setup (p.3)
» Turning knob E switches between different foot control “Layouts” (see p. 8).

» A mini-Tuner appears at the top of the Home page itself in the form of >|<
two green triangles. When both are lit, the note is in tune.

» Two Performance Control Pages let you assign the five top panel knobs of the FM9 for
easy, hands-on access to any parameters you choose. Learn more on p. 114.

» The Home menu also provides access to the Presets directory page,
listing all presets in a scrolling list sorted by number.
» PAGE to the Presets page to show the directory.
= To sort alphabetically by name, press the “Sort A-Z" button.
= The ENTER key loads the selected preset.
» The Meters page provides visual indication of all input and output levels, including USB.

N



1 INTRODUCTION

LAYOUTS

The FM9 is based on our popular FC controllers. The central concept behind all of these products is the Layout.
A layout is a set of footswitch definitions. You can change the layout to change what the footswitches do. All
layouts and switches can be completely customized. The FM9 provides eight layouts in total, plus one special
“Master” layout (covered below). Layouts have both numbers and names to make them easier to manage.

There are multiple ways to change the layout on the FM9. The easiest is probably to turn knob E on the Home
page of the Home Menu. You wouldn’t be able to do this easily while you are playing, however, so we created the
Master Layout Menu and Layout Switches so you can change layouts with your feet.

The FM9 Factory Default Layouts also include some pre-programmed footswitches to change layouts in a way
that is easy, convenient, and intuitive. See Section 10: Layouts & Switches for more on this subject.

THE MASTER LAYOUT MENU

Switching from one layout to another is the key to the versatility of the FM9. There are many ways to do this, but
the built-in Master Layout Menu (“MLM” for short) will be the first method you'll want to understand. The Master
Layout Menu grants instant access to other layouts, one per footswitch.

To show the Master Layout Menu, rock your foot from heel to toe over both of the two right-most footswitches on
your FC, as shown in the following illustration of the “MLM Switch Combo.”

OOO o0 o0
@ =) eC—=+) eC—=

The Master Layout menu automatically assigns different layouts to different footswitches in order. Footswitch

1 loads Layout 1, Footswitch 2 loads Layout 2, and so on. If your layouts have names, these will be shown in the
Mini-Displays. When you activate any switch to select a layout, it is loaded immediately. The currently selected
layout will be shown with a bright LED ring, while other options are dimmed. To exit the MLM without changing the
current layout, just select the bright switch to go to the current layout again.

If the lower right switch has a Tap function, this function will not be activated by the MLM Switch Combo. If
the lower right switch has a Hold function, you can still easily execute the MLM Switch Combo quickly, before
the Hold function fires. If the Hold function should fire, the Master Layout Menu will still be displayed after you
execute the combo stomp. Learn more in “Tap & Hold Functions” on p. 72

When you design your own layouts, avoid using a hold function on the
lower right switch, or consider one that doesn’t change your sound,
just in case you accidentally fire it while activating the MLM.

layouts without the MLM. You can also “piggyback” a layout change on
another switch function using a “Layout Link."

Learn more in Section 10: Layouts & Switches.
8

@ A layout can also include Tap or Hold switches that change to other



1 INTRODUCTION

FOOTSWITCHES

The FM9 has nine built-in footswitches, each with its own mini-display and vari-color LED ring. Footswitches
can be used to change presets, select scenes, toggle effects, and much more. This page introduces the basic
concepts, while Section 10: Layouts & Switches covers the topic in greater detail.

SWITCHING PRESETS

Let’s begin with how to explore the factory presets and scenes using the footswitches. When the FM9 starts up,
it loads the Presets Layout, shown below. In this Layout, the first five footswitches (green) each select a single
preset. Preset names are shown in the mini-displays. The current preset will have a bright ring and the others will
be dim.

A “bank” is a group of presets. To change to the next bank of five presets, tap the Bank +1 footswitch. To change
to the previous bank, tap the Bank -1 footswitch.

The extra top two switches can be used to jump to the Scenes Layout and for Tap Tempo. Press and Hold the Tap
Tempo switch to show the TUNER. Once you change to the Scenes Layout, the same switch that got you there can

be used to return to the Presets Layout.
(Hold for Tuner)

I SCENES | I Tap Tempo | | BANK +1 |
A\ N 7=
ISQ Bassguyl I Plexi 50W l | Friedman I IClass—A EBHI I 5153 l | BANK -1 I

AN\ O AN\ AN\ O 2\

You can use the MANAGE PRESETS feature of FM9-Edit to drag and drop presets of the FM9 into any order
you wish. Put your favorites in groups of five so you'll have what you need without a lot of bank changes.

FOOTSWITCH FUNCTIONS

Every footswitch in every Layout can have its own independent Tap Function and Hold Function. Functions are
arranged in Categories like “Presets”, “Scenes”, or “Effects”. A special “EZ" mode makes these simple to assign.

LED RING COLORS

Every footswitch category has its own default LED ring color. You can change the default colors in SETUP: FC
Controllers: Ring Colors. You can also change the color of any individual switch.

MINI DISPLAYS

The Mini-Display for each switch shows a label for the Tap function. While the switch is depressed — even for a
normal “tap” — the label changes momentarily to show the Hold function. Each function has several options for
the mini-display, and you can even use your own custom labels.

ho



1 INTRODUCTION

EXPRESSION PEDALS

This section is for pedals connected to the local “Pedal” jacks of the FM9.
For pedals connected to an FC controller, see your FC Owner’'s Manual.

Each of the three Pedal jacks of the FM9 support one expression pedal or one external footswitch.

EXPRESION
PEDAL

TRS
2
=2
C
(]
\n
o
[
TRS
PEDAL JACK

FAQ:

TIP

SLEEVE

TO CONNECT & CALIBRATE AN EXPRESSION PEDAL...

Expression pedals should have a linear resistance taper and a maximum resistance in
the range of 10-100kQ. Expression pedals must be connected using Tip-Ring-Sleeve
(“TRS") cables.

Connect your expression pedal to one of the FM9 Pedal jacks with a TRS cable, then
follow these instructions:

1. From the Home page, open SETUP: 1/0: Pedal.

2. For pedal jack 1, set Type to “EXPRESSION”
(or use Pedal 2 Type if that's the jack you're connecting to)

3. Navigate down to the Calibrate function for your pedal and press ENTER.
4. Follow the on-screen instructions to perform calibration. Press HOME to finish.

= Be sure to see the next page for instructions on assigning your new pedal.
= |f something doesn’t work, try a different pedal or cable.

FRACTAL AUDIO EV PEDALS

The Fractal Audio Systems “EV” pedals are
perfect for use with all Fractal Audio Systems
products. The EV-1 is a full-sized expression
pedal. The EV-2 is a compact version. These
pedals feature rugged cast metal casings, a
high quality 100kQ linear potentiometer, and
built-in analog volume pedal capability.

Learn more at https:/www.fractalaudio.com

WHAT IS TRS? “TRS" stands for TIP-RING-SLEEVE and describes the
configuration of a 1/4" end plug or jack with three connectors. Normal guitar cables
are “TS" (Tip-Sleeve) since they lack the ring required for a third contact. Expression
pedals require TRS cables because full control voltage is transmitted to them on

| | one contact (the tip), while less than full voltage is returned to on another (the ring)
CJ]:. so the host device is able to sense and utilize the pedal position. The third contact

RING

(sleeve) is connected to ground.

10
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1 INTRODUCTION

GLOBAL EXPRESSION SETUP

FM9 Pedal Jack 1 can be assigned as the “External 1 Controller” for use with factory presets as a Wah.
Follow the instructions below.

1. From the Home page, open SETUP: MIDI/Remote: External.

2. NAV down to External Control 1.

3. Turn the A or VALUE knob to select PEDAL 1

4. Press EXIT when finished.
You can test the pedal using Factory presets in the range 000-064.

External 1 can also easily be assigned as Volume, Whammy, or almost anything else on a per-preset basis.
Learn more about assigning pedals and switches to sound parameters in Section 9: Modifiers.

GLOBAL VOLUME SETUP

The FM9 allows global remote control of the volume of any Input or Output. To set up a pedal for global volume,
follow the instructions below.

Be careful not to assign the same pedal to both Volume and an External Controller as described above.
First you'll need to decide which global volume option you prefer:

= An Input Volume changes gain or distortion and the behavior of level-dependent blocks like
the compressor or gate. This is like using a volume pedal between your guitar and amp.

= Qutput Volume does not affect gain or level-dependent blocks, but scales everything you hear
including effect tails. This is like using adjusting the level of your guitar in the PA.

To set Global Volume:
1. From the Home page, open SETUP: MIDI/Remote: Other.
2. NAV down to find the entry that you want to control: Input Volume 1, 2, or 3, or Output 1, 2, or 3.

3. Turn the A or VALUE knob to assign the pedal you want to use.
Select “PEDAL 2" for the onboard Pedal jack (or #1 or #3 if you prefer).

4. Test and EXIT when finished.

Learn more about these options in “The MIDI/Remote Menu” on p. 97




1 INTRODUCTION

EXTERNAL SWITCHES

This section is for switches connected to the local “Pedal” jacks of the FM9.
For switches connected to an FC Series controller, see your FC Owner's Manual.

Each of the two Pedal jacks of the FM9 can support a switch instead of an expression pedal. Any make-break
switch type may be used with the FM9 in this way. Connect as shown below:

SINGLE
FOOTSWITCH EXTERNAL SWITCH SETTINGS

External switches require a simple setup:
» Page to the Pedal page of the I/0 menu under SETUP.

TS » Set Pedal 1 Type to “SWITCH" .
» Next, navigate down and set the Polarity and Behavior for your switch.

= Polarity is based on whether the switch is normally OPEN or CLOSED.

= Behavior allows you to set a momentary switch to behave as a VIRTUAL TOGGLE switch.
= See "I/0: Pedal Page” on p. 96 for more on these settings.

Press HOME to finish.

Patch Cable

External Switches can be used with the options found in the MIDI/REMOTE MENU by
selecting the option PEDAL 1, PEDAL 2 or PEDAL 3 (this label refers to the name of the
jack on the FM9 and not what you have connected to it).

The STAND IN SWITCH feature (p._81) makes external switches even more powerful,
since it allows them to perform any of the the functions of an onboard switch.

TS

PEDAL JACK



1 INTRODUCTION

USB AUDIO

USB provides the FM9 with a host of great audio features. With 8 input and 8 output channels, you can play
backing tracks, record processed audio or DI signals, re-amp in real-time, and more.

See Section 3: USB for full details on the USB capabilities of the FM9.

FRACTAL-BOT & FM9-EDIT OO)

In addition to providing audio capabilities, USB allows you to use the FM9 with
our companion software applications, Fractal-Bot and FM9-Edit.

Fractal-Bot is a small, simple program used to update the FM9 when new
firmware is released. It includes tools to backup or restore presets and other
custom settings and more.

FM9-Edit is a full-featured software editor/librarian for the FM9. If you are

comfortable with audio software or plug-ins, you will definitely enjoy this easy

and powerful app. It can operate almost every aspect of the FM9 and even has some “power-user” routines that
aren't possible on the unit itself (e.g. Performance Page editor, Block Library, Scene Swap, etc.). FM9-Edit also
provides great tools for managing presets and banks, installing Cab Packs, and more.

You can download FM9-Edit for Mac or Windows at https:/www.fractalaudio.com/FM9-edit

SEMSEDIT
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1 INTRODUCTION

INTRO TO THE LAYOUT GRID

At the heart of the FM9 is the Layout Grid, an array of rows and columns used to construct presets. In the
world of traditional gear, our rig options are restricted by budget, space, weight, and the limits of the equipment
itself. Building a rig means making hard choices. With the FM9 however, these limits are replaced by a vast and
expansive “inventory” of virtual amps, cabs, effects, and more. Every single preset gives you the flexibility to
design a unique rig composed of whichever components you choose.

So, in more detail: to create a preset, you will select virtual pieces of gear called blocks from the inventory. Each
block represents a different component like a wah pedal, amp, or reverb unit. You place these on to the Layout
grid and connect them together using virtual cables. You can split, merge, or create parallel paths as needed.
Passive shunts, like cables, carry signal through empty grid spaces. Special input and output blocks connect to
the various jacks and USB signals of the FM9. Here is an illustrated overview of this concept:

(=]

[ R
£
EEE

Passed
OUT1| toOUT1 :
Jacks

:' ............................................ The Layout Grid ............................................

Let's review what’s shown above. Signal flow begins at the Input 1 block on the left (blue). It is connected by a
cable to the Wah block, which in turn connects to a shunt. The shunt has no effect on the sound and is shown
only to introduce the idea of how it can be used to carry signal from one block to another. The shunt is connected
to an Amp block (we might set its type to “Plexi T00W High”), which in turn feeds a Cab (one of the many “4x12"
options, perhaps). This is connected to a Reverb and then to an Output block (green). In this limited example,
many grid spaces are empty, and only some of the columns are shown. In reality, the size of a preset is limited
only by the size of the grid, block inventory, and total processing power (“CPU"). The FM9 can create presets large
enough to cover a song, a set, or even an entire show.

@ The Layout “ZOOM” feature shows the whole grid at once. Look for the ZOOM button on Layout menu pages.

14



1 INTRODUCTION

INTRO TO SCENES AND CHANNELS

Imagine a professional rackmount system rig like the ones used by guitar heroes for decades. In such arig, the
various components — pedals, guitar amp, rack units — are usually connected to a central switching unit so they
can be switched in groups without “tap dancing.” Some components may also have settings that the switcher can
change, like the channel of an amp, or the MIDI program of a delay unit. As described on the previous page, an
FM9 preset is like this rig: it consists of “blocks” (amp, cab, effects) all connected together in a certain way.

In the traditional rig, you can set up and save different combinations and channels: Clean, Rhythm, Lead, etc.
Scenes allow you to create saved combinations within a preset. Scenes don't rewire the rig or change what gear it
contains; instead, they switch blocks on or off and change block “Channels.” Each preset contains eight scenes.
Like presets, Scenes also have their own names.

Scenes also offer an advantage over presets when making sound changes while you play. When you change
scenes, the FM9 does not need to reload the entire “rig.” Instead, it just sets the blocks and channels as needed
for the new scene. This is not only faster, but also allows easy “spillover” of delay and reverb tails.

Channels on the FM9 make blocks extremely flexible. Each channel contains its own fully independent set of
parameters for the entire block. For example, Channel A of a Drive block might be dialed in as a clean boost, B as
an overdrive, C as a distortion, and D as a Fuzz. That's four completely different drive sounds from just block. This
can be used to conserve CPU power when compared to using multiple blocks.

SCENES AND CHANNELS: A VISUAL EXAMPLE

[ IN1 cMp|i—{DRV [{—AMP[i—{cAB [s—{cHo ;LY [;—ouT 1]

Here is our preset. The Input 1 block feeds a Compressor, which is connected to a Drive, then an Amp and Cab,
then Chorus, Delay, and finally the Output 1 block.

[ IN1 —{eMP[i— v —{aMP[i—{cAB [{—{cHoli—

SCENE 1 - “Clean”: For scene 1, the Drive and Delay blocks are bypassed. We dial in the Compressor, Amp,
Cab, and Chorus for a classic clean tone. Notice that the amp says “1A”. This means we are using Amp 1, set
to channel A. Let's imagine it as the “ODS-100 Clean” model. We name this scene “Clean”.

—{DRV [{H—AMP[E—{cAB [J—0| — 0UT1

SCENE 2 - “Crunch”: To create scene 2, we bypass the Compressor, Chorus, and Delay and engage the Drive.
The Channel of the Amp block is changed from “A” to “B”, which we dial in as a “Euro Blue” model. Remember,
each channel has a totally independent set of settings, so we can dial in every amp parameter exactly as we
want it: Drive, Treble, Mid, Bass, Master, and many more. We then dial in Channel “A” on the drive block with a
good “screamer” sound by selecting the “TS808 OD" type. Let’s name this scene “Crunch”.

[ IN1 —cMpPE—{pRrv[i—AMP[E—{cAB i —{oy |i—out 1]

SCENE 3 - “Lead”: Here's our soaring lead. The Chorus is bypassed. We've changed the compressor to
Channel “B” and dialed it in for sustain. The amp is the same as the “Crunch” scene but the Drive changes to
“B”, which we'll make a “Ruckus LED". The Delay is on channel “B” set for ping-pong echoes with higher mix
and feedback. We name this scene “Lead".

Learn more about these topics in Section 5: Presets and Section 6: Scenes & Channels.

15



1 INTRODUCTION

GRID EDITING: QUICK START

Learn more about the Layout grid in Section 5. Meanwhile, here’s a very quick primer:

»

From the Home page, press LAYOUT (knob B) or ENTER to show the
grid (that is, the “Edit” page of the Layout menu).

Use the NAV buttons to move the cursor around the grid.

To change any block, turn the VALUE knob to cycle through the list of available blocks.

When you find the block you want, press ENTER to confirm. Press EXIT to cancel changes.

On the grid, “push” functions of the B, C, and D knobs allow you to toggle a block’s Bypass state,
Delete a block, or create/remove a connector Cable between any two blocks in adjacent columns.

To save any changes, press STORE, ENTER, ENTER.

BLOCK EDITING: QUICK START

Learn more about editing blocks in Section 5: Presets. Meanwhile, here’s a very quick primer:

»
»
»

Parameter o feeeoeeen @ @ @ @
Highlighted . :

Open the Layout grid (see above), select the desired block and press EDIT to open its menu.
Use the PAGE buttons to navigate menu pages.

Many blocks have a TYPE page, which allows you to dial in multiple settings with one knob.
Examples include setting an Amp to “USA Lead+" vs. “Tweed 5F1", or a reverb to “Cavern” or “Large Spring”.

Use the A, B, C, D, and E knobs to edit on-screen parameters. From
any block’s Edit menu, press EXIT to return to the grid.

To save any changes, press STORE, ENTER, ENTER.
The stylized diagram below shows a typical edit menu page with annotations:

Block Name and Number Menu Pages (Tabs) 1/0 Meters
Block Type Current Scene/Channel Tuner :
Drive 1 : Type (Ba.sic} Expert ! Mix Al
Current T808 OD: Scene: 1 ~ Channel: A —— =
Parameter
Value BOX ................................................ ( ......................... 500 >
Current

DOrive Tone Mix Level
Inactive Row
is dimmed ...................

(NAV Up/Down

to change rows)

Push(FunC)tions ~~~~~~ ¢ RESET ) ( BYPASS ) ( MODIFIER ) ( ) (MORE 10f2)

A-E : : : : :
Resets Bypassor  Adds a Modifer A yellow dot Reveals the
this Block to Engage this to the current  shows Modifier Scene/Channel

defaults block parameter capability Selector
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1 INTRODUCTION

THE FRACTAL AUDIO BLOCKS GUIDE

The FM9 is based on our flagship rackmount processor, the award-winning Axe-Fx Ill. Both the FM9 and the
Axe-Fx Ill use presets built from blocks, and the blocks on both devices share many of the same parameters and
settings. A separate manual covers these blocks in complete detail. More than a simple reference, it contains
background information, tips, and extra material to help you make the most of your Axe-Fx or FM9.

The Fractal Audio Blocks Guide can be downloaded from https://www.fractalaudio.com/fas-bg

Srracma
BLOCKS GUIDE

Complete Reference for
Blocks and Parameters
o The Aae-Ex 11 E ERED
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1 INTRODUCTION

THE FOOTSWITCH FUNCTIONS GUIDE

Our current product lineup uses a shared system of Layouts and Footswitches.

A Layout is like a preset for the footswitches, each with its pre-programmed settings for Tap and Hold functions.
Changing the Layout on a device changes the functions for all of the footswitches on that device. You can change
Layouts at will. There are many footswitch functions to choose from as you design your Layouts.

Additional details about Layouts and switches are included in Section 10: Layouts & Switches.

For a detailed guide to all of the available Footswitch Functions, download the Fractal Audio Footswitch

Functions Guide from https:/www.fractalaudio.com/fas-ffg

ﬁﬁ ACTAL
AL BYRTERME

FOOTSWITCH
FUNCTIONS
GUIDE
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2 HARDWARE OVERVIEW
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0 Chassis — The FM9 is housed in a rugged steel chassis with high-durability protective plastic end caps.

0 Color Display — A large 800x480 color display is optimized for readability even in the most difficult
environments, with excellent brightness and contrast.

o A, B, C, D, and E knobs — Five “endless rotary” push-knobs perform different functions in different areas of
the FM9. Push functions are shown as “buttons” in the display above the knobs. Most Edit pages show one
or two rows of five knobs for easy 1:1 operation. On vertical menu pages, knob functions have “A,B,C,D,E”
labels on the left to indicate control mapping. (You can also use NAV and VALUE to edit any parameter.)

o HOME Button — This button loads the Home menu, a convenient place to select presets, access the tuner,
edit presets on the Layout grid, view Controllers, or turn the page to access meters, performance controls, or
the presets directory.

9 EDIT Button — This is used to Edit blocks in the current preset. You can jump right to the current block from
the home menu or any other page and then tap EDIT sequentially to step through all blocks in the preset
(top-to-bottom, left-to-right), or select a block on the Layout grid first and then press Edit. See “Presets” on p.
39 for more on editing presets.

0 STORE Button — Enters the Store menu where you can save presets and also edit the names of presets and
scenes. See “Saving Changes” on p. 47.




2 HARDWARE OVERVIEW

0 TEMPO Button — Tap this button once to show the Tempo menu page, or tap two or more times to set a new
tempo. After setting the tempo, press EXIT to return to wherever you were.
TIP: The tempo can also be entered using a footswitch and by various other means. See Section 11: Tempo

Q VALUE Knob — The VALUE knob performs different functions on different menu pages.
» |n the Home menu, it cycles through presets.
» |n the Layout grid, it is used to add or change which blocks are on the grid.
* |n Edit and SETUP menus, it changes parameter values, selects from lists, and more.
The Value knob also has a push function of opening the Layout Grid.

o NAV Buttons — The four NAV buttons perform different functions on different pages. On the preset page of
the Home menu, they select and load Presets (Left/Right) and Scenes (Up/Down). In other menu pages, they
select between on-screen parameters or options, moving the “focus” of the VALUE knob, as indicated by a
blue highlight and brighter blue text.

@ ENTER and EXIT Buttons — The ENTER button executes commands, commits changes, accesses sub-menus,
and more. EXIT works for cancel, escape, and various other functions.

TIP: From the home page, ENTER is a shortcut to open the layout grid.
m PAGE LEFT and PAGE RIGHT — These step through menu pages, shown as “tabs” at the top of the display.
@ Output Level Knobs 1, 2 and 3 — These knobs independently control the volume of each of the
corresponding rear panel outputs. As discussed in various setup diagrams in this manual, Output 3 is at unity

gain when set fully clockwise.

@ Meter Bridge — Three LED meters — one mono and two stereo — show the levels at Inputs 1, 2, and 3.
The red LED indicates -6dB. Adjust input levels as discussed in “Setting Levels” on p. 5

@ Status LEDs — Six LEDs show important information.

= The OUT CLIP LEDs (1, 2, and 3) indicate that internal signal levels are too high, which can be corrected by
turning down the corresponding output knob or by lowering the level of your presets.

= The Edited LED lights whenever the current preset has been altered but not saved.
= The MIDI In LED lights while MIDI data is being received at the MIDI Input or via USB.
» The Tempo LED flashes to show the current Tempo.

TIP: You can also find on-screen meters on the Meters pages of the Home menu and the Layout.

@ Footswitches — The switches of the FM9 use our proprietary Solid State Switching (SSS™) technology,
featuring extremely smooth, quiet, action, and no mechanical contacts to fail. Each footswitch can be
assigned your choice of one “Tap” and/or one press-and-hold (“Hold") function. These can be different in
different ways in different “Layouts”. Learn more in Section 10: Layouts & Switches.
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@ Input 1 [Instrument] (mono) — (1) 1/4" Jack (unbalanced) — Connect your guitar, bass or other “instrument
level” outputs to this input featuring our proprietary “Secret Sauce IV” circuitry.

@ 'nput 2 - (2) 1/4" Jacks (balanced) and @F) Input 3 — (2) 1/4” Jacks (balanced)

Connect balanced or unbalanced line level signals here. Inputs 2 and 3 can be used as auxiliary inputs with
any mono or stereo line level source like a guitar processor, mixer, synthesizer, backing track player, etc.,

or paired with Out 2 and/or 3 for “send and return” applications involving pedals, processors, preamps, and
more. These inputs can also be used for guitar or bass but do not have the “secret sauce” circuit like Input 1.

TIP: Balanced audio connections are resistant to noise and interference. It is best to use XLR or TRS
(3-conductor) cables when connecting balanced devices. Use regular TS-type cables or adapters (2-conductor)
with the unbalanced outputs of guitars, preamps, and many other guitar products.

@ Output 1 L+R (stereo) — (2) XLR-Male (balanced) AND (2) 1/4" Jacks (Humbuster™) — This is typically
the “Main” output. Use the XLR jacks to connect to balanced FRFR speakers, mixers, studio monitors, etc.,
using the ground lift switch if necessary to reduce 60-cycle hum. An additional pair of Humbuster 1/4" jacks
produces the same signal as the XLR jacks and can be used at the same time.

@ Output 2 L+R - (Stereo) — (2) XLR-Male (balanced) — Use the XLR jacks to connect to the balanced inputs
of FRFR speakers, mixers, monitors, etc., using the ground lift switch if needed to reduce 60-cycle hum. You
can also use XLR to TS cables to connect to unbalanced inputs.

Output 3 L+R (stereo) — (2) 1/4” Jacks (Humbuster™) - Output 3 can be used for a variety of applications. It
differs from Out 1 and Out 2 in that it is designed for unity gain applications such as the popular “Four-Cable
Method” and other scenarios involving pedals, tube amps, analog DI recording, etc. Set the OUT 3 Level knob
fully clockwise for unity gain. Section 4 covers some of these applications in detail.

@ Headphones Output — 1/4" Stereo Jack — Connect headphones here to monitor Output 1 (see above).

@ Pedal Inputs — (1,2,3) 1/4" Jacks — used to connect external expression pedals or switches to control
various functions. See “Expression Pedals” on p. 10 and “External Switches” on p. 12.

FASLINK Il Connector — This allows you to connect the FM9 with one or two FC-6 or FC-12 foot controllers.
FASLINK™ uses a standard XLR cable for 2-way communication and also powers the first FC without an
external “wall wart” adapter. (See your FC Owner’s Manual for more on daisy chaining and other options.)

NOTE: The FASLINK Il port on the FM9 is designed for our FC Series of foot controllers and is NOT compatible
with the FASLINK port on our MFC-101 MIDI foot controller.

@ SPDIF In and Out — (Coaxial "RCA” type connectors) — Digital in and out ports allow the FM9 to interconnect
1



2 HARDWARE OVERVIEW

with other digital devices without the added latency of D/A or A/D conversions. These ports operate at
a fixed clock rate of 48k with the capability to use the internal clock or to chase external clock signals
detected at the SPDIF input. The SPDIF output can transmit your choice of signals as determined by the
setting for SPDIF Out Source located in SETUP: 1/0: Audio. (See “I/0: AUDIO Page” on p. 94.)

@ USB — This provides the FM9 with 8x8 USB audio capabilities when connected to a compatible Mac or PC
for use with a DAW or other audio applications. In addition, MIDI-over-USB provides a 2-way connection for
Fractal-Bot and FM9-Edit, and the FM9 MIDI ports appear in your DAW or MIDI program for automation and
remote control. See Section 3: USB for important information on USB.

@ MIDI Ports — The MIDI IN port of the FM9 allows you to control various MIDI functions including preset and
scene selection, effect bypass, channel changes, parameter changes, and more. The FM9 can also transmit
various MIDI messages and features a soft MIDI THRU which can be enabled in SETUP: I/0: MIDI. See
“Sending and Receiving MIDI” on p. 122 for more information on the various ways the FM9 works with MIDI.

@ AC Power Receptacle — Insert the supplied power cable and connect the other end to a grounded AC power
receptacle. The FM9 has a universal power supply, which means it can be used around the world by simply
changing the cable.

The power receptacle has an integrated Power Switch which turns the power on or off. The FM9 features
pop suppression, but it is still advisable to turn down or mute connected devices when powering on or off.
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3 USB
COMPUTER INTEGRATION

With a USB connection to a computer, the FM9 provides 8x8 audio interface capabilities, including computer
audio playback, recording, and re-amping in your DAW or other audio applications. A driver is required for
Windows operating systems. No driver is required for Mac operating systems.

In addition, a computer connection provides high-speed “MIDI-over-USB” for remote control of the FM9, plus
backups, updates, editing, and more.

WINDOWS MINIMUM REQUIREMENTS

0S: Windows 7 SP1 or newer (all versions compatible with x86 or x64).
CPU: Intel Core 2 @1.6 GHz or better, or AMD equivalent.

Memory: 1GB minimum.
USB: USB 2.0 support required.
Driver: A USB driver is required for use under Windows operating systems.

The Windows drivers can be downloaded at http://www.fractalaudio.com/FM9

Step-by-step instructions are included with the installer.

MAC MINIMUM REQUIREMENTS

0S: 0S X 10.9 or later required for USB audio. An issue in older OS X versions causes audio pops.
Note: Older Mac OS versions may work for MIDI-over-USB (Fractal-Bot, FM9-Edit, etc.).

CPU: Intel or Apple M1 Processor.
Memory: 512MB minimum.

USB: USB 2.0 support required.

Driver: No driver is required for Mac 0S.

Important: If you are using a USB-C to USB adapter on a newer Apple computer, plug the USB-C adapter into a
the port on your Mac first, allow it several seconds to “wake up” and then connect a USB cable and FM9 into
the adapter.
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3USB

USB AUDIO

Each of the 8 input and 8 output audio channels is mapped to an audio signal or physical input/output.
As with all USB Audio devices, inputs and outputs are defined with respect to the computer.

Where an input or output has options, the required parameters can be found under SETUP: 1/0: Audio.

Setup Parameter names are shown in the diagram in PURPLE CAPS.

RECORDING

USB Channels

ale
810
(5)(e)

Source

INST

IN1
Il::i :l:::]?’ 7,8 SOURCE)

Applications

Record Processed Audio

Record Processed Audio

Record a DI for re-amping

Record a Stereo Source without processing

PLAYBACK
USB Channels Destination Applications
@ @ OUT 1 L+R Play Computer Audio
)(Cffsbesswtafﬁef MAPPI |
@ @ ‘ OUT 2 L+R Play Computer Audio

® B
E and opt: SPDIF OUT

and/orIN2or 3

Route Audio to the grid for re-amping or processing
(INPUT 1 SOURCE, INPUT 2 SOURCE, INPUT 3 SOURCE)

As above, plus option for playback at digital output
(SPDIF OUT SOURCE)
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BASIC PLAYBACK

The specific steps for playback on a given computer will vary based on its operating system and software, but the
basic idea is to select the FM9 as the audio interface and begin playback.

On Mac 0S, no driver is needed.

= Connect the FM9 to an available USB port.
= On your Mac, open System Preferences: Sound and select the FM9 as the output device (shown below).
= System audio such as Apple Music will be be played back through FM9 Output 1 (Left and Right.)

On Windows you must install the driver first.

* Find FM9 USB Audio Setup at:
https://www.fractalaudio.com/FM9-downloads/

= Once the drivers are installed, open Sound under Control Panel.
= Select the FM9 and then click “Set Default”.
= System audio such as Microsoft Music Player will be played back through FM9 Output 1 (Left and Right.)
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Mac Sound Preferences Windows Sound Preferences

Whichever OS you are using, you can confirm that the FM9 is receiving audio by viewing the Meters page of the
Home menu, where you should see meter activity on USB IN 1L and 1R. If you turn up the OUT 1 LEVEL knob, you
will also see meter activity on ANALOG OUT 1L and 1R and hear audio at the connected speakers.

BASIC RECORDING

The specific steps for recording on a given computer will vary based on its operating system and recording
software, but the basic idea is to select the FM9 as your audio interface, set the project sample rate to 48k, create
a track, assign the desired input, and begin recording. Remember that USB 1+2 will record what you hear at the
main outs of the FM9.
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USB RE-AMPING

The FM9 USB Audio capabilities are perfect for “re-amping,” a method in which the raw, unprocessed DI output of
a guitar is recorded and then re-processed later through the amp, cab, and effects of your choice.

Re-amping has many benefits. First, it allows you to record when inspiration strikes, capturing a DI instead of
obsessing over the final tone. Later, you - or a mix engineer — can redesign the sound as your track’s production
advances. Punches and edits made on the DI track are also made virtually inaudible by the re-amping process.

The FM9 allows you to dial in new tones while simultaneously listening to the track for context.

STEP 1: RECORDING

The following tutorial assumes that you have connected Output 1 L/R to monitors or headphones and that
SETUP>1/0 parameters are at default values. The details may vary from one DAW to another, but this guide should
be easy to adapt to your own environment.

1. Inyour DAW, select the FM9 as the main audio interface. Set the main outputs to FM9 Outputs 1+2.
Create a new project in the DAW, and set its sample rate to 48kHz.

OPTIONAL: Record or insert any backing tracks and test their playback at FM9 Output 1.

Connect your guitar to the Instrument input of the FM9 and select any preset desired.

Now record the DI:

= Create a mono track. Name this track something like “Guitar DI”. Set its input to FM9 Input 5.
This will record the signal at the Instrument jack with no processing.

= Arm the Guitar DI track for recording, making sure that Software/Input Monitoring is NOT enabled.
Start RECORDING. You should hear the processed guitar but record the DI.
Note: You can simultaneously record the processed guitar at the same time by arming a different stereo
track to record FM9 USB Inputs 1 and 2.

= Be aware: while a processed track will show “hot” levels, the level of a DI track will appear to be very low.
This is NORMAL! You are recording the “raw” signal exactly as it comes out of your guitar.

= Be aware that foot controller actions such as expression pedal and footswitch presses are not recorded.
= YOU HAVE NOW RECORDED YOUR DI.

STEP 2: RE-AMPING

Before re-amping, you must first change some settings on the FM9. Press HOME and open SETUP. Navigate to
the 1/0 menu, and change Digital Input Source to USB (CHANNELS 5/6). Then nav down a few rows and change
Input 1 Source to “DIGITAL". You must change this Input 1 Source back to “ANALOG” when you finish re-amping!

6. Change the output of your “DI”" track to FM9 Output 5.

7. NOTE: You may wish to turn down the volume of your studio monitors before testing playback!
To test playback, optionally solo the DI track, rewind to where the DI clip begins, and press PLAY. You should
hear the DI being processed by your FM9 preset.

8. Now prepare to record the processed output of the re-amp:
= (Create a stereo track. Name it something like “Guitar Re-Amp 1".
= Set its inputs to FM9 Inputs 142.
= Arm your re-amping track for recording, making sure that Software/Input Monitoring is NOT enabled.

9. Rewind, press RECORD, and roll the track. The DI plays into the FM9 and its output is recorded.
YOU HAVE NOW RECORDED THE RE-AMPED TRACK.

aRwbn

This simple method can also be adapted for re-cabbing, adding effects to a printed track, etc.
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4 SETTING UP

4 SETTING UP

This section provides an overview of using the FM9 in various setups using third-party equipment. When you
test any new setup, always proceed slowly with all level knobs turned all the way down. The FM9 features pop
suppression on startup, but speakers or monitors should be powered on last whenever possible. A basic AC surge/
spike protector is also recommended. Remember that the FM9 is extremely flexible. There are countless setups
not detailed here.

GENERAL PRINCIPLES

INPUTS

» Setting Input Levels is important. See “Setting Levels” on p. 5.

» The Input 1/Instrument jack features “Secret Sauce IV” to lower the noise floor, but you can
also safely connect guitars and other instruments to Input 2 or Input 3 with good results.

» Inputs 2 and 3 are balanced. Use balanced 1/4" cables when connecting to balanced devices.
Use normal TS guitar cables when connecting to unbalanced devices.

OUTPUTS

» Outputs 1 and 2 default to “-10" dBV, a lower level “consumer” format. Change to “+4” dBu
when connecting to pro audio equipment. Find these settings under SETUP: 1/0: Audio.

» Use XLR cables when connecting Out 1 or Out 2 XLR outs to the XLR inputs of other devices.

» Use XLR female to TRS male cables or adapters when connecting Out 1 or Out 2
XLR connectors to the balanced 1/4" TRS inputs of other devices.

» Use the Out 1/0ut 2 ground lift switches if required to combat the hum caused by ground loops.

» Use XLR female to TS male cables when connecting Out 1 or Out 2 XLR
connectors to the unbalanced 1/4" inputs of other devices.

» Use Humbuster™ cables (see p. 6.) or regular guitar patch cables (1/4" tip sleeve) when connecting Out
1 or Out 3 1/4” Humbuster outputs to to the unbalanced 1/4” inputs of pedals, amplifiers, and other devices.

» Output 3 operates at unity gain when the Out 3 Level knob is turned fully clockwise.
The optional Boost/Pad setting can help lower the noise floor of Out 3 in some cases. See p. 95 for details.

MONO/STEREO

» Any setup can easily be adapted for mono or stereo with some simple changes to input and output settings.
» See ‘Mono vs. Stereo” on p. 6 for an introduction to this topic.

SPECIAL AMP BLOCK SETTINGS

» When using the FM9 amp block into traditional (not full range) guitar speakers, certain advanced amp
parameters require consideration. Turn off Speaker Drive and Speaker Compression. Also consider
setting LF Resonance Frequency to match the resonant frequency of your connected cab if you know it.

» The Amp block also includes an Output Mode setting which optimizes the output when using
either speaker sims and FRFR speakers or a solid state power amp and real guitar speakers.

FC CONTROLLERS

» Any setup shown here also works great with one or more FC-6 or FC-12 foot controllers connected.
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4 SETTING UP

FRFR/DIRECT

Global Settings: Default
Presets: Factory or Custom

This setup takes advantage of the ability of the FM9 to recreate all aspects of an “end-to-end” guitar chain, including

virtual stompboxes, amps, cabs, studio effects, and more. It is the most versatile, flexible, and popular setup.

Output 1 is connected directly to full-range, flat response (“FRFR") speakers or a PA. A number of manufacturers
offer FRFR products designed specifically for guitar, but any high quality PA speaker or monitor can be used.
Some FRFR systems have a built in amplifier, while others have separate power amp and speaker components.

All Global and 1/0 settings on the FM9 can be left at default settings for this setup, and factory presets can be
used without modification.

Adjust overall levels using the front panel OUT 1 knob.

An optional FC-6 is shown in this diagram. The FM9 is designed to be expanded with up to two FC Controllers.

CONNECTIONS

» Connect your guitar to
Input 1 (Instrument).

» Connect Output 1 to
the input(s) of your
FRFR System. Use Left
for mono or Left and

FASLINK 11
Port (Male)

Right for stereo.

» If you're using a mixer,
be sure to connect the
FM9 to line level inputs
rather than mic level

inputs. Also, “zero out” FASLINK Il

) . Y Port (Female) 0pti0na|
all other channel settings  OUTPUT optional FC-12 or FC-6
to begin. Contact your © 1R . forStereo

-——-

mixer’s manufacturer if
you have any questions.

PERSONAL
FRFR
MONITORS
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FM9 AS AUDIO INTERFACE

Global Settings: Default
Presets: Factory or Custom

The FM9 is a high quality audio interface that can be
used for recording or playback. The setup shown here
has the advantage of allowing easy USB re-amping.
Note that all computer audio and project settings must
be set to 48 kHz, which is the fixed rate of the FM9.

Connect studio monitors directly to Output 1 L+R.

The top panel OUT 1 level of the FM9 is the master
volume, adjusting the overall levels of the FM9 and
computer playback simultaneously. For USB audio
playback level control, adjust levels inside the
computer or use the level parameters of the FM9
found in SETUP: 1/0: USB.

Besides Input 1, the other inputs of the FM9 can also be
used to record microphones, keyboards, and more.

OUTPUT
1L

OUTPUT
1R

FMO9-Edit and Fractal-Bot use the same USB connection.

STUDIO MONITORS COMPUTER

FM9 + THIRD-PARTY
AUDIO INTERFACE

As detailed above, the FM9 is a high-quality, standalone
USB audio interface, but it can also be used to add
world-class guitar processing and effects to an existing
studio setup with a third-party audio interface.

While this does not allow re-amping over USB, there are
many reasons why you might prefer an existing interface,
such as the ability to run at sample rates other than 48k,
or to take advantage of additional inputs or outputs, mic
preamps, etc.

» Connect your guitar to FM9 Input 1 (Instrument).

» Connect your studio monitors and computer
to your audio interface according to the
instructions of its manufacturer.

» Connect FM9 Output 1 L+R to a stereo line

level input pair on your audio interface. COMPUTER

» Connect the FM9 to the computer via USB
to enable FM9-Edit and Fractal-Bot.

STUDIO MONITORS




4 SETTING UP

NEUTRAL (“FLAT") POWER AMP & GUITAR CAB

Global Settings: Modified (see below)
Presets: Factory or Custom

This popular setup uses a full range flat response (“FRFR”) power amp with traditional guitar speakers. Such
amps are usually solid-state and designed specifically for pro audio or FRFR guitar. They are ideally tonally neutral
and dynamically transparent though some may have basic tone controls and/or some effect on “feel.”

The FM9 performs amp modeling but NOT speaker cab simulation. Effects can be used as desired in any position.

DISABLE SPEAKER CAB MODELING

Using real speakers and modeled speakers at the same
time would be redundant, so this setup requires you to
disable or remove the FM9 Cab blocks. You can do this
manually in each preset, or take advantage of an easy
global setting:

» Navigate to SETUP: Global Settings: Config.
» Change Cabinet Modeling to “BYPASSED".

A “NEUTRAL’ POWER AMP...

In comparison to the neutral power amp used here,
the power section of most guitar amps has a very
pronounced effect on tone and feel. Here, however,
the FM9's “Power Amp Modeling” simulates these
characteristics. This has several benefits. First, since
one amp's power section can be so different from
another’s, a modeled power amp ensures accuracy
when you change amp model types. The power amp of
a “deluxe” is extremely different the power amp of a
“recto”, for instance. Therefore, do NOT disable power
amp modeling on the FM9 when using a neutral power
amp.

One setting you should change, however, is Output
Mode, located near the top on the Advanced page of the
Amp block’s edit menu. Set it to “SS PWR AMP + CAB".
In this mode, virtual speaker compression behaves
differently, relying on the real speaker for compression
while still simulating speaker interaction with the virtual
power amp.

CONNECTIONS

»
»

Connect your guitar to Input 1 Instrument.

Connect Output 1L to the input
of your power amp, which will typically be balanced.

For an unbalanced input, use a Humbuster™ cable.

Connect the power amp to a speaker
as directed by the manufacturer.

FM9

GUITAR
SPEAKER
CABINET
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TRADITIONAL GUITAR POWER AMP & CAB

Global Settings: Modified (see below)
Presets: Factory or Custom

This setup uses traditional guitar speakers and a traditional guitar power amp—that is, one with a pronounced
effect on tone and feel. This amp may be the “power section” of a head or combo, accessed via an “FX RETURN"
input on the amp, or it may be a standalone power amp for guitar.

DISABLE POWER AMP MODELING CONNECTIONS

The “non-neutral” power amp in this setup contributes » Connect your guitar to FM9 Input 1 Instrument.
considerably to the overall sound. We will therefore » Connect the FM9 to the power amp

disable “Power Amp Modeling” in the FM9 so as to not input using FM9 Output 1 (1/4" jack)

apply power amp characteristics twice! The FM9 will using a Humbuster™ cable.

continue to model the preamp. » Connect your power amp to a guitar speaker

You can disable power amp modeling manually in the cabinet as directed by the manufacturer. (If it's
Amp blocks of your presets (this parameter is on the a combo, the speaker is already connected.)
amp’s Power Amp Page), or you can take advantage of
an easy global setting:

» Navigate to SETUP: Global Settings: Config.
» Change Power Amp Modeling to “OFF".

i%

FM9

(NOTE: Some power amps are in fact more subtle, and
some players like to leave Power Amp Modeling ENABLED
with this type of setup. Try it both ways and decide for
yourself.)

__________

ST

Optional for Stereo
to a second amp

FX RETURN

DISABLE SPEAKER CAB MODELING

This setup also uses traditional guitar speakers, which Amplifier
apply strong tonal coloration. Using modeled speakers HEAD OR %

at the same time would be redundant, so we must COMBO ° 00009° ©
disable or remove the FM9 cab block. You can do this WITH

manually in every preset, or take advantage of an easy POWER AMP IN
global setting: OR
FX RETURN
» Navigate to SETUP: Global Settings: Config.
» Change Cabinet Modeling to “BYPASSED".

0l0.

Q ”,

Hmumumuu e— ””--U
e 2(e 2 -0

NOTE: Instead of the power section of a head or cab,
you can also use tube power amp designed for guitar.



4 SETTING UP

FRONT-OF-HOUSE + PERSONAL FRFR MONITOR

Global Settings: “Out 2 Copy Out 1" Turned ON
Presets: Factory or Custom

This setup sends identical signals to the front-of-house PA and your personal FRFR monitor, with separate level
and global EQ controls for each. As in other Direct/FRFR setups, the FM9 creates a fully modeled end-to-end guitar
sound for the ultimate in flexibility—stompboxes, amps, cabs, post effects, and more.

Output 1 is used for your personal monitor. It can be connected with XLR or using a Humbuster™ cable if the monitor
does not have a balanced input. Set your personal levels using the front panel OUT 1 knob.

Output 2 is sent to front of house as an independent copy of Out 1 with its own level control from the
front panel OUT 2 knob. (PRO TIP: Set it and forget it... make the sound tech happy!) Instead of inserting
the Output 2 block manually in every preset, use this simple trick: navigate to SETUP: 1/0: Audio and change
Output 2/Copy Output 1 to “ON”. Output 2 will now replicate the signal being at Output 1.

CONNECTIONS

» Connect your guitar to FM9
Input 1 (Instrument).

» Connect Output 1 to the input
of your FRFR monitor.

» Connect Output 2 to the
front-of house system.

= |f you are working with a sound
technician, be sure to tell them
that you are outputting a line
level input — NOT a microphone
level signal. They should use a
balanced line input without a
preamp.

= Also tell them you are sending
a fully processed “mix-ready”
sound, and that they should
“zero” the channel with no EQ or
processing, at least to start.

Optional
for Stereo

PERSONAL FRFR MONITOR FRONT-OF-HOUSE
MIXER/PA
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FRFR FRONT-OF-HOUSE + GUITAR CAB BACKLINE

Global Settings: Default Presets: Custom

This setup sends one signal WITH cab sims to Out 1, and a second signal WITHOUT cab sims to Out 3. This is requires
special presets to tap the signal path at two different points. The first signal goes direct to front-of-house. The second
signal feeds a power amp and real guitar speakers for an authentic backline experience. (There is a factory preset
“Template” for this setup towards the end of Bank C.)

| N1 H wan H pRv H AMP H cHo [ by |+{ caB [HouT1]

ouT3

Front of House - The signal with speaker sims is sent via Out 1 to the PA. It has all the benefits of going direct: great,
consistent tone at the perfect level controlled using the OUT 1 knob. Remember, when connecting to a mixer, use
line level inputs and avoid mixer settings that might undesirably color the sound. Notice that the Cab block above
is shown after the “post amp” FX (Chorus and Delay). If a stereo signal is required at Output 1, the cab block must
also be set up for to stereo. Learn more about the Cab block in “The Fractal Audio Blocks Guide”.

Backline - This signal is basically identical to the first, but without speaker simulation which would be redundant
with the real speaker. This provides all of the benefits of modeling the amp and effects, plus the familiar playing
experience of loud guitar speakers (“stage level,” sweet singing sustain, moving air, ringing ears...).

This requires a neutral power amp (see p. 30) since power amp modeling must be ENABLED for Out 1 to send a
direct signal to FOH. (You could use a more complex dual Amp block preset with a non-neutral power amp.)

....................

: OUTPUT | optional
' : for Stereo

Optional
for Stereo

POWER
AMP

olooo/el ::: - (lilie 2 2@ 2 2
O|0|0 00000 ouT
O|0O|0O|0O|0000 ::

commenceeooos 551 FRONT-OF-HOUSE

segeggssl ™ SPEAKER
DEHEIEEEEE S'I’"“R CABINET

CONNECTIONS

» Connect your guitar to Input 1 (Instrument). » Connect Out 3 to the input of your “neutral”
power amp (see p. 30). If your power amp

has balanced inputs, substitute Out 2 for
Out 3 wherever it is used in this setup.

» Connect Output 1 to the front-of-house PA.

» Connect your amp to a speaker cab
as directed by the manufacturer.



4 SETTING UP

FX PROCESSOR ONLY (“PRE")

Global Settings: check I/0 Mono/Stereo settings; See the tip about optimizing for low noise, below.
Presets: Custom

In this setup, the FM9 is used as a virtual pedalboard, providing access to our vast collection of industry-leading
effects. It is placed between your guitar and amp like traditional pedals. You'll need custom presets, but as with
all FM9 setups, you are free to create what you need. Presets should NOT contain Amp or Cab blocks for this
setup. They should be created with an understanding of how effects sound in front of your amp’s preamp and the
distortion it generates. (You may wish to look into the term “pedal platform amp” for more on this subject.) FM9
Output 3 is used in this setup, because it is designed for unity gain operation. A sample preset is shown below:

[ N1 H cmp H{wan | prv | by H Rev |Hours)

CONNECTIONS

» Connect your guitar to FM9
Input 1 (Instrument).

» Connect Output 3 L to the input of your amp.
A Humbuster™ cable is recommended.

= To extend this configuration for optional
stereo, connect Output 3 R to the input of a
second amplifier.

» You can in fact use the FM9 to select
between two different amps by changing
channels on its Out 3 block. Here are some
sample settings: A __ ... N
- Channel A: Balance Center (Both Amps) : :
- Channel B: Balance Left (Left Amp) Rty '
- Channel C: Balance Right (Right Amp)

- Channel D: (Not used)
(See “Scenes & Channels” on p. 49 for g

Stereo

more info.) 8000000 *lJ |
» Set the FM9 OUT 3 knob fully clockwise €L m'COMBO GUITAR
for unity gain if desired, and adjust AMP

your amp as you normally would.

TIP: OPTIMIZE FOR LOW NOISE

The optional Boost/Pad function of Output 3 can be used to lower the noise floor. Find this under
SETUP: 1/0: Audio. To find the right setting, adjust it to be as high as possible without clipping,
as indicated by the red LED on the unit’s top panel. The volume won't change as you make
adjustments, but you should hear the FM9’s noise floor drop as you increase boost/pad.
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FX PROCESSOR ONLY (“POST")

Global Settings: check I/0 Mono/Stereo settings; See the tip about optimizing for low noise, below.
Presets: Custom

The FM9 can be used as a processor in the loop of an amp, providing access to our industry leading effects for
those who may not be not ready to make the jump to amp modeling. (Don't worry, we still like you!)

FM9 Input 3 is used in this setup to accommodate your amp’s line level FX send.
FM9 Output 3 is used in this setup, because of its unity gain capabilities.

You will need to create custom presets for this setup. These must have NO Amp or Cab blocks, and must contain
only those effects that sound good to you after the distortion stage of your preamp. An example is shown below:

(N3 H eq HcHo [ LA byt Hbwvz H rev |Hours)

CONNECTIONS ‘
» Connect your guitar to your amp’s |£ m
instrument input as you normally would. ~ Lr—j——

» Connect the FX Send of your amp to
FMO9 Input 3 L. Adjust Input trim on the INPUT
FM9 if needed in SETUP: 1/0: Input.

» For the setup shown here, set Input 3 Mode to

.

. OUTPUT ' Connectto FXRTN
3R : of a second amp for
""""" optional stereo.

EESE=y,

“LEFT ONLY” under SETUP: 1/0: Audio. (It is rare FX &
but not unheard of to use two preamps in stereo.) SEND £
» Connect FM9 Output 3 L to the FX Return of your — ) AMP ) .
amp. A Humbuster™ cable is recommended. @freeique &5
» Set the front panel OUT 3 knob fully ~
clockwise for unity gain, or as desired 80 00009 & IN

for appropriate volume levels.

» To extend this configuration for optional stereo,
you would typically connect Output 3 R to the FX
return of a second amplifier.
SPEAKER

PARALLEL FX LOOP? CABINET
If your amp’s FX loop is parallel, your FM9 presets must

be further customized so that no dry signal passes

through the FM9. This generally limits the effects you

can use, how they must be arranged, what their mix (! )

setting must be, and more. If your amp is switchable, a
series loop is certainly easier to use in this setup.

TIP: OPTIMIZE FOR LOW NOISE

The optional Boost/Pad function on Output 3 can be used to lower the noise floor. To find the right
setting, adjust this to be as high as possible without clipping, as indicated by a red LED on the front
panel meters. The volume won't change but you should hear the FM9's noise floor drop as you
increase boost/pad. Find this option under SETUP: 1/0: Audio.
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4 SETTING UP

FOUR-CABLE METHOD (“4CM")

Global Settings: Default, but see “Tip” Below  Presets: Custom

The Four-Cable Method (“4CM") uses custom presets to insert the FM9 at two different points along a long signal
chain. This setup was more popular years ago, but as amp modeling improves, fewer and fewer players use it.

First, a chain of “pre” effects like wah and drive are used between the guitar and your amp'’s preamp section.
Next, a chain of “post” effects like delay and reverb are placed in your amp’s FX loop. The 4CM preset therefore
contains two independent paths, each requiring its own separate in, out, and FX blocks. A 4CM presets contain no
Amp or Cab blocks. A stylized illustration appears below.

[ IN1T H{waAHH DRV H{ == }ouTs)| IN3 - by H REV H <= HouT1

Pre-FX Post-FX

Signal hits the FMO first, where it is processed by the pre effects. Output 3 feeds the front of your amplifier. The
amp’s FX Send is connected to Input 3, and a chain of post effects processes signal and passes it to Output 1
and your amp’s FX Return. Note that the pre and post chains are not connected to each other at all on the FM9
grid. In fact, either chain can be as simple or as complex as desired.

CONNECTIONS

» Connect your guitar to FM9 Input 1 (Instrument).

» Connect FM9 Output 3 L to the front input of
your amp using a Humbuster™ cable to combat
hum from ground loops. Set the front panel OUT
3 knob fully clockwise for unity gain operation.

-
» Connect your amp’s FX Send to Input 3 L. S T . s )
FM9 Input trim can be adjusted in SETUP: 1/0: oo ]

Audio. On the same page, set Input 3 Mode

to “LEFT ONLY”. Also see the “Tip” below. OUTPUT [ oUTPUT INPUT OUTPUT
» Connect Output 1L (1/4") to the FX Return . ::nal 1|L yy *
of your amp using a Humbuster™ cable. Set for Stereo. Ex -
the front panel OUT 1 knob as desired for RETURN SEND
| |

appropriate volume. To extend this configuration
for optional stereo, connect Output 1 R to
the FX Return of a second amplifier.

TIP: OPTIMIZE FOR LOW NOISE
Even with Humbuster cables, the 4CM can
be noisy. The optional Boost/Pad function

on Out 3 can help to lower the noise floor.
To find the right setting, adjust this to be as high as
possible without clipping, as indicated by a red LED on
the top panel. The volume won't change but you should

hear the FM9's noise floor drop as you increase boost/ Q Q

Amplifier
8o 000OIS !

Guitar
Amp

y—~

pad. Find this option under SETUP: 1/0: Audio.

If your amp has a parallel FX loop,
please see the note on p. 35
\ ),




4 SETTING UP

INSERTING OUTBOARD GEAR

Global Settings: As per your usual setup, check I/0 Mono/Stereo Settings
Presets: Custom

The extra ins and outs of the FM9 can be used in a “send-and-return” loop for outboard gear. Custom presets are
required for this setup, with output and input blocks added for the send and the return (see illustration below).

OUTBOARD
in___out

Serves as a SEND lServes as a RETURN

| IN1 | cmp |- waH [ bRV H AmP H caB ]—[OUT3]— IN3

Signal passes through the grid to the OUT 3 block where it leaves the FM9 to be processed by the external device.
The outputs of the external device are connected to Input 3. Additional blocks can be used before finally passing
signal to Out 1. Notice that the Out 3 block IS connected to the IN 3 block. This is because Input 3 is specially
designed to work as a bypass for the entire loop, allowing signal to flow even when the outboard gear is not in
use. You can operate this with a footswitch, or control it with scenes.

One final comment: don't jump to the conclusion that an insert is the best way to use 3rd party gear. You can
achieve great results simply by connecting things in series like traditional pedals. The FM9 works great when
used with pedals between your guitar and its input. Similarly, you can connect FM9 outputs to the inputs of other
processors. One advantage of using an insert, however, is that outboard gear can be controlled by FM9 presets,
scenes, and footswitches, or even recorded via USB.

CONNECTIONS

» Connect your guitar to FM9 Input 1 (Instrument). A —
i L EESEEESSE==
» This example assumes Output 1 is connected to a Py v S

PA or FRFR monitors, but the principles you learn &
here can be applied to other rig designs as well. INSTRIN

» Connect Output 3 L as a “send” to the input
of your outboard device using a Humbuster™ FM9

cable. Use Output 3 R for optional stereo. H

» Adjust output levels using the front panel
OUT 3 knob, remembering that setting it
fully clockwise provides unity gain.

OR
ST\ @

= Use input trim and/or output level controls on "oy OUI:UT
your outbpard device as needed for optimal INPUT
gain staging. 3R
» Connect the output of your outbhoard device to "dliﬁ:l]'T"
Input 3 L as a “return.” Use Input 3 R for optional 3R

stereo. Use guitar cables or balanced cables e Optional
as appropriate. Adjust Input 3 levels as needed for Stereo
in SETUP: 1/0: Audio. Also see the TIP about
noise optimization on the preceding page.

. OUTBOARD GEAR
» NOTE: Other FM9 inputs and outputs can be (PREAMP, PROCESSOR, PEDAL, ETC.)

used in the same way for additional inserts.

The FM9 can send MIDI to control 3rd party devices. Connect a MIDI cable from the MIDI Out of the
FM?9 to the MIDI IN of the connected device. Then program the required MIDI messages using either a
“Scene MIDI Message” or a “Control Switch MIDI Message”.
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4 SETTING UP

ELECTRIC AND ACOUSTIC

Global Settings: Set Input 2 Mode to “Left Only” under SETUP: 1/0: Audio
Presets: Custom

This setup is provided for those who wish to use the FM9 to process an electric guitar and an acoustic guitar at
the same time. It also works for guitars equipped with dual output magnetic and piezo pickups. Special presets
containing the Input 2 block are required as illustrated below. For this setup, the electric and acoustic signals are
combined into one stereo output, but if you learn to use Input and Output blocks, this will open other options such
as different guitars appearing at different outputs.

CONNECTIONS

»

Connect your electric guitar to
FMO Input 1 (Instrument).

Connect your acoustic guitar (or the piezo side
of your electric) to FM9 Input 2 L. Set Input 2
Mode to “LEFT ONLY" under SETUP: 1/0: Audio.

Connect FM9 Output 1 to your PA, mixer, or

monitors as you would in any other “direct” setup.

Create a preset as shown below where IN 1 is the
electric guitar and IN 2 is the acoustic/piezo.

A variety of blocks can be used to process

an acoustic guitar. In many cases, a bit of
compression and EQ is all you need, but another
good option is the TUBE PRE model in the amp
block, with or without a Cab block loaded with

a custom IR designed to enhance the piezo

tone with the sound of a mic'd acoustic.

Note that in the example, the two chains
are sharing a reverb block, which sounds
great and is also economical. It is also
possible to share many other blocks.

If you wanted the acoustic to go to its
own output, you could insert the OUT 2
block and connect to that instead.

EXAMPLE PRESET

Electric

[ (Illlg':R) ] INPUT 2L

..........

..........

P.A. or FRFR MONITOR

| INT H{WAH [ DRV | amp1 H cas1 H DLY

REV |-{ouT1|

[IN2 HempH EQ Fawpor- CHO |

Acoustic



5 PRESETS

9 PRESETS

OVERVIEW

ul

Please review “Intro to Scenes and Channels” on p. 15 before reading this section.

The FM9 contains 512 preset memory locations.
Each preset is like a full rig with its own amp, cab, effects, and more.

Every memory location, including the Factory Presets, can be modified and/or completely overwritten.

If you want to restore the factory presets (or install the newer versions we sometimes release),
you can download these from https:/www.fractalaudio.com and install using FM9-Edit.

Every preset has its own name that you can change as you store it.

Presets are built on the Layout Grid by inserting, connecting, and dialing in Blocks.
Every preset contains eight Scenes, each with its own name.

Blocks contain Channels. Change the channel to dial in a completely different setting!

FM9 Turbo has 10+% more DSP than FM9 Standard.
Every FM9 has more CPU power than the FM3, but less than the Axe-Fx Ill.
Still, a single preset can still potentially cover an entire song, or even an entire gig.

SELECTING PRESETS

Different areas of the FM9 provide different ways to select (or “load”) presets:

On the Home page - Use the NAV LEFT and NAV RIGHT buttons or turn the VALUE knob.

On the “PRESETS" directory page of the HOME menu - Use the NAV buttons to
select a preset and press ENTER. Presets in the directory are sorted in numerical
order. To re-sort alphabetically, press the SORT A-Z button (Push-knob E).

Foot Switches - FM9 footswitches have a range of “preset select” options.

MIDI - MIDI Bank and PC messages may be used to select presets using the industry-
standard “CC#0 + PC" method. See “MID| Reference Tables” on p. 124. MIDI Custom
PC Mapping is also supported, see “Program Change Mapping” on p. 53.

FM9 Home Perform-PP Perform-GBL »

099: FM9 Awesome

Heavy Heavy

Sweet Clean FX

Crunch FX

Basic Drive Tighter Gate
Wide Rhythm

QOutro FX /Ext 1 = FB

Postmaodern Rings Twice

4-Channel Synth Sequence

LAYOUT CONTROLLERS | | FC PER-PRESET SETUP

The Home Page of the Home Menu
39
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5 PRESETS

THE LAYOUT GRID

The grid is a 14x6 framework for building presets. Think of grid spaces as slots. Blocks are inserted on the grid
and connected together to create a signal processing path. Each grid space and every cable is stereo (though not
all blocks are). You don't need separate left and right paths!

Access the grid from the Home page by pressing the ENTER button or the LAYOUT Push-knob.

In the default view, the FM9 display shows only a 6x6 section of the grid. Navigate to off-screen areas using the E
knobs, or the NAV buttons. A bottom scrollbar indicates where you are in the overall left-to-right layout. To show the
entire grid at once, zoom out with the ZOOM button (Push-knob A).

Meters  Tools Layout oPu 40% Meters  Tools

(> Scene: 1 Channel Block Level Row Column (3 Scene: 1 Channel Block Level Row Column
Z00M BYPASS DELETE CABLE CONTROLLERS | Z00M J BYPASS DELETE CABLE CONTROLLERS
The grid normally shows a partial view of its rows and columns. Zoom out to show the entire grid at once.
You can scroll left or right with navigation controls. This also reveals VU meters for leveling scenes and presets.

WORKING WITH BLOCKS

As explained in “Intro to the Layout Grid” on p. 14, FM9 presets are using blocks pulled from a large inventory
of amps, cabs, stompboxes, studio effects, mixers, and more. To navigate around the grid you must move the
cursor — a yellow rectangle controlled by the NAV buttons or the D or E knobs.

TO INSERT A BLOCK...

NAV to the desired grid location.

Turn the VALUE wheel to step through the list of blocks.

Press ENTER to confirm or EXIT to cancel changes.

As you insert blocks, they are removed from the list, but every preset has the entire inventory to begin with.

»
»
4
»

TO CHANGE OR REMOVE AN EXISTING BLOCK...

» To CHANGE a block, select it and turn VALUE to the desired type.
» To REMOVE a block, select it and turn VALUE until “None” is displayed.
» Press ENTER to confirm or EXIT to cancel changes.

TIP: A shortcut makes it easy to remove an existing block or convert it to a shunt. Select
[ DELETE ] the block and press the DELETE button (Push-knob C). A deleted block is replaced by a
shunt. Delete a shunt to leave an empty space.
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5 PRESETS

TO BYPASS OR ENGAGE A BLOCK ON THE GRID...

» Use NAV buttons to select the block.
» Press the BYPASS button (Push-knob B). Bypassed blocks are dimmed or “grayed out” on the grid.

RESETTING A BLOCK/CHANNEL

Blocks on the FM9 remember their last used settings, even as you place them on the grid. You may want a fresh
start before or after making changes. RESET takes only two button presses and can be performed at any time.

» Ifitisn't already open for editing, select the desired block on the grid and press EDIT.
[ RESET ] » Press the RESET button (Push-knob A). You are prompted to reset the current channel.
» Press ENTER to confirm. You can reset other channels in a block as they are used.

SHUNTS

A shunt is a sonically transparent block—like a cable which carries signal from one point to another. Like grid
spaces, a shunt is stereo; you don't need two for left/right. You can use shunts to span empty space in any preset.

TO INSERT A SHUNT...

» NAV to the desired grid location and turn VALUE until “SHUNT" is displayed.
» Press ENTER to confirm or EXIT to cancel changes.

INPUTS AND OUTPUTS

Input and Output blocks are required to get signal to the grid or pass it to the outputs jacks. All factory presets
use Input 1 and Output 1. Other setups may require different Input and Output blocks.
See Section 4 on “Setups” for examples. See “The Fractal Audio Blocks Guide” for more information.

BLOCK DISPLAY TYPES

The color display of the FM9 shows different grid block states as follows. Several examples appear below. Notice
that the selected block has a bold yellow outline and the bypassed block is grayed out.

Input Bypassed Selected Normal Shunt Output
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MOVING BLOCKS, ROWS, AND COLUMNS

A special “Tools” page in the Layout menu contains various utilities to MOVE individual blocks or entire rows
or columns UP, DOWN, LEFT, or RIGHT. When a block or a grid row or column is moved, it swaps places with the
item in the space it is moved to. This may result in certain connector cables being modified or removed, so be
sure to look over how the elements of your preset are connected before moving things around.

» Open the Tools page of the Layout menu.

» Select a function with the FUNCTION knob (A): Move Block/Column/Row, Left/Right/Up/Down.
» Use the NAV buttons to select the Block, Row, or Column you wish to move.

» Press ENTER or push knob C to execute the move.

CONNECTOR CABLES

Just like physical gear, the blocks in the FM9 need to be connected together for signal to flow. This is done using
virtual cables, which run from one grid block to another. With even one cable missing, your preset may be totally
silent! Like shunts, connectors are stereo and totally transparent.

TO CREATE A CONNECTOR CABLE...

» On the grid, navigate to the block where you wish the cable to BEGIN. You can't start from an EMPTY space!
» Press the CABLE button (Push-knob D), or ENTER. The selected block
and its neighbor to the right will alternatingly flash.

» If you wish to connect to a different ROW, use NAV up or nav down to
select the desired destination. You can’t skip columns!

» Press ENTER to make the connection. To cancel, press EXIT instead.

= Be sure to select a destination that is not already connected to the block
you started from, or you will REMOVE that cable (see below).

TO REMOVE A CABLE CONNECTOR...

Cables are removed in much the same way as they are created.

» On the grid, NAV to the block where the cable begins.

» Press the CABLE button (Push-knob D), or ENTER. The selected block
and its neighbor to the right will alternatingly flash.

» NAV to select the “other end” of the cable you wish to remove. You can't skip columns!
» Press ENTER and the cable will be removed. To cancel, press EXIT instead.

SHORTCUT: To connect across multiple empty grid columns with a series of shunts and cables,
select any block that is followed by a series of empty spaces, then press-and-hold the ENTER
button. The intervening spaces will be automatically filled with shunts and connected with cables.
Careful: any existing cables encountered along the way will be REMOVED!

_ in/stereo out. The grid allows up to six full stereo paths, and you do NOT need to create parallel grid
"-.xx =&  paths for simple stereo! Some blocks internally process audio in mono (such as Amp or Drive) but
“._/ even these generally have Input Select and Output Balance parameters.

9 Remember, on the FM9 grid, each component is STEREOQ. Shunts, cables, and many blocks are stereo
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THE RULES OF FM9 CABLES

» No cable = No sound. Even one missing link will break the chain.

» Signal flows from LEFT to RIGHT.

» A cable MUST originate from a BLOCK or a SHUNT. You cannot start from an EMPTY location.

v

If you try to connect to an EMPTY location, a SHUNT will be created there.

v

You can ONLY connect to blocks in the next column to the right.

The diagram below illustrates the above:

The % is the block where we will begin.
The v shows valid possible destinations.

The © symbol shows destinations that are illegal/unavailable.

dE@@
alzgitle

JYWE
zlele

Any columns farther left or right would also be illegal/unavailable.

If the Y were in a different ROW, every v would still be in the same place.

» You may freely SPLIT or MERGE up to six ways at any point. This is sonically transparent and there is zero
risk of signal degradation or phase problems. CROSSING is also possible. Here are some examples:

Split Merge Cross Complex

—
-

i
.
s

_ J/\ J

ol
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BLOCK INVENTORY

For a complete guide to all blocks and parameters, see “The Fractal Audio Blocks Guide”
The following table contains an overview of every block. Each preset has the entire inventory to choose from.

BLOCK DESCRIPTION

AMP Amp Here it is! 289+ amp models in one block!

CAB Cab Speaker cab simulation with both “Factory” and “User” banks.

CHO Chorus Create classic mono and stereo modulation effects including vibrato.
CMP Compressor Control dynamics and add sustain.

XVR Crossover Divide a signal into low and high frequency bands.

DLY Delay Up to 8000 ms of delay, with types for analog, digital, tape, and more.
DRV Drive Types including boost, overdrive, distortion, fuzz, and many more.
ENH Enhancer Classic and modern modes to create and control spatialization.

FLT Filter Includes low pass, high pass, band pass, and many other types.

FLG Flanger Various types cover everything from subtle modulation to extreme jet.
FOR Formant Create dynamic vowel sounds with this multi-mode formant filter.

GTE Gate/Expander Useful for everything from subtle control to extreme effects.

GEQ Graphic EQ A variety of modes allow easy, flexible tone sculpting.

IN Input Injects the signal from physical inputs onto the grid.

LPR Looper A powerful looper with great remote control options.

MGT Megatap This 40-tap delay creates fantastic sonic patterns.

MID MIDI The Scene MIDI Block transmits MIDI when a scene is selected.

MIX Mixer Allows you to mix up to four stereo signals.

MTD Multi-Delay A variety of special delays including diffuser, quad-tap, and more.
MBC Multiband Comp. Three-band compressor that is great for mastering or dynamic EQ.
MUX Multiplexer This input selector routes one of many inputs to an output.

OUT Output Transmits signal to the corresponding physical output jacks.

PEQ Parametric EQ The 5-band parametric equalizer allows precise control of tone.

PHA Phaser A variety of vintage and cutting edge phaser effects, including ‘vibe.
PIT  Pitch Shift Includes detune, harmonizer (intelligent/custom), whammy, and more.
PLX Plex Delay Up to eight delay lines interacting in a matrix. Gorgeous!

RES Resonator Resonant comb filters in parallel can create cool resonant sounds or chords.
RTN Return Receives signal from the Feedback Send block.

REV Reverb World-class recreations of vintage springs, rooms, halls, and more.
RNG Ring Mod The extremely flexible ring modulator provides for a range of cool effects.
ROT Rotary Simulates a classic rotary speaker with multiple microphones.

SND Send Transmits signal to the Feedback Return block.

SYN Synth A 3-voice monophonic synth that tracks what you play.

TTD Ten-Tap Delay Set the time, pan, and spacing of one to ten separate echoes.

TRM Tremolo Creates classic trem, plus auto-pan or extreme psycho acoustic effects.
VOL Volume/Pan Simple volume block also offers channel input/output tools.

WAH Wah The classic wah, with multiple types based on classic originals.

Each preset also includes a Controllers block that is not placed on the grid.
Certain blocks found on the Axe-Fx lll do not appear on the FM9.
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EXAMPLE PRESET GRIDS

These FM9-Edit screen captures show how blocks are combined to form presets.

Ex 1: Bare bones! Amp and Cab. No effects.

Ex 2: Here some effects are added before the amp and after the cab.
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EDITING EFFECT BLOCKS

Blocks are fully programmable, allowing you to dial in every setting as desired. The Edit menu for every block
contains one or more pages, each with multiple parameters which control various functions. The functions

of push-knobs are indicated via on-screen labels. Here's a quick overview of how to access and work with the
different types of block Edit menus.

OPENING AN EDIT MENU

» On the Layout grid, select the desired block and press EDIT.

» OR... from anywhere on the FM9, just press EDIT to jump right to the Edit menu for the selected block.
CHANGING PAGES

»

Most Edit menus have multiple pages, shown as “tabs”
at the top of the menu (red arrows, right).The color of
the tabs matches the color of the block on the grid.

Tap the <<PAGE>> buttons to page left or right.

EDITING "KNOB"” PAGES

»

4
»

Most Edit menu pages show rows of five knobs,
switches or selectors. To make changes, use the
five physical knobs below the display (green arrows,
right) or the NAV buttons and VALUE knob.

You will hear all changes in real time.

If a menu page has two rows of knobs, use
NAV UP/DOWN to switch between them.

EDITING "“MENU" PAGES

»
»

Some pages have vertical lists of parameters.

Use the NAV UP/DOWN buttons to step through
the list or NAV LEFT/RIGHT buttons to jump.

The A knob and the VALUE knob operate
the selected parameter.

B, C, D, and E knobs control other parameters in
the list, as shown by blue labels on the list.

OTHER PAGE TYPES

»

Some blocks have special Edit menus, with parameters
arranged in rows and columns. Some of these include
interactive meters or graphs. Use NAV and VALUE or
AB,C,D,E knobs to move around and make changes.

For TYPE pages, such as Amp Type, just NAV through
the list to make a selection and turn the page or press
EXIT when finished. Selections take effect instantly.
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Chorus 1 Type [ Basic) Expert  Mix
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9 P 9%

Chorus 1 Type Basic fExpert} Mix

Analog Stereo Scene:1 Channel: A =
B High Cut 8000 Hz
C LFO Phase 90.0 deg
D LFO Type TRIANGLE
E Auto Depth Low
Phase Reverse NONE
Drive 3.33
Width 50.0 %
LFO2 Rate 0.050 Hz
LFO2 Depth 0.0%

Stereo Spread © 100.0 %

(CCHANNEL - ) ( CHANNEL + ) (__BYPASS ) (_ RESET ) (_ MODIFIER )

Multiband Compressor 1 f[)onﬁg} Mix
Scene:1 Channel: A [
Low Mid High
Crossover Freq  500.0 Hz 10000 Hz
Threshold -80 db -20db -10db
Ratio 1.000 20.00 2.000
Attack 10.00 ms 10.00 ms 10.00 ms
Release 10.00 ms 1000 ms 500 ms
Level 6.0 dB -20.0dB -6.00dB
Detector Fast RMS Peak RMS+Peak
Mute OFF o LOW MID  HI
& Nav Value Value Value

(CCHANNEL - ) ( CHANNEL + ) (__BYPASS ) (_ RESET ) (_ MODIFIER )
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SAVING CHANGES

After editing a preset, you may want to save the results.

Every preset in the FM9 can be modified. There are no permanent presets.

When you change a preset in any way, the front panel "EDITED" LED lights until you STORE or load a new preset.

TO STORE A PRESET...

»
»
»
»
»

Press STORE to show the STORE page.

Turn the VALUE wheel or B knob if you wish to save to a different location.
Press ENTER to display “Do you want to overwrite the Preset?”

Press ENTER again to confirm, or EXIT to cancel.

The message “SAVED!" is shown when saving is complete.

TO CHANGE PRESET OR SCENE NAMES...

The FM9 has 512 preset memory locations. You can edit the name of any preset while storing.

»

»

Press STORE to show the STORE page.
NAV down once to the PRESET line.

= Turn the B knob to move the cursor.

The C knob selects UPPER CASE letters.

The D knob selects lower case letters.

The E knob selects numbers.

The VALUE knob selects ALL characters, including symbols.
= You can use up to 31 characters in a preset name.

You can also NAV to any Scene name to edit it in the same way.

Press ENTER to Store, then press ENTER again to confirm.
The message “SAVED!" is displayed and the new location (if any) is loaded.

Scene naming is a powerful capability. Aside from stating what a specific scene is
intended for, the names of unused scenes can be used for short notes or reminders.
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PRESET CPU LIMITS

The CPU of the FM9 is used mainly for sound processing. A preset with nothing but an Amp and Cab is less
demanding than a preset with a Wah, Drive, Amp, Cab, Delay and Reverb.

You can check the current CPU level at any time by viewing the mini CPU meter at the top of the layout grid.

The maximum recommended load is approximately 80%. There are safeguards to prevent you from pushing the
FM9 too far. Should CPU levels rise above the allowable limit, the FM9 will disable sound processing and flash the
warning, “CPU LIMIT - Muted". This allows you to remove blocks or change settings to solve the problem.

The FM9 will also prevent you from inserting a block that would push the CPU over the limit. If this happens,
you can make changes to reduce the current CPU load and try again. You might remove an effect that is less
important. Adjusting certain parameters can also help.

Different blocks have a different impact on the CPU. Some blocks such as Amp, Delay, and Reverb have hardly any
effect on the meter at all because they run on dedicated CPU cores.

Blocks basically use the same amount of CPU whether they are engaged or bypassed, but remember that the
meter shows the CPU level for the current scene. Switching to a scene that uses a more CPU-intensive channel
can increase the CPU load. Check various combinations of channels and scenes to avoid unwanted CPU
overloads.

Aside from adding/removing blocks, here are a few common settings that have a pronounced effect on CPU:
= Cab: Mute: Using two IRs demands more CPU than using one.
Set the mic Preamp Type to NONE and set Room Level to 0%.
= Compressor: Set Type to one of the "PEDAL' options to use less CPU.
= Phaser: Stages. Lower = less CPU.
= Filter: Order and Q. Lower = less CPU.
» Multitap Delay: Type. Different types have different CPU requirements.
= Plex Delay: Number of Delays affects CPU usage.
= Synth: Turn extra voice type parameters OFF to conserve CPU
= Modifiers also affect CPU usage.

TIP: The Fractal Audio Wiki keeps a list of CPU saving ideas.

AMP, REVERB, DELAY BLOCKS

On the FM9, Amp, Reverb and Delay blocks run in dedicated areas of CPU, so there is little change in the CPU
meter when adding, removing, or editing these blocks. Rarely, with certain extreme settings, the dedictated CPU
cores for the above blocks can also become strained, although this is not shown on the main CPU meter.

CPU & USB

On the FM9, CPU usage does not increase when USB is connected/disconnected.
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6 SCENES & CHANNELS

Before reading this section, please review “Intro to Scenes and Channels” on p. 15.

A Scene is a bit like a preset within a preset. Scenes can turn blocks on/off, change block Channels, and more.
Scenes don't need to be created—they're already there, ready to be set as desired. To save any changes to a scene,
you must save the entire preset. There are many benefits to using scenes. By switching multiple blocks, they
eliminate the need to “tap dance” on switches. They also offer the easiest way to ensure perfect “spillover” of
effects like delay and reverb. Scenes can also change overall volume levels, send MIDI messages, and more.
Each Scene also has a name.

WHAT SCENES DO...

Each Scene stores ALL of the following:

1. The current Bypass state of every block in the current preset: on or off.
2. The current Channel of every block in the current preset.

P E R Note that by changing the channel of the “Controllers” block, scenes can change the Tempo!
SCENE 3. The current “Scene Level” of the Output blocks.
4. The settings of four Scene Controllers used as Modifier sources (see Section 9.)
5. Each scene also has its own Name.
6. Scenes can cause the Scene MIDI block to send up to 8 MIDI PC or CC messages.
See the Blocks Guide for more information on this block.
CHANNELS

Most blocks have some number of channels (typically four). This feature will be instantly familiar if you've ever
used an amp or effect with channels. Each channel of a block allows you to set every parameter of that block to
any setting. It's like having multiple blocks in one. For example, Channel A of a Drive block might be dialed in as a
“clean boost” while Channel B is dialed in as a heavy overdrive.

Remember, Scenes can't change individual parameter values, but they CAN change the channel of any block, and
every channel has its own fully independent parameter values.

DON"T: Don't imagine that every parameter in every scene is fully independent. Changing one might affect all!

DO: Do change scenes, change the channel of a block, and then dial in the new channel as desired. Just
remember that any changes you make will also apply to any other scenes that use the same channel.
(This concept is illustrated on p. 15.)

F AQ. WHY NOT JUST CHANGE PRESETS? Preset changes give you total

® flexibility. You can change anything and everything in every preset, but there are also
drawbacks. Synchronizing multiple presets can be tedious, it takes care to get levels and spillover just right,
and while preset changes are fast, Scene and channel changes are even faster and can be seamless.
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HOW TO CHANGE A BLOCK'S CHANNEL

Different areas of the FM9 provide different ways to change block channels:
= On the GRID - Select the desired block and turn the Channel knob (B).
The current Channel is shown above the knob.

» While EDITING a BLOCK - Use the CHANNEL-/+ buttons (Push-knobs A & B) to select a channel.
The current channel is shown near the top center of every page in the Edit menu.

= Foot Control - The onboard switches of the FM9, or those on a connected
FC Controller offer a range of dedicated “Channel” options.

= MIDI - MIDI and other controllers such as a connected external footswitch can be used to
change the Channel. See “Selecting Scenes & Channels While Playing” on p. 52

= FMO-Edit provides an easy one-click way to change the channel.
A
SETTING UP CHANNELS

Whenever you edit a block, you are already programming at least one Channel (usually Channel A). Programming
additional channels is easy: simply select the desired channel as described above, set the various parameters to
their new values, and then save the preset.

TO COPY ONE CHANNEL TO ANOTHER...

The Tools page of the Layout menu (“grid”) provides a utility to copy one Channel to another. This works within a
single block only; you can’t copy a Channel from one block to another, or from one preset to another.

Navigate to the Tools page of the Layout menu.

Turn the VALUE wheel until “COPY CHANNEL" is shown on the display.

Use the D knob to select the channel you want to copy from. Channel letters are shown above the knobs.
Use the E knob to select the location you want to copy to.

Press ENTER or the on-screen EXECUTE button (Push-knob C) to complete the copy.

Test your preset and remember to STORE to make the changes permanent.

SaRkwbd=

While you can’t copy channels across blocks or presets on the FM9 itself, you can do this using
FM9-Edit, the free companion software editor for the FM9.
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SELECTING SCENES

Different areas of the FM9 provide different ways to select a Scene.

= On the Home page - Use the NAV UP/DOWN buttons or turn Push-knob A. The current scene is highlighted.
= On the GRID - Turn the Scene knob (Push-knob A). The current scene is shown above the knob.
= Foot Control - The onboard switches of the FM9, or those on a connected
FC Controller offer a range of dedicated “Scene” options.
= MIDI - MIDI can be used to change the scene. See “Selecting Scenes & Channels While Playing” on p. 52
= FMO-Edit provides an easy, one-click way to change the Scene.

SETTING UP SCENES

Whenever you create a preset, you are already using at least one Scene. Programming additional scenes is easy.
Here are step-by-step instructions for setting up scenes:

TO SET UP A NEW SCENE OR EDIT AN EXISTING ONE...

1. Load the desired preset and select the desired Scene.
2. Bypass or engage each block as desired.
= On the Layout (grid) or while editing any block, use the BYPASS button (Push-knob B).
= Oruse any assigned footswitch or remote controller to bypass/engage the block.
3. Set the Channel for each block as described on the previous page.
4. Test and save your preset. On the STORE page, NAV to any new scenes and name them (see p. 47).

Always test ALL scenes in your preset—even those you think you might not use.
Ensure that there are no unpleasant volume jumps or other surprises in case of accidental missteps later.
A good rule of thumb is to copy a good scene into any unused locations.

TO COPY ONE SCENE TO ANOTHER...

The Tools page of the Layout menu contains a way to copy scenes within a single preset.

Navigate to the Tools page of the Layout menu (grid).

Turn the VALUE wheel until “COPY SCENE" is shown on the display.

Use the D knob to select the scene you want to copy from. Scene numbers are shown above the knob.

Use the E knob to select the location you want to copy to. You can also choose to copy one scene to “ALL".
Press ENTER or the on-screen EXECUTE button (Push-knob C) and the copy operation is completed.

Test your preset and remember to STORE to make the changes permanent.

Skl wbd=

See the FAQ on the previous page if you're wondering about copying scenes between presets.
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SELECTING SCENES & CHANNELS WHILE PLAYING

Scenes and Channels can be selected via Footswitches, Global Controllers, or MIDI. Several options are provided.

FOOTSWITCHES

Scenes and Channels can be selected using the onboard footswitches. See Section 10: Layouts & Switches

SCENE INCREMENT AND DECREMENT

The Scene Increment and Decrement functions allow you to step up or down through scenes one at a time. You
must first assign each of these function its own CC# or pedal/switch option in the MIDI/Remote menu under

SETUP. The function is triggered by any value of the controller.

SCENE SELECT

Scene Select (found under SETUP: MIDI/Remote: Other) allows you to designate a MIDI CC
message for selecting specific Scenes.

The scene is set by the value of the controller (not the controller number itself... see FAQ below).
Values begin at 0, while Scenes are numbered from 1, so “Value + 1 = Scene number”

(see table 1, right). The series continues, repeating scenes 1-8 across CC values up to 127"
EXAMPLE: Imagine you want MIDI to select scene 3. Open the MIDI/Remote menu and assign
your desired CC# to “Scene Select”. Let's use CC#34 in this example. To load Scene 3, send
CC#34 with a value of “2” to the FM9 (Scene 3: 3-1=2)

CHANNEL SELECT

This uses the value of a controller to select a specific Channel. Each block has its own dedicated
setting for channel select, found across the listings on the Channel page of the MIDI/Remote
menu under SETUP.

The Channel is set by the value of the controller (not the controller number itself... see FAQ
below). Values begin at 0, which is Channel A, and it continues from there. (See table 2, right).

As with Scene Select (above) the series continues, repeating Channels A-D across values to 127.

1 In mathematical terms, that's Scene# = [(CC Value mod 8) +1]

TABLE 1

CC Values & Scenes
0 =Scene 1
1= Scene 2
2 = Scene 3
3 =Scene 4
4 =Scene 5
5=Scene 6
6 = Scene 7
7 =Scene 8

TABLE 2

CC Values & Channels
0 = Channel A
1 =Channel B
2 = Channel C
3 = Channel D

~ MIDI CC Number and CC Value... What's the difference?
FAQ. MIDI Control Change messages —aka “CCs"— have a number (0-127) and a value (0-127).
The number is like an “ID” which is used to distinguish one CC from another and set its
function in a receiving device. A simple example might be a MIDI expression pedal that sends CC#7 which is
interpreted as “Volume” on the receiving end. The FM9 lets you designate CCs for various controllable items in

several lists found in the MIDI/Remote menu under SETUP.

Once a CC# is set to control a function, the value of that CC tells the function what to do. Some functions—like
Volume— interpret data across a continuous range from 0-127. Other functions—like Bypass—simply toggle

OFF for a low value and toggle ON for a high one. Other functions might be triggered by any value.

Different types of physical controllers transmit values in different ways. A pedal that rocks continuously from
heel-to-toe sends a stream of continuous values from 0-127. A switch sends a single value for OFF (typically

0) and another for ON (typically 127). Other MIDI controllers offer other options.

As described above, both the CC number and its value are the key to selecting Scenes and Channels via MIDI.
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PROGRAM CHANGE MAPPING

Another way to select Scenes via MIDI is using PC Mapping, which allows a single incoming MIDI Program
Change (PC) message to select your choice of both Preset and Scene. This is a popular option in cases where
a connected MIDI foot controller lacks the sophistication to transmit the MIDI messages required for scene
selection.

The PC Mapping parameter on the General page of the MIDI/Remote menu under SETUP must be enabled for
custom mapping to be in effect. With this option set to “ON”, an internal table remaps each incoming MIDI
Program Change message so it can load your choice of preset and scene. The map is limited to 128 entries so
MIDI BANK SELECT messages are d while PC Mapping is enabled.

With PC Mapping option set to “OFF”, MIDI Program Changes load presets on a 1:1 basis and Bank Select
commands are processed as usual as per “MIDI Reference Tables” on p. 124.

BUILDING THE MAP
The mapping table is on the Mapping page of the MIDI/Remote menu under SETUP.

To use it, follow this simple process:
1. NAV to the row for whichever Program Change message you want to remap.

2. Use the B knob to set the desired value for Map to Preset.
This is the preset that will load when the selected Program Change message is received.

3. Use the C knob to set the desired value for Map to Scene. You can choose a scene by its number, or select
“AS SAVED" to load the default scene saved in your preset. (see p. 54 for more on Default Scene).

4. Repeat steps 2 through 4 for any remaining Program Change messages you wish to remap.
5. EXIT when finished. You do not need to store settings in the SETUP menu.

The custom map parameters remain intact but not active when if you switch PC Mapping Off.

TRANSMITTING MIDI WITH SCENES

The Scene MIDI Block allows each scene to transmit up to eight MIDI messages.
See “The Fractal Audio Blocks Guide” on p. 17 for more on this block.
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SCENE LEVELS

Each of the Output blocks includes eight parameters that allow you to cut or boost the level for any scene. Using
these adjustments is a quick way to balance or boost scene levels when other level options are not available.

THE DEFAULT SCENE

When a new preset is loaded, it automatically starts on whichever Scene was selected when the preset was last
saved. So, to set the default scene for any preset, simply select the desired Scene and then save the preset.
If you'd rather override this behavior, you can change the Default Scene in SETUP: Global Settings: Config.

SCENES, CHANNELS & MODIFIERS

The Modifier system of the FM9, detailed in Section 9, provides remote control and automation options.

Here is a summary of the ways that Modifiers relate to Scenes and Channels.

SCENE CONTROLLERS

Remember that parameter settings cannot be changed by a scene. A Scene can change the Channel, but this
isn't quite the same thing, and it's also possible that all of your channels are already in use. The Scene Controller
system bridges the gap between these worlds, providing a way for individual parameters or groups of parameters
to have different values in different scenes.

To learn more, see “Tutorial: Scene Controllers” on p. 70.

CHANNELS & MODIFIERS

By default, any modifiers are shared across all Channels of a block'. This is a great convenience in most cases, as
it avoids the need to apply the same modifier multiple times as you change channels.

The option is also provided to limit a modifier to only ONE channel ("A” vs. “All”, for example).

1 In some cases, you may notice that if you change an effect Type from one channel to the next, certain parameters are either not
present at all, or appear with different names. For example, in the Delay block, the Mono Tape type has a parameter called “Head 2 Ratio”.
This same parameter is called “L/R Time Ratio” in the Dual Delay. A modifier on one will affect the other.
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SCENE REVERT

Changes to a scene on the FM9 remain in effect until you save them or discard them by loading a different
preset—or reloading the current preset. This last option can work differently, depending on a Global setting called
Scene Revert. With Scene Revert turned on, changes are discarded as soon as you load any new Scene.

Here are two examples so you can compare how Scene changes work with Scene Revert OFF vs. ON:

Ex 1: SCENE REVERT OFF (default) Ex 2: SCENE REVERT ON

1. You load SCENE 1. DRIVE 1 is OFF. 1. You load SCENE 1. DRIVE 1 is OFF.

2. You turn DRIVE 1 ON with a Footswitch. 2. Youturn DRIVE 1 ON with a Footswitch.
3. You change to SCENE 2. 3. You change to SCENE 2.

4. You change BACK to SCENE 1. 4. You change BACK to SCENE 1.

5. Drive will still be ON, as you last left it. 5. Drive will be OFF as you last saved it.

TO ENABLE/DISABLE SCENE REVERT...

1. Page to the General page of the MIDI/Remote menu under SETUP.
2. NAV to SCENE REVERT and set it “ON" or “OFF" as desired.

3. EXIT to finish. (You do not need to STORE changes in SETUP.)
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SCENE IGNORE

FM9 Firmware 3.0 introduced Scene Ignore. You can find this option in the Edit menu of most blocks. Scene
Ignore allows a new type of switching flexibility. It is based on the way some analog rigs work, where some pedals
may be controlled by a programmed switcher, but others are not. With Scene Ignore ENABLED, a block is totally
outside of the Scene system. If you want to change its channel or bypass state, you need to do this manually.

Here's an example. Imagine a tube amp used with a drive pedal, plus a separate “switching system” for wet
effects. The amp will have its own set of footswitches for channels — maybe Clean, Crunch, and Lead. The drive
pedal can be stomped on or off. The Wet effects system has its own “presets” —let’s say Dry, Light FX (chorus and
a little reverb), and Full FX (Chorus, Delay, and a lot of Reverb). It would be easy to replicate all of this in the FM9,
but without Scene Ignore, the amp, drive, and effects would all ALWAYS switch when you load a new Scene. By
setting the Amp and the Drive to Scene Ignore and using scenes to control the effects, you get indepenedent “mix
and match” switching with a total of eighteen different combinations, all from just seven footswitches. Here's how
it might look on an FM9. The three different colored zones are independently switchable. Only the blue “Effect
Scenes” zone uses traditional scenes.
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PER-CHANNEL

It is important to understand that Scene Ignore is in fact a per-channel setting. This allows a “hybrid” approach;
some channels can be set to respond to scene changes while others ignore them. If this idea seems tricky, think
of it as a radio control receiver. Enabling Scene Ignore switches the radio off and the block is no longer “listening”
to scenes. No scene can then take control of the block, regardless of other settings. Only YOU can, using a
footswitch, etc.

Example: Channels A, B, and C of a drive block have Scene Ignore turned OFF. They work in the usual way, with
Scenes to bypass/engage and change the channel. Meanwhile, channel D has Scene Ignore turned ON. If any
scene switches the block to Channel D—or if you switch to D manually—the block will stop responding to further
scene commands. The “radio” is off. In this state, the block can still be switched manually using FC footswitches,
MIDI, etc.—just like a fully independent pedal or amp could be. If you manually switch the block back to A,B, or C
where Scenes are no longer being ignored, it will again begin to “listen” to scene instructions.

If you want a mixed scenario with Scene Ignore sometimes ON and sometimes OFF, you'll need a footswitch or
some other way to change the channel of your block back to a channel that does not ignore scenes. Extending
the example above, this might be an FC footswitch. TAP is set to Bypass the Drive, and HOLD is set to Toggle
Channels A and D. Toggle to A for scene control. Toggle to D for manual control. Tap on or off at will.

TIP: If you always want full scene independence, a good safeguard is to turn Scene Ignore to ON in every channel.
Similarly, if you want a block to be controlled only by scenes, make sure that Scene Ignore is OFF for all channels.
If not, one of them may cause that block to stop responding to scene changes!
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7 LEVELING PRESETS

This section is about balancing levels across Presets, Scenes and Channels. It is NOT about how to correctly set
FM9 input or output levels to prevent clipping (compare “Setting Levels” on p. 5).

Musicians and audio technicians face an almost universal challenge of getting levels “right.” Legions of techs
and engineers mix bands in real time from the smallest basement jams to the biggest festival stages. The world
has quickly realized that the advanced modeling technology created by Fractal Audio actually makes this job
easier. (Front-of-house engineers are some of our biggest fans!) A tube amp often needs to be too loud to be
controllable, and its tone can vary considerably from day to day. Speakers, mics and pedals are quirky and require
constant control. In comparison, Amp modeling, speaker cab simulation, and virtual effects, give us cranked
sound at low volume, precision control, accurate metering, and fewer overall compromises. A few simple rules of
thumb will put you in total control over levels in the modeling world.

Control is not everything though: a second challenge remains. Levels must be understood in context. Our hearing,
speakers, and surroundings are all variable. You can learn the basics in this overview, but consider exploring this
subject further to delve deeper into the world of acoustics and audio engineering.

LEVELS IN CONTEXT

» Our ears deceive us. A phenomenon known as the “equal-loudness contour” effect (aka
“Fletcher Munsen” effect) makes the same tones sound different when they are heard at
different volume levels. At lower volumes, low and high frequencies seem to be relatively
quieter. Learn more about this effect and compare your sound levels at “gig” volumes!

» Different speaker systems and performance spaces (including whether or not the venue is packed
or empty!) can emphasize and deemphasize different frequencies. This changes our perceptions of
tone and level. Set final levels on the system you will perform through, or ideally, use the best and
most accurate speakers you can find—and then be prepared to make adjustments on other systems.
This goes for your tone as well as your level. The global equalizers can be useful for this.

» Mix or context also changes our perceptions of loudness. Two guitar sounds may appear to
be relatively equal in level when you audition them alone, but may sound totally different when
“competing” in a mix against other instruments such as bass and drums. Adjust in context.

THE RULE OF THUMB

» There are a lot of different ways to adjust levels on the FM9. A good rule of thumb is to use
the Level parameter of the Amp block. See “A Method for Leveling” on the next page for how
to use this in a process for adjusting levels across Presets, Scenes and Channels.

» Above all, use common sense. Rely on meters, but don’t set levels solely on how they look. Use your ears too!

EXCEPTIONS TO THE RULE

If level-dependent blocks follow the amp, be sure to readjust them after changing Amp levels. Alternately, move
level adjustments farther downstream. Here are some common cases to consider:

» If you use Drive/Saturation in the Preamp section of the Cab block, adjust the Level of the Cab block instead.

» If level-dependent effects such as drive (or other effects containing drive), or dynamics (compressor, gate,
or ducking effects) are used after the amp, make adjustments farther downstream instead of at the amp.
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A METHOD FOR LEVELING

The Layout Grid grid provides an excellent environment for leveling presets, scenes, and channels. From the Home
page, press ENTER to open the layout menu. The page buttons change between Edit and Meters pages, allowing
you to see block names as well as block meters for input (blue) and output (green). when you press ZOOM (Push-
knob A) , you will see two VU meters for Outputs 1 and 2 at the top of the display. These meters are great for
setting levels with a scale from -20 to +10 dB and a red line at 0. (This is the internal level, NOT a dBu reading.)

NOTE: Each of the latest Fractal-Audio editors also includes a utility called “Preset Leveling” in the “Tools” menu.
Use it to display large VU meters plus useful controls while using this method.

Edit Meters  Tools cpu Edit Meters  Tools

(> Scene: 1 Channel Block Level Row Column (> Scene: 1 Channel Block Level Row Column
| Z00M J BYPASS DELETE CABLE CONTROLLERS | Z00M J BYPASS DELETE CABLE CONTROLLERS

The zoomed out grid shows VU meters atop the screen. Page right to the Meters page for block meters.

To set levels, play your guitar and watch the VU meters. Adjust the output level of the Amp block by selecting it
on the mini grid and turning the Block Level knob (C) until the level hovers near the red line. Different types of
playing and different amp models and settings will excite the meter in different ways. Play chords and “chugs” as
their bassy content may push the meters harder, and it is potentially OK to see some red when you do this. If you
want to compare the levels of two presets/scenes/channels, play the same type of material while watching the
meters. Remember that whenever you various amp, cab, or effect settings, you will need to revisit this process.

The Layout view allows you to change Scenes (knob A) and Channels (knob B), so you can compare and adjust
everything all within a single page.

Remember this common sense principle: trust the meters, but rely on your ears!

LEAD/LOUD SOUNDS

You now know how to normalize levels across Presets, Scenes, and Channels, but what if you specifically want
some sounds to be louder or quieter than others? A good approach is to begin with the loudest sound and then
make the other sounds quieter. This helps ensure that you will have plenty of headroom to avoid clipping. It's fine
for certain tones to be very quiet: all Fractal Audio products have an extremely low noise floor and do not easily
suffer internally from the kinds of problems which plague analog gear at lower levels.

Make it easier to adjust levels by using the Looper block to “play” while you operate the level controls.
Place the looper between the input and your first block.
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BYPASS AND LEVEL

Block bypass settings also contribute to preset levels. Here are some tips to help you dial in effects so that levels
can remain under control as you bypass or engage blocks.

»

Sometimes, you WANT an effect to boost or cut levels. Other times, you want the volume to stay very
much the same as an effect is switched in or out. In either case, there's an easy method you can use

to make correct settings. First, with an effect engaged, set its Mix so the blend of wet and dry sounds
just right to you. Then, with one hand on the block’s Level parameter and the other on its Bypass button
(Push-knob B), switch the effect on and off, making level adjustments until the desired volume is achieved
when the effect is on or off. You can also use a footswitch if one is configured to control the effect.

Time-based effects like delay and reverb are usually best in series with their Bypass Mode set to “MUTE

FX IN”. This ensures that the dry level remains constant (“unity”) when you engage or bypass the block.
Because this setting masks possible changes to your dry level, you should use the Meters page of the Layout
menu to ensure that the level is roughly the same before and after these effects when they are bypassed.

Parallel effects should have Bypass Mode set to “MUTE", “MUTE IN”, or “MUTE
OUT” to avoid increasing the dry signal level when the effect is bypassed.

Pitch and certain other effects require special consideration. Depending on the particular type and settings,
you may wish to treat them like a time-based effect with Bypass Mode set to “MUTE FX IN", or you try a totally
different approach with one of the other settings such as “THRU". Try it and see what works best for you.

The various Bypass Modes are detailed in “The Fractal Audio Blocks Guide”.

PRO TIP: Unless you use multiple parallel paths to prevent effects from feeding into one another,
time-based effects sound exactly the same in series or parallel. Using parallel effects, however, can
make it easier to keep dry levels the same as you switch effects in or out, or adjust their settings.
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The “The Fractal Audio Blocks Guide” covers effect blocks and parameters for all current Fractal Audio products.
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Modifiers are one of the most exciting features on the FM9. They allow sound parameters to be remote controlled or
automated in real time. With modifiers, anything goes: an expression pedal might operate a wah or whammy. A step
sequencer or LFO might sweep a filter. A footswitch or MIDI message might adjust effects, volume, and much, much
more. Modifiers are easy to use, but have fantastic potential for those who want extreme creativity or control.

CREATING A MODIFIER

The process of creating a modifier begins right at the parameter you want to control. Parameters that can be
controlled are marked with a yellow circular symbol (shown below on a knob and a switch). When a modifier is
already present, the circle will be solid yellow, like an LED that has been turned ON. You will see the same symbol
whether the target parameter is on a knob page, a text page, or any other type of menu.

() ()

Balance
The open circle The filled circle  Here, a switch This parameter
meansyoucanadda  means amodifieris  instead of aknob  has no option for a
modifier here. already present. allows a modifier. modifier.
TO CREATE A MODIFIER...

»
»

Select any parameter that supports a modifier. E
Press the ENTER button or the MODIFIER Push-knob to show the Modifier menu.

The Modifier Source page will appear. Select a SOURCE to control the
parameter. Learn more about Sources on p. 63.

Press PAGE RIGHT to switch to the Modify page (you must select a source first!)

This page contains all of the parameters related to the interaction between the source
and the parameter. (Learn more on p. 64.) If nothing else, check that MIN and MAX are
set to the lowest and highest values you want to hear as the source changes.

Press EXIT to leave the modifier menu. You will notice that the dot is now solid. l!]

Modifiers will animate on-screen knobs, faders switches and graphs.
For text menu parameters, a bar graph shows the value of the source.

You must STORE the preset to save any modifier changes.
In FM9-Edit, RIGHT-CLICK or Control Click a modifiable parameter to show the modifier screen.

TO EDIT OR REMOVE A MODIFIER...

»
4

To edit an existing modifier, use the same process as creating a modifier.
To remove a modifier, change its SOURCE to “NONE".
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MODIFIER TUTORIAL: WAH PEDAL

Below you will find a basic step-by-step tutorial on setting up a modifier for a Wah pedal.
For this example, to work correctly, the following must be true:

= A Wah block must be in your preset (see Section 5: Presets).
= You have an Expression pedal set up (see “Expression Pedals” on p. 10).

Here are the steps:

On the Layout Grid, NAV to your Wah block and press EDIT to show its menu. @
Page to the Config page of the Wah block’s Edit menu. Wah
Find the on-screen Wah Control parameter and notice the yellow Modifier dot symbol. |#s]sligs]!

NAV to select that parameter, or just give its knob a twiddle. It will be highlighted (blue) when selected.
Press ENTER or the MODIFIER Push-knob to show the Modifier menu.

On the Source page, change the SOURCE to your pedal. Depending on how your pedal is connected this
might be “Pedal 1 (Exp/Sw Tip)" (the on-board expression jack of the FM9), or it might be one of the
“External Controllers” (p._69), or it might be one of the “FC” pedal options.

ook wd -

7. Test! The Wah should work when you move the pedal. You'll also see the dot move on the graph. If it
doesn’t work, check your source or make sure the pedal is properly connected and calibrated.

8. Save the preset by pressing STORE, ENTER, ENTER.
The Wah in this example is controlled by an expression pedal. An expression pedal can be used to control other
parameters like whammy control, rotary rate, delay feedback, and many more.

There are also many different sources we could use instead of a pedal. Try an LFO for a modulating auto-wah, or
an Envelope Follower for some funky Mu-Tron action. MIDI opens up another world of controller options.

MODIFIER TIPS AND TRICKS

= The same source can be assigned to multiple modifiers at the same time. For example, one pedal
might adjust Chorus Rate and Chorus Depth at the same time — even in different ways.

= The modifiers for a given block will normally be shared across all of the channels of that
block, but you can also limit a modifier so it applies only to any one channel—your choice.
Change the “Channel” setting inside the Modifier menu from “ALL" to just A, B, C, D.

= Modifiers use a very small amount of CPU power while you use them.
Test any presets which seem close to the edge.

= Any block that can be bypassed also has a Bypass parameter that allows you to assign a modifier.
(The modifier is placed on Bypass and not Bypass Mode as it was on some previous Fractal Audio products.)
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MODIFIER SOURCES OVERVIEW

There are over 70 different choices to use for modifier sources. Learn about them in this overview.

INTERNAL CONTROLLERS LFO 1 LFO 2 ADSR1 | [ADSR2
Internal controllers are part of every preset. Toshowthe [N\ /N\/\| A/ NN\ /\ . /\ q

Controllers menu, press the CONTROLLERS button on the N
Home page (push knob C) or on the grid Grid (push knob

E) or press the TEMPO button once Sequencer Pitch Envelope Scene Ctrl
Internal controllers have settings of their own which can 860000| |TTTTTT = |I 8888
be saved with every preset. All of the Internal Controllers =

(Tempo, LFOs, ADSRs, etc.) are part of a Controllers block. This block has four channels, so you can have up to
four different sets of Controller values in one preset!

The Internal Controllers include one Tempo, two LFOs (Low Frequency Oscillators), two ADSRs (envelope
generators), a Sequencer, an Envelope Follower, a Pitch Follower, five Manual Controllers, four Scene
Controllers, and six Control Switches. See p. 67 for more on internal controllers.

ONBOARD & FC PEDALS & SWITCHES POL2

The onboard Pedal jacks of the FM9 and the Pedal or Switch

jacks of a connected FC series controller can be assigned 1 e 3 4
directly as modifier sources. In comparison to previous

products, it is no longer necessary to assign these to an @ @ @ @ @ @
External Controller first (though this is still possible, and POL1  POL3

even recommended).

PEDALS

FM9 FC

EXTERNAL CONTROLLERS (s e (] [e] e (] ) (] () o) o)) (] o] (o] ]

External Controllers are proxy or “go-between” sources. They each have their own global setting to determine
what controls them. You can set them up to be controlled by your choice of:

= Any MIDI Control Change (CC#) message.
= One of the onboard Expression (Pedal) jacks.
= One of the Pedal or Switch jacks of a connected FC series controller.

In comparison to Internal Controllers or Onboard & FC Pedals and Switches, external controllers act like a “go-
between” as illustrated below.

Internal Controller or Onboard Exp Jack External Controller
Source Parameter “Source” External Controller Parameter
(e.g. PEDAL 1) (e.g. PEDAL 1) (e.g. External 1)

External Controllers are a great choice for presets you might share, because different people will use different
controllers in different setups.

Example: you send your friend a preset containing a Wah operated by External 1. On your system, External 1 is
globally assigned to “PEDAL 1"— one of the onboard expression jacks. On your friend’s system, External 1 is
assigned to “CC#16" because an older MIDI controller is being used. The Wah works perfectly on both rigs with
no changes required! Learn more about External controllers on p. 63.

63
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MODIFIER PARAMETERS

The Modify page of the modifier menu contains parameters to determine the nature of the relationship between
the source(s) and the parameter. By default, a modifier is linear: the parameter value moves in direct proportion
to the source. By changing this relationship, you can create a variety of desirable effects. For example, you might
adjust the “taper” of the change, reverse its effect, or smooth the changes over time. Here is an overview of the
additional parameters you can use to create these effects and many more.

The Channel setting determines whether the modifier will be enabled on ALL channels or just on one channel
(A,B,C or D). There are many creative uses for this, including effects which auto-engage only when set to a
particular channel where their modifier is active.

Min and Max set the range of parameter change. These are extremely important parameters.

EXAMPLE: The modifier for a pedal controlling Delay Feedback has Min at “10%" and Max at “50%". The
feedback sweeps only from 10% to 50 as the pedal is moved, even though this parameter’s range actually
extends from -100% to +100%.

Start, Mid, End, Slope, Scale, and Offset are used to create custom curves which re-map the source to the
target. On the Modify page, a graph shows the relationship between the source (x-axis) and the parameter
(y-axis). A dot on the graph tracks the source. The default settings (first graph below) create a 1:1 linear
relationship (the blue line) between source and parameter. As the source changes, the parameter tracks it directly.
The second two graphs below show just a few examples of the kinds of non-linear curves you can create using
Slope, Scale, and Offset. The pages which follow contain more examples.

Parameter —»

Sourée—»

Damping, Attack and Release: These are used to slow the rate at which the target parameter value “chases” the
source. At low settings, these add just a little smoothing. Try settings of about 5 ms to “relax” a pedal or to ease
a square LFO to eliminate clicks and pops, or use higher settings for slow, lazy changes. Increase Attack to slow
the change as the source is increased. Release controls the rate as the source decreases. The Damping type
parameter determines if damping happens in a linear (constant) or exponential manner (slowing as the source
reaches the extremes.)

Auto-Engage works with Off Value to make the entire block turn ON or OFF automatically whenever the source
controller is moved. This is typically used with a Wah pedal so you don't need a toe switch. (Follow the example
on p. 62 and set AUTO-ENGAGE to “SLOW P0OS" to try it out!) Find more about Auto-Engage on p. 66.

PC Reset sets the value for an external source when a preset first loads. This allows you to override the actual
position of an external controller until it is moved or updated. To set the default value: after applying the modifier,
exit to the Edit page. Notice that the value of that parameter can be edited as usual. If PC Reset is ON, the value
you set and then save will be used from preset load until the source is changed (i.e. the pedal has been moved).

Update Rate controls how often the modifier is refreshed. The setting of slow is actually very fast, and fine

for the majority of applications. The faster settings require additional CPU but provide even smoother sound
performance when ultra fast changes are required (while using a fast LFO for instance). Check this setting if you
think you hear “zipper noise” while a modifier is in use.
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UNDERSTANDING MODIFIER MIN AND MAX

MIN and MAX set a range for the parameter under control. This lets you fine-tune modifiers in very cool ways. In
the example below, imagine a volume pedal with different settings. Using the principles on this page, you should
be able to achieve a wide range of modifier control scenarios.

Mid: 50.0%  End: 100.0%

- x Max: 10.0
: The pedal “start” (heel position) sets the volume to

. Min: 0.00; silent. The pedal “end” (toe down position)

has the volume at Max: 10 or all the way up.

As you rock the pedal forward, the dot follows the line.

It moves up as it goes and the volume does too.

Here is your basic “vanilla” volume pedal.

Start: 0.0%
‘ Min: 0.0

Max: 10.0

Now, something different: a “boost” pedal with Min set
to 8 and Max still at 10. In the heel position, the volume
will go only as low as 8, instead of 0 as in the previous
example.

Here is a different twist: Min is at 10.0 — the loudest
setting, while Max is at 0.0 — silent.

It looks the same, but this is a reverse volume pedal!

Min: 10.0

USING “MID” TO CREATE BASIC CURVES

Let's imagine a modifier on the feedback of a delay to demonstrate changes to response curves. By now you
should be familiar with the default settings, so let’s skip right to the curved version:

Mid: 25.0% End: 100.0%
\ h Max: 100% As we adjust Mid, the graph shows the curve. At 25%,
5 5 x Max: ° the response is “tapered” so that with the pedal half
| way forward, Feedback is only 25% between Min and
Max.

This type of curve provides gradual control of feedback
: across the lower end of the range, and then a more
v Min: 0% rapid change towards the top.

Start: 0.0%
<€
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ADVANCED MODIFIER CURVES AND SHAPES

You can also adjust Start, End, and Slope (which introduces an “S” or “backwards S” shape). The numbers
beneath each example below show the settings for Start, Mid, End and Slope. With a bit of experimentation, you
will learn to achieve desired modifier effects quickly. Try dialing in the shapes below for practice:

0,75100 50 100,50,0 50 0,100,0 50  0,50,100 0 050,100 100 0,25100 10

Scale and Offset also remap modifier response. Scale adds vertical exaggeration or compression, while Offset
moves the entire curve up or down on the Y-axis. Segments outside the graph boundaries will be clipped and
replaced by line segments. The examples below show some interesting possible applications.

: : : : 1
5 5 START:  0.0% START:  0.0% START:  47.2%
cereernsseeifflenssnnnnnnns ............. MID: 50% ............. ............. MID: 50% .............. ........... .| mID: 0%
5 5 END:  100% END:  100% END:  60.6%
........................................ SCALE: 2.0 oo | SCALES 0.0 ) Ef..|| SCALE: 10.0
OFFSET: 100% OFFSET: 0% OFFSET: -100%

AUTO-ENGAGE TURNS EFFECTS ON/OFF AUTOMATICALLY

If you have used a Wah pedal with no “toe switch,” you will instantly understand the principle of “auto engage.”
This type of Wah turns on automatically when you rock it forward it and then bypasses automatically when you
return the pedal to the heel position. That's the idea behind Auto-Engage — and it can even be reversed.

Auto-Engage engages or bypasses a block when the Source of a modifier changes. Once you try it, we believe you
will quickly find that this capability comfortably eliminates the need for expression pedal toe switches.

Set it up using two parameters on the Modify page:

Auto-Engage - Determines whether or not the block will automatically engage or bypass. FAST, MEDIUM and
SLOW settings determine how quickly the effect turns ON/OFF once Auto-Engage is triggered. Use SLOW settings
to delay auto-engage, so your effect doesn’t switch off too suddenly while you're still using it.

= The three POSITION (“POS") options trigger the effect based on OFF VALUE (see below).
= The three SPEED (“SPD") options engage the effect when the controller is moved quickly.
= Setto “OFF” to disable Auto-Engage.

Off Value - Sets the position threshold that the source must cross for auto-engage to occur. When Off Value is
set below 50%, the effect is bypassed when the controller goes below that value. If Off Value is set to 50% or
higher, the effect is bypassed when the controller goes above that value.

For “heel down = bypassed,” set to 5%. For “toe down = bypassed,” try 95%.

MODIFIERS AND CHANNELS

A modifier is normally shared across all of the channels of the block where it exists. However, you can also limit it
to operating on just a single channel—your choice—using the Channel parameter in the modifier menu.

66
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Internal Controllers can be programmed per-preset for use as modifier sources. To access these parameters,
push the CONTROLLERS button on the Home page (D) or press TEMPO. Save the preset to commit changes.

TEMPO Tempo appears in the Controllers menu. For more information, see Section 11: Tempo.

LFO1 + LFO2 LFo

A Low Frequency Oscillator (“LFO”) AN
generates control signals in a variety of

periodic and random wave shapes. Examples of
LFOs in use include the pulse of a tremolo, the back
and forth sweep of a phaser, or the random filter in
Ship Ahoy by Frank Zappa.

Type sets the waveform or shape. You can set the
Rate manually or sync it to the current Tempo. You
can vary the overall Depth and Duty, or symmetry.
LFO WAVEFORMS are illustrated in “The Fractal
Audio Blocks Guide” The Run parameter starts and
stops the LFO. This can be used to keep it from
drifting out of time.

Each LFO outputs “A” and “B” signals, each of which
is an independent modifier source on the list. You
can change the Phase of output B with respect to A.

Quantize changes smooth waveforms into stepped
ones. Try it on the “TRI" waveform for example.

ADSR1 + ADSR2 ADSR

The two ADSR sources are envelope generators &
with Attack, Decay, Sustain and Release
parameters (thus “ADSR”). The ADSR is triggered
whenever the signal level exceeds its Threshold measured
at the selected input (1 or 2). The envelope has three self-
explanatory modes (Once, Loop, and Sustain) and can
optionally be set to Retrigger every time the threshold is
exceeded. A Type parameter selects between Linear and
Exponential curves.

In comparison to the Envelope Follower, the ADSR
envelope generator always creates the same control
signal, but only triggers when you play hard enough.

PITCH FOLLOWER Pitch

Detector

The Pitch Follower analyzes the pitch of your | [TT{TT]]
(monophonic) playing and outputs a low
value for a low note and a high value for a high note.

SEQUENCER Sequencer
The Step-Sequencer generates control 909000
patterns by looping through 2-32 “stag-

es.” You set the Value for each stage, the

Number of stages, and the Rate or Tempo. The Run
switch allows you to start or stop the sequence.
Damping slurs the change between steps.

ENVELOPE FOLLOWER Envelope
This conyerts mput level to a cqntrol signal, o
responding variably to your playing dynam-

ics. The classic example is a touch-wabh,

where the frequency of the wah varies based on how
hard you play. You can set Attack and Release times
independently, set the trigger Threshold, and adjust

the Gain at the trigger signal input, which can be set
to Input 1 or Input 2.

SCENE CONTROLLERS

Each of the four Scene Controllers

is a “virtual knob” whose setting can
programmed with a different value in every
Scene. By assigning this knob as a modifier source,
you can create “per-scene” parameters.

Scene

0000
0000

For example, you might assign Scene Controller 1 to
Input Drive in the Amp block with a value of 30% in
Scene 1, 50% in Scene 2, 66% in Scene 3, and so on.

As with any source, a scene controller can be
assigned to multiple parameters at the same time,
each with its own modifier settings.

A Scene Controllers tutorial appears on p. 70.
For more on Scenes, see Section 6 on p. 49.

way to copy/paste Controller channels.

The Internal Controllers menu offers four channels for four sets of independent settings for ALL of
the items listed above: four tempos per preset, four sequencer settings, etc. When you change the
channel, ALL of the controllers switch to the new channel and the new settings. FM9-Edit provides a
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MANUAL CONTROLLERS

Similar to Scene Controllers, the five Manual Controllers are virtual knobs whose values can only be changed
manually. A Manual controller makes it possible, for instance, to create a “super control” where one knob
operates multiple sound functions at the same time. For example, you might assign delay mix, reverb time and
chorus depth parameters — all at the same time — to the “Manual 1" modifier source. Now, when you adjust
Manual 1, all of the above parameters will change simultaneously as desired.

Another good use for Manual Controllers is to simulate an expression pedal when you do not have one handy.

TUTORIAL: MANUAL CONTROLLERS

In this tutorial, we will set up a Manual Controller to adjust the Feedback and Mix of a delay block. Load the
factory preset “#009 Plexi 100W".

1. The first step in using a Manual Controller is to assign it as a Modifier Source to the parameter of your
choice. Enter the Layout grid of the preset, navigate to the Delay block, and press EDIT.

Use the PAGE buttons to locate the Config page of the Delay block.

NAV to the Feedback parameter and note the open yellow modifier “ring” beneath the knob.

With the Feedback parameter highlighted, press ENTER to display the Modifier menu.

On the Source page, select Manual 1.

Page right to the Modify page. Set Min to 0% and the Max to 50%.

Press EXIT to return to the Delay menu. Notice that the open modifier symbol is now a solid yellow dot.

NAV to the Mix parameter and press press ENTER to display the Modifier menu.

© o N o g bk WD

On the Source page, select Manual 1.

10. Page right to the Modify page. Set Min to 5% and the Max to 65%.

11. Now let's try the Manual Controller. Press HOME to show the home page.
12. Press the CONTROLLERS button (Push-knob C).

13. Use the PAGE buttons to locate the Manual page of the Controllers menu.

14. Turn knob A to adjust Manual 1 and listen to your delay settings change. As the knob approaches 100%, the
Delay mix increases (louder echoes) and the Feedback increases (more repeats).

15. OPTIONAL: press STORE, ENTER, ENTER if you want to save your work.
Not only will all of the modifier settings be saved, but the position of the Manual knob as well.

CONTROL SWITCHES

The six Control Switch sources can be used with the onboard footswitches or an FC controller. For more
information, please refer to “The Footswitch Functions Guide” on p. 18.
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METRONOME

A metronome is included for convenience. The Metronome is not technically a controller, but its settings are
accessed through the Tempo page of the Controllers menu. To enable the metronome press the Tempo button
and adjust the level for the desired output(s). Note: the metronome levels persist across presets and are reset to
OFF at power on.

EXTERNAL CONTROLLERS

External Controllers are modifier sources that are in turn controlled via external MIDI or a connected expression
pedal or switch. For example, if the source of a modifier on a Wah effect is set to “External 1" and External 1 is set
to “MIDI CC#16"; a connected MIDI expression pedal transmitting CC#16 will operate the Wah.

This concept is illustrated on p. 63

The global assignments for External Controllers are set on the External Control page of the MIDI/Remote menu
under SETUP. You can assign a MIDI CC#, an on-board Expression pedal or switch, or a Pedal or Switch on a
connected FC series controller. Choosing an External Controller as the source of your modifier is the same as
assigning any other source .

To change which CC# or pedal/switch operates an External Controller:

1. Open the MIDI/Remote menu in SETUP and page to External Ctrl.

2. Use NAV to select the External Controller you want to change (ex: “External Control 17).

3. Use VALUE to change the assignment. You can also select “NONE" to disable the selected controller.
4. EXIT when finished.

EXTERNAL CONTROLLER INITIAL VALUES

External Controllers assigned to MIDI are given a value of “0” until some MIDI data is received to change them.
You can imagine how a missing or broken MIDI controller might therefore present a big problem...

The External Controller Initial Value parameters can change the startup value for a controller to 100%. Then,
when the Axe-Fx lll is powered on, any modifiers assigned to the missing controller will be all the way up instead
of all the way down. To change the initial value for an External Controller:

» Page to the General page of the MIDI/Remote menu under SETUP.
» Use NAV to select to whichever controller you want to change (ex: “External Control 1”).
» Use VALUE to change the setting.

EXIT when finished.

MODIFIERS LIST

The last page of the Controllers menu lists all of the modifiers in the current preset. You can jump to edit each
modifier from this list by pressing ENTER.

As you'll gather from looking at the list, the maximum number of modifiers per preset is 24.
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TUTORIAL: SCENE CONTROLLERS

This tutorial requires FM-9 Edit. It assigns a Scene Controller to adjust the Input Drive of an Amp block. While it
is easy enough to achieve different amp sounds within a preset simply by switching the channel, this example
provides an excellent and easy way to understand how Scene Controllers work.

1. Load the factory preset “#030 Wreckers".

2. To simplify this preset for our current needs, select Scene 1 “Rocket” if it isn't already selected. Then, from
the Scenes v dropdown (near the yellow preset name) choose Copy: Copy Current Scene to All.

3. Now let's create the modifier: Click on the Amp block in the grid and find the Drive parameter on the Authentic
page. Notice the open yellow modifier “ring” beneath the knob? This means the parameter can be controlled
by a modifier.

4. Right-click or Ctrl-Click the Drive knob to show the Edit Modifier screen.
5. Click the Source dropdown and select Scene Controller 1.

6. For this tutorial, you don’t need any custom settings on the Modify page, so you may now close the modifier
screen. Notice that the open yellow modifier symbol below Drive is now a solid yellow dot.

7. Now let's set some values for Scene Controller 1. Click the Controllers button in the upper left below the FM9-
Edit logo.

8. Click the “Scene Ctrl 1#2" tab from the list in the second column of the bottom pane of the editor.

9. Notice the eight different values for SCENE CONTROLLER 1. These will set the value for our target parameter
in each of the eight scenes. You can dial in these values now. Set Scene 1 to 15%. Set Scene 2 to 40%. Set
Scene 3 to 60%. Set Scene 4 to 100%.

10. Click the Amp Block so we can see it in action. Watch the Drive knob change as you select scenes 1-4. Try
it out with a guitar so you can hear it in action. Now would also be a good time to rename the scenes if you
want to.

11. Feel free to assign other Scene Controllers to other parameters in your preset as desired.
12. If you want to save your work, use Preset: Save to New Preset Number to avoid overwriting a factory preset.

TIP: You can also edit Scene Controllers without using FM9-Edit. Create a modifier in the usual way and then
find the scene controller values on the Scene Ctrl page of the Controllers menu (Press HOME, then Push-knob C).

Control
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10 LAYOUTS & SWITCHES

Footswitch operation of the FM9 is based on Layouts. A layout is a set of footswitch definitions, each with one
Tap and one Hold function. You can change layouts on the fly to change what the footswitches do. For example,
one layout might be used to select Presets, while a different layout selects Scenes. The FM9 provides eight
layouts, plus one special “Master Layout Menu”. Any switch in any layout can be completely customized with your
choice of functions, colors, and more. Layouts even have their own names to make navigating easier.

While not performing, you can also easily change the layout on the FM9 itself by turning the FC Layout knob on
the Home page.

CHANGING LAYOUTS

Changing from one layout to another is key to the versatility of FM9 foot switches.
There are multiple ways to do change the layout:
» On the home page of the home menu, turn Knob E to change the layout.

» Use the Master Layout Menu (“MLM” for short). This special menu grants instant
access to other layouts, one per footswitch. To show the Master Layout Menu, use the
“combination stomp” shown below and in “The Master Layout Menu” on p. 8.

—3
;\/\; 0 00, 00
b o 2. @ Coor g

» Use a footswitch whose function is set to change the layout. The factory default layouts use this
capability to provide an easy way to go from selecting Presets to selecting Scenes (and back).

» Use Layout Links: this advanced feature allows you to piggyback a layout change on the regular tap
or hold function of a footswitch. You might use this, for instance, to change automatically to the
Scenes layout whenever you select a Preset. Learn more in "The Footswitch Functions Guide”.
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TAP & HOLD FUNCTIONS

Every switch in every layout can have its own individual TAP and/or HOLD functions.

Tap functions — used throughout history for guitar effects and beyond, tap is best for changes that require tight
timing. For example, a tap switch set to switch to a new Scene is ideal to change the sound right on cue.

Hold functions on the other hand, require a “long press” and are fired after a brief delay, so their timing can be
less precise. Hold switches are perfect for functions like opening the Tuner, or accessing an alternate layout such

as Looper Control.

THE RULES OF SWITCH TIMING

Like every product with “hold” footswitches, the FM9 must follow rules for timing so it “knows” whether you are
trying to activate the Tap function or the Hold function. If you're still holding after a short (and configurable) time
delay, the Hold function fires. If you release the switch before the time runs out, the Tap function fires. Whenever
there is a hold function assigned, the tap is activated when the switch is released instead of when it is pressed.
The following illustrations help explain switch firing and timing:

TIMING FOR A TAP FUNCTION
WITH NO HOLD FUNCTION

v

The Tap function fires at the
moment the footswitch is
depressed.

TIMING FOR A TAP FUNCTION
WITH A HOLD FUNCTION

Press and Hold Timeout
(% second by default)
-

VA

The Tap function fires when
you release the switch, as long
as this happens before the
Press and Hold Timeout.

If not, the Hold function
eventually fires...

If you need tight timing from a Tap switch that has a Hold
function, tap and release very quickly—even a fraction of a

second early, knowing that the change will occur as your foot

comes up.

TIMING FOR ANY
HOLD FUNCTION

Press and Hold Timeout
(% second by default)
A

% A

When you hold a switch, its HOLD
function activates when the Press
and Hold Timeout runs out—
whether or not the switch has a Tap
function. This does not cause the
Tap function to fire.

An advanced option, found under
SETUP: FC Controllers: Config
allows you to change the
Hold Function Mode so that any
hold function is delayed until you
release the switch. This allows
you to to fire hold functions with
precise musical timing.

You can change the duration of the Press and Hold Timeout under SETUP: FC Controllers: Config.
The default is 0.5 seconds. Make it longer if you find that you are activating Hold functions when you

mean to activate Tap functions. Make it shorter to fire Hold functions sooner.

You can even have the hold function wait to fire until you release the switch, making it possible to
have direct and perfect control over hold function timing.
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FACTORY DEFAULT LAYOUTS

Factory default settings for the FM9 include various predefined layouts: one for selecting presets, one for
changing scenes, one for the looper, and so on. These are illustrated on the following page.

The Factory default layouts are designed to be very simple. The idea was that they should require almost no
explanation, so someone using the FM9 for the first time could easily understand its capabilities. In fact there is
no such thing as an ideal layout—no “one-size-fits-all” solution. Those who desire to make changes will find it is
very easy to change any switch on any layout to perform any function. See the “The Footswitch Functions Guide”
for a complete reference covering all available functions.

As a bonus, the FM9 also includes an alternate set of layouts based on the popular “OMG9” layouts
used with the Fractal Audio FM3 and FC-6. Learn more “Optional OFM9G Layouts” on p. 106

this clears all of your Footswitch layouts too!

! j WARNING! When you perform Reset System Parameters under SETUP: Utilities

RESETTING THE FACTORY LAYOUTS

The FM9 includes a utility to reset the Factory Default Layouts to their default settings. To do this:
» Open SETUP: FC Controllers/Onboard Switches.

» Page to the RESET page.

» Select the desired option and press ENTER to Load FM9 Factory Default Layouts.
» Press ENTER again to confirm.
» Press HOME to exit.

SWITCH FLOW

Footswitches are not numbered, but the switch definitions in layouts are. The numbers flow is from left to right,
bottom to top, as shown below.
1 [ 1 [
I_ J L ) :I

O
| 1 l 12 I 13 . S : "]
While the FM9 has NINE onboard switches, you will notice that each layout actually contains TWELVE switch

definitions. The extra definitions can be accessed when you connect an FC-12, or when you use the FM9 or an
FC-6 and change the View. See “Layout Views” on p. 83 for additional information.

13




10 LAYOUTS & SWITCHES

FM9 FACTORY LAYOUTS

The default layouts showcase the capabilities of the FM9 and also provide a solid basis for studio or live use.

(Loads Layout 2)

( Y Y
1 PRESETS SCENES | ™°TemPO [ gany 41 J
S A Howo:Tuner Lo
Y Y Y
( P1 I P2 I P3 P4 P5 Bank -1 J
I\ I\ N\
(Loads Layout 1)
( Y Y
2 SCENES PRESETS S7 J
\, Z\ Z\
Y Y Y
( S1 I S2 I S3 S4 S5 J
I\ I\ N\
(Loads Layout 4)
( Y Y
3 EFFECTS Flanger 1 Rotary 1 |MORE FX>J
\, Z\ Z\
Y Y Y
(Phaseﬂ I Drive 1 ITremPam Chorus 1 Delay 1 Reverb 1 J
I\ I\ N\
(Loads Layout 3)
Y Y
4 MORE FX (Enhance1 RingMod 1 | <<MORE FXJ
<> <>
[ Comp 1 I Drive 2 IMuItiDeIay1I Plex 1 Delay 2 Pitch 1 J
N\ N\
5 LOOPER ( Erase I I Looper J
Bypass
[TapTempoI Record I Play I Once IHaIfSpeedI Reversej
6 PER-PRESET (Teowr [ eors | eess )
[ PP#1 I PP#2 I PP#3 I PP#4 I PP#5 I PP#6 J
Y Y
7 CHANNELS (Delay1 A/B| Drive 1C Drive 1D J
<> <>
[ Amp 1A I Amp 1B I Amp 1C I Amp 1D Drive 1A Drive 1B J
I\ N\
- Y
8 SETLIST SONG Prev Song | Next Song TAPTempOJ
A HoLo:Tuner
Y \
[Section 1 ISection 2 I Section 3 I Section 4 | Section5 | Section 6)
I\ N\

Layout 1: Presets is designed for switching
presets, with switches for the NEXT and
PREVIOUS BANK.

The SCENES switch changes to Layout 2.
Hold the Tempo switch to show the Tuner.

Layout 2: Scenes is designed for selecting
scenes 1-8.
The PRESETS switch returns to LAYOUT 1.

Layout 3: Effects allows you to bypass or
engage eight different effects.

The MORE>> switch loads layout 4, for
access to eight more effects, plus a switch
to return to the first FX layout.

Remember that the LED ring will be BRIGHT
if an effect is engaged, DIM if an effect is
bypassed, and OFF if an effect is not found
in the current preset.

Layout 5: Looper offers every control on
the Looper block, plus Looper Bypass and
Tap Tempo.

Layout 6: Per-Preset demonstrates
per-preset “placeholder” switches (as
compared to per-preset “overrides”).

You will need to create switch definitions in
your presets for this layout to work.

See “Per-Preset Switches” on p. 80

Layout 7 contains effect Channel switches
for Amp 1, Drive 1, and Delay 1.

Layout 8 is ready for use with the Setlist/
Song feature. Note that you must have
songs in a set list for this to work. See p.

BONUS! Many who use the Fractal Audio FM3 with an FC-6 enjoy a special set of custom layouts
cheekily called “OMG9.” We created a special FM9 version of this system called “OFM9G" and it
can be installed in just a few simple steps by anyone who wants to try this popular way of using the
footswitches. See p. 106 for more information.
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EASY (“EZ") EDITS

The FM9 makes it simple to change any footswitch in any layout to perform any function.
The easiest way to do this is with the “EZ” Switch edit page as described below.

IMPORTANT: To avoid annoying screen jumps and sonic mishaps, all footswitches are DISABLED
while you are on the EZ page. To test switch edits, change to a different menu page or press EXIT.
TO USE THE EZ EDIT PAGE:

» Onthe FM9, open SETUP: FC Controllers/Onboard Switches and
page to the “EZ" tab if it isn't already selected.

» Press the footswitch you want to edit.

» An onscreen graphic shows which footswitch you have selected.

FC Controllers EZ

Tap any footswitch to see its settings below. O O O
®¢ O O O O O

Layout 1: PRESETS
Switch Ring Color Default

Category Preset

Function Select by #
Preset 1
Mini-Display Label Name

Category Unassigned
Function 5

C Nav Value
RESET SWITCH | COPY SWITCH | PASTE SWITCH

» You can edit both TAP and HOLD functions for any switch.
» Use the A knob or NAV buttons to navigate the list and C or VALUE knobs to make changes.

= Set the desired Category and the Function.

= Set any parameters for the selected Function as desired. For example, when you choose
Preset: Select by #, a parameter appears to let you set the desired preset number.

= You can also customize the ring color for an individual switch, overriding the defaults which are assigned
to the current Category.

= You can also select from different automatic “labels” for the Mini-Display, or enter Custom text.
» The EZ page also provides buttons to RESET (clear with confirmation), and COPY/PASTE switches.

» Press another footswitch to move on, or press EXIT when finished.

& Reminder: All changes in the FC Controllers menu take effect immediately with no need to store.

For more information on functions and their parameters, please see “The Footswitch Functions Guide”.
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THE LAYOUTS LIST

EZ editing is certainly easy, but the FM9 also provides a deeper way to set up layouts and switches. The Edit
Layout page of the Foot Controllers menu provides an overview of all layouts, plus the ability to drill down into
any switch, with all of the settings from EZ page and more.

FC Controllers Layouts
LAYOUT NAME

Layout 1 PRESETS
Layout 2 SCENES
Layout 3 EFFECTS
Layout 4 MORE FX
Layout 5 LOOPER
Layout 6 PER-PRESET

Layout 7 CHANNELS
Layout 8 EMPTY
Layout 9 MasterLayout

C Nav
RESET ALL EDIT LAYOUT EDIT NAME COPY LAYOUT |  PASTE LAYOUT

On the FM9, open the Setup: Foot Controllers and page to the “Layouts” tab.

» Use the A knob or NAV buttons to select the desired layout.

» Select any layout and press ENTER or EDIT LAYOUT (Push-knob B) to open that layout for deeper editing.
» The push-knobs offer additional functions:

= RESET ALL sets all functions for all switches in all layouts to “Unassigned” and clears all customization.
(A confirmation screen requires you to press ENTER first.)
= EDIT NAME allows you to rename the layout (see “Naming Layouts” on p. 79).

= COPY LAYOUT and PASTE LAYOUT allow you to duplicate layouts across numbered locations.

Number 9... As you review or edit layouts, you will notice “Layout 9" in the list.
@ Layout 9 is in fact the Master Layout Menu used to access other layouts.
Do not edit this layout unless you understand what it is, what you're changing, and how it works.
If you modify the Master Layout Menu — intentionally or otherwise — you can easily reset it to factory default

settings without resetting anything else. Just use the “RESET LAYOUT" button on the Edit Layout page (p. 77).
Unlike all other layouts, #9 reverts to factory settings instead of being completely cleared.

As you get deeper in to the FM9, you may find the ability to modify the MLM quite useful, with options like “Layout
Link” or the ability to add functions instead of unused menus.
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Select any layout on the Layouts page (p. 76) and press ENTER or EDIT LAYOUT (Push-knob B)
to open that layout for editing in the Edit Layout view.

The Edit Layout view has two pages: one for the Tap functions and one for the Hold functions. Each shows the
Category and the Function for all 12 switches, plus values for the first two parameters of each. Note that many
functions have more than two parameters, available on the deeper “Edit Switch” screen (p. 78).

Edit Layout 1: PRESETS

CATEGORY

Preset

Preset

Preset
Unassigned
Unassigned
Unassigned
Unassigned
Unassigned
Unassigned
Unassigned
Unassigned
Unassigned

1Tap
2 Tap
3 Tap
4 Tap
o Tap
6 Tap
7 Tap
8 Tap
9 Tap
10 Tap
11 Tap
12 Tap

C Nav
RESET LAYOUT

Category
EDIT SWITCH

Notice the Tap and Hold pages

Tap
FUNCTION VALUE 1 VALUE 2

Select in Bank 1
Select in Bank 2
Select in Bank

Function Value 1 Value 1
RESET SWITCH | | COPY SWITCH | PASTE SWITCH

» UsetheA, B, C,D, and E knobs, or the NAV buttons and VALUE knob to make changes.

» Select any switch and press ENTER or the EDIT SWITCH button (Push-
knob B) to open that switch for deeper editing (see p. 78).

» The push-knobs offer additional functions:

= RESET LAYOUT sets all switches in the current layout to “Unassigned” and clears all customization.
(A confirmation screen requires you to press ENTER first.)

» RESET SWITCH clears the Tap or Hold function from the current switch.
= COPY SWITCH and PASTE SWITCH provide a means to replicate a switch to a new location.

@ See “The Footswitch Functions Guide” for details on all categories, functions, and parameters.
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EDIT A SWITCH

Select any switch on the Edit Layout page (p. 77) and press
EDIT SWITCH or ENTER to open the selected switch for deep editing.

The Edit Switch view has two pages: one for its Tap function and one for its Hold function.
Each page shows the current Category and the Function for the switch, plus any and all parameters for the
current function.

» UsetheA,B,C,D,and E knobs or the NAV buttons and VALUE wheel to make changes.

» On the Tap page, you can also change the Switch Ring Color for an
individual switch, overriding the usual default Category color.

» You can select from different automatic “labels” for the Mini-Display, or even enter custom text.
Details on the various label options can be found in “The Footswitch Functions Guide”

Notice the Tap and Hold pages

Edit Layout 5: PRESETS / Switch 5

Category Preset
Function Select in Bank
Preset S
Mini-Display Label Name

Switch Ring Color Default

FC#1
FC#2
FC#3
FC#4

RESET TAP

» The LAYOUT LINK parameters allow the Tap or Hold function of the switch to
also change the Layout and View of the FM9 and up to two connected FC units.
See "The Footswitch Functions Guide” for more on Layout Links.

» The RESET button (Push-knob A) clears the function and all customization from the current page.
(A confirmation screen requires you to press ENTER first.)

A NOTE ON PRESS & HOLD LABELS IN THE MINI DISPLAYS

The Mini-Display for each switch shows the label for its Tap function. When a switch is pressed down — even
briefly for a normal “tap” — it changes to show the label of the Hold function, even if you don’t keep holding the
switch down until its Hold function fires.

A special “Reveal Hold" utility switch can also cause all mini-displays to persistently show the Hold functions for
their switches. See "The Footswitch Functions Guide” for more on this.
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NAMING LAYOUTS

Every Layout has a name, which appears in the Master Layout Menu and can also appear on dedicated Layout
footswitches. Changing the name of a layout is simple with the same interface used to name presets and scenes.

NAME A LAYOUT:
» Onthe FM9, open the “Layouts” page of the FC Controllers/Onboard Switches menu under SETUP.

» Use the A knob or NAV buttons to select the desired layout.
» Push the EDIT NAME button (Push-knob C).
» Enter the desired name, up to ten characters:

= Turn the B knob or use NAV buttons to move the cursor.

= The C knob selects upper case letters.

= The D knob selects lower case letters.

= The E knob selects numbers.

= The VALUE knob selects ALL characters, including symbols.
= Press D or E for INSERT and DELETE functions.

= Press ENTER to commit the name or EXIT to cancel.

&= Reminder: All changes in the FC Controllers menu take effect immediately with no need to store.

STARTUP LAYOUT

The FM9 and each connected FC Controller have a Default Startup Layout that loads automatically when you
power on the FM9. You can change the default startup layout for any device as follows.

SET DEFAULT LAYOUTS:
» Onthe FM9, open the “Devices” page of the FC Controllers/Onboard Switches menu under SETUP.

» Use the A knob to select the desired Device.
» Use the NAV buttons and VALUE wheel to set the desired Default Layout.

» You can also manually change the Current Layout and Current View (p. 83)
for both the FM9 itself and any connected FC controllers.

The Devices page also allows you to set up Mirroring the FM9 to an FC controller.
See the FC Controller Owner’s Manual for more on mirroring.

BACKING UP LAYOUTS

All layouts are included in any backup of the unit’s system, but you
can also back up or restore Layouts individually or all at once using
FMO9-Edit. Find these options in the Edit dropdown of the Layouts
section of the “FC Controllers” area. (shown at right).

LAYOUTS
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PER-PRESET SWITCHES

Like the Axe-Fx Ill and FM3, the FM9 supports two ways of having the footswitches in any layout change on a per-
preset basis. The first is “Placeholders” and the second is “Overrides.” Both of these methods rely on the special
set of “Per Preset Switch Definitions” that are part of every preset. Find these definitions in the “Per-Preset FC”
area of the Home menu (Push-knob D).

Numbered Placeholder switches (like those in the FM9 factory “Per Preset” layout) are inserted just like any
other function in any Layout. They do nothing, however, unless the correspondingly numbered Per-Preset Switch
Definition is populated. For example, the first switch in Layout 6 is set to always perform the first Per-Preset
switch definition (“PP#1") in the current preset. This might be “Drive 2: Bypass” in one preset and “Flanger 2:
Bypass” in another.

Overrides are less polite. Each preset also has the ability to commandeer any switch in any layout. Whatever
global definition that switch normally has is instead replaced by a PP# of your choice. For example, a given preset
might force “Layout 1, Switch 1" to show PP#2. Imagine you have your whole board set up around five scenes

but then suddenly realize you need a 6th scene in just one song. You dial in “PP#2" to “Select Scene 6" and then
override the Tempo switch in your main layout with PP#2 in the preset for that one song. Very cool.

Critically, both Placeholders and Overrides draw from the same list of 24 numbered per-preset definitions (“PP#)
found in any preset. In the case of Placeholders, the footswitch asks for one by its number. In the case of
Overrides, the preset forces a designated switch into a designated position.

Learn more about Per-Preset Switches in the Footswitch Functions Guide available on our web site:

https://www.fractalaudio.com/fas-ffg

CREATING PER-PRESET SWITCH DEFINITIONS

Here's how to create the definitions used by both types of Per-Preset switches:

1. Load the desired preset and navigate to its list of per-preset switch footswitch definitions:

= Press HOME, then use Push-knob D to open the FC Per-Preset menu.
= Page to the Per-Preset FC tab if it isn't already selected.

2. Nav to the top of the list and then turn the VALUE knob to select your choice of per-preset switch definitions
(numbered “PP# 1-24.). The first twelve of these appear as placeholders in layout 6.

3. Define the PP# switch. The interface is basically identical to that used by the “EZ” footswitch page.
= You can set Tap Function, Hold Function, LED ring color, Mini-Display settings, and Layout Links.

4. Repeat this process from step 2 for any other PP# switches you wish to define.

5. OPTION: If you want to create any overrides, turn the page to “Overrides”. NAV to the Layout and Switch you
want to override and turn the VALUE wheel to the desired PP#.

6. You must save the preset to commit any changes: STORE, ENTER, ENTER.
7. Press HOME when finished.


https://www.fractalaudio.com/fas-ffg
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STAND-IN SWITCHES

Stand-In Switches allow an external switch to fire the function of a switch in any layout. This requires you to have
one or more external switches. These can be connected directly to the FM9 (see p. 12) or to an FC Controller
(see your FC Owner’s Manual).

Without the Stand-In Switch feature, the capabilities of an external switch are very limited. Modifiers and global
functions, for instance don't have any press-and-hold capabilities, and they can't, for instance, change a Bank,
switch a Layout or View, or have any kind of per-preset capability.

To make such switches more powerful, we created Stand-In Switches. This feature allows a connected external
switch to operate like a remote control for any switch that you have already programmed in a layout on your FM9.

For example, you might normally have Layout 3, Switch 12 set to bypass/engage the Trem Pan 1 block on tap,
and toggle the block’s channel from A to B on hold. When you set up an external switch Stand-In for Layout 3,
Switch 12, it now performs these functions. This even allows an external switch to perform per-preset functions
as described on the previous page. Be aware that the stand-in is just a pointer. If you change the switch under
remote control, the function of the stand-in will change too.

TO CREATE A STAND-IN SWITCH:

From the Home page, open SETUP: FC Controllers/Onboard Switches
Page to the Stand-In Switches tab.

Navigate up or down to the switch you want to set up. For example, “FM9 SW2 Tip”
Select the desired Layout and Switch using the B and C or Value knobs.
Set up any other Stand-In Switches and press Home when finished.

o gk wDd =

Test your switch.
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USING THE FM9 WITH AN FC CONTROLLER

The FM9 has a FASLINK port to connect up to two Fractal Audio FC-6 or FC-12 foot controllers. Using an FC
controller expands the number of footswitches to increase your options on the floor — including jacks for 4
additional expression pedals and 4 external switches per FC. No special configuration is required; simply connect
the FC to the FM9 and it begins working.

Up to two FC controllers can also be daisy chained from the FM9, increasing the total maximum number of
simultaneous footswitches to 33!

Remember that when daisy-chaining, the second FC Controller will require an AC adapter. It is not powered by the
FASLINK “thru” connector on the first FC Controller.

When adding an FC, you will need to create custom layouts, since all the factory default options have been
designed around nine footswitches. The usual way to do this will be to have some layouts dedicated to the FM9
and others dedicated to the FC-6 or FC-12.

The Layout Link feature becomes especially important in this type of setup, since it allows one foot controller to
change the layout on another controller. See “The Footswitch Functions Guide” for more on this feature.

An additional benefit of using the
FM9 with an FC Controller is that
each attached controller supports
an additional four expression
pedals and four external switches!
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LAYOUT VIEWS

You will recall that a layout consists of twelve footswitch definitions, only nine of which are displayed when that
layout is used on an FM9'. Views allow you to take advantage of the remaining three switches, and also allow a
connected FC-6 to show switches 1-6 or 7-12, thereby maximizing the utility of each layout.

You typically change the view by using a footswitch function, but there are other ways as well. On the Home page
of the Home menu, knob D changes the View, as does a parameter found in Setup: C Controllers: Devices.

The allocation of switches between View 1 and View 2 is illustrated below.

1 A connected FC-12 can show all 12 at once.

VIEW 1 7 1 e | [ ]
17\ 17\ 17\
E e I e I e B e T e

1A\ 17\ 17\ 17\ 17\ 17\
©

QO
7

VIEW 2 =viewt| [ - | [ — ]
17\ 17\ 1A\

17\ O\ 1A\

On the FM9, View 2 shows only three switches — those “left over” from View 1. To maximize their utility without
the need to sacrifice a tap or hold function, a switch in the top row is hard-coded to change back to View 1.

In SETUP: FC Controllers : Devices, you can also set the default startup view for the FM9 or a connected FC.
See p. 79 for more on this menu page.
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FM9 FOOTSWITCH FAQ

As mentioned throughout this manual, the “The Footswitch Functions Guide” covers everything there is to know
about the many categories and functions that can be assign to Tap or Hold on FM9 switches.

Here is a quick summary of common questions.

Q:
A:

Q

Q

How do the LED rings for EFFECT switches work?

The LED Rings show up-to-the-moment information about the assigned effect. If the ring is DIM, the effect
is OFF. If the ring is BRIGHT, the effect is ON. If the ring is completely OFF, then the assigned effect is NOT
AVAILABLE in the current preset.

TIP: One of the most common uses for “Per Preset Footswitches” is to override an
unused effect switch with one for an effect that is used in that preset.

How do | assign presets to footswitches?

This can be done using the PRESET: SELECT function, but this approach is really only appropriate if you use
very few presets in total. Instead, BANKS make it easy to get to get to many presets using few switches.

In fact, the preset Footswitches in the default FM9 layouts use a function called “PRESET: SELECT IN BANK"
to automatically load presets in the order in which they are stored in the FM9. It is easy to reorder presets
using the Manage Presets area of FM9-Edit, where you can copy/paste or use drag-and-drop to swap preset
locations. (Don't forget to press “Save” to commit your changes.)

TIP: While using Manage Presets, turn on the “FC Banks"” option at the top so you can
easily see which presets will map to which footswitches. The FM9 includes many empty
preset memories, providing lots of room for you to store additional creations.

Can | back up, share, or restore my Footswitch Layouts?

Yes. Perhaps the most common way to back up your footswitch layouts is to receive a backup of your
SYSTEM using Fractal-Bot (p._13). The system file contains all of the layouts and FC settings.

FM9-Edit is even more flexible, with options to export

or import individual layouts or the entire set. Find these
choices in the Edit menu dropdown located in the LAYOUTS
panel of the FC Controllers area of FM9-Edit.

LAYOUTS
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11 TEMPO

Tempo is used in electronic music for synchronizing different rates and times, whether inside one machine or
across several. Tempo on the FM9 allows for both internal and external synchronization, providing effects with
a central BPM clock that can either work standalone or chase incoming MIDI Clock from 5-pin or USB. The FM9
does not transmit MIDI Clock. The Tempo can be set to any whole number value in the range 20-250 BPM. The
FM9 flashes its current tempo on a front-panel LED and any footswitch assigned to Tempo.

THE GLOBAL TEMPO

The Global Tempo is a system setting outside of any presets, scenes or channels.
You can change it in any of several ways:

1. Tap any onboard or FC footswitch assigned to the Utility: Tempo function.

2. Tap two or more times on the front panel TEMPO button.

3. Tap the TEMPO button once and use the Tempo knob (B).

4. Use an external MIDI device to transmit MIDI Clock to the FM9 over 5-pin or USB.
5

Use a MIDI CC# or external switch assigned to Tempo Tap.
Find this assignment in Setup: MIDI Remote: Other.

Be aware that whenever you change the Global Tempo, you are also changing the current Preset Tempo, which will
be saved if you store the current preset (see below). Be on guard not to over-write saved tempos.

TTIP: By default, Tap Tempo uses an “AVERAGE” of ten taps, which is forgiving but gradual. You can change this
so it uses only the “LAST TWO" — a more abrupt but precise method.
Find this Tap Tempo option under SETUP: Global Settings: Config: Tap Tempo.

PRESET TEMPO

By default, a given preset will ignore the Global Tempo and use its own saved Preset Tempo instead. Tap the
top panel tempo button (not a footswitch) and notice that a preset’s Tempo page contains two parameters: one
is an actual Tempo (BPM) value, and the other is a setting called Tempo To Use, which determines what happens
whenever that preset is loaded.

When you load a preset whose Tempo To Use is “PRESET," the saved Preset Tempo takes over: the tempo display
updates and all tempo-dependent time/rate parameters are recalculated. In fact the Global Tempo has not
changed; it remains in the background and will be used when you load a different preset with Tempo to Use set to
“GLOBAL".

NOTE: Be aware that whenever you manually change a preset Tempo, you are also updating the Global Tempo.

Remember that each of the four channels of the Controllers block has its own settings for both Tempo (BPM) and
Tempo to Use. You can use this to have some Scenes or Channels change the tempo while others do not.

TO SET “TEMPO TO USE"...
1. Load the preset.
2. Tap once on the TEMPO button.
3. Change TEMPO TO USE as desired to either “GLOBAL" or “PRESET".
4. STORE the preset.

85
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SYNCHRONIZING SOUND PARAMETERS

Many rates and times on the FM9 can synchronized to the Tempo by setting their corresponding Tempo
parameters. This is done by selecting from a list of values, ranging from 1/64-note-triplets to double whole notes,
with 76+ options in all. For example, to set the Time of a Delay block to follow the quarter note pulse of the
tempo, find the Tempo parameter on the Config page of the Delay block’s Edit menu and set this value to “1/4.”

The moment you assign a value for Tempo (other than “NONE”), its associated rate or time parameter is
overridden and may not be changed manually — as indicated by its appearance in parentheses. To regain control
of an overridden parameter, set its corresponding Tempo parameter back to “NONE".

TO SYNCHRONIZE A DELAY TO THE TEMPO...
» Navigate to any type of Delay block and press EDIT to show its Edit menu.

» Find the Tempo parameter and set it to “1/4". Feel free to choose/explore other options. “1/8th dot”
is also very useful and popular. Note that some delay types have more than one Tempo parameter.

» STORE the preset.

Remember that once a Tempo has been set, you will be unable to adjust Time manually or with a Modifier.

TO SYNCHRONIZE A TREMOLO OR OTHER RATE TO THE TEMPO...

» Navigate to the effect and press EDIT to show its Edit menu.

» Find the Tempo parameter and set it as desired. A typical value here might be
“1/8th" or “1/16th". Feel free to choose/explore other options.

» STORE the preset.
Remember that once a Tempo has been set, you will be unable to adjust Rate manually or with a Modifier.

Note that syncing an LFO to the tempo does not align the phase of that LFO to the Tempo LED, to MIDI song
position pointer, or to other synchronized LFOs. You can synchronize various LFOs together by setting their RATE
knobs fully counterclockwise to “LFO1 SYNC" and then syncing the LFO1 Controller to the Tempo (p. 67).
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12 TUNER

The FM9 has a built-in Tuner—an essential tool for the performing or recording musician. The tuner is easy to use
and has high-resolution automatic pitch detection, a calibration control, offsets for modified tuning schemes, and
the option to mute audio while tuning. Find the Tuner on the Home page by pressing TUNER (Push-knob A) or on
various foot switches in the footswitch layouts.

The tuner features a note name display, a “zero-center” meter, a spinning “strobe” type display and triangular
indicators for sharp and flat.

ADVANCED TUNER FUNCTIONS

The actual tuner is on the Tune page of the Tuner menu.
The Config and Offsets pages provide options for advanced tuner functions.

Configuration Parameters

OFF/INPUT/OUTPUT

PARAMETER Description.
Source Selects which physical input the tuner should listen at.
Mute Determines how the tuner mute function works.

= OFF: No mute. All signal is passed as usual when the tuner is engaged.
= QUTPUT: The signal is muted at the output. Tails are silenced.
= INPUT: The signal is muted at the noise gate. Tails ring out.

Display Mode

MIXED/ALL FLATS/
ALL SHARPS

Determines whether the tuner shows note names for accidentals as Sharps, Flats, or a
mix of both.

Calibration
430.0 - 450.0 Hz

Calibrates the tuner by setting the frequency of A4 (in the octave above middle C).
The tuner defaults to A440.

Downtune

0 - 4 Semitones

The Downtune control allows for simplified tuning when tuning down one to four
semitones. The Tuner display will read the non-downtuned equivalent note, i.e. if tuning
down two semitones, the D will still show E. While Downtune is set to any value other
than None, any blocks that utilize pitch information will also be transposed accordingly.

Use Offsets Determines whether the Offset settings (see below) are applied or ignored.
OFF/ON

OFFSET PARAMETERS
PARAMETER Description
E1, B2, G3, D4, A5, E6 | Offsets allow the tuner to be calibrated so individual notes diverge from standard
+/-25.00 Cts concert tuning by a defined amount. Use this for example for Buzz Feiten tuning.
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MINI TUNERS »—|—=

For convenience, mini-tuners appear throughout the FM9. These consist of two green triangles to indicate when a
note is flat (left lit), sharp (right lit) or in tune (both lit). A small line helps display tuning progress.

FOOTSWITCH TUNER MODE

This option, which you can enable in SETUP: FC Controllers: Config uses the onboard LED rings of the FM9 to
help you tune visually.
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13 SETUP MENU

Open the menu by pressing the SETUP button (Push-knob E) on the Home page. The current Firmware Version
is shown at the top of the page. To enter a menu, select it with NAV and press ENTER. All changes take effect
immediately without needing to be stored. The settings for Setup parameters are included in a backup of the
System (see "Backing Up & Restoring" on p. 103)

FC SETLISTS/SONGS MENU

"Setlists & Songs" on p. 110

FC CONTROLLERS/ONBOARD SWITCHES MENUS

FC: EZ PAGE FC: REMOTE PAGE
"Easy (“EZ") Edits" on p. 75 Covered in the Owner's Manual for the FC Controller
FC: DEVICES PAGE FC: STAND-IN SWITCHES PAGE
"Startup Layout” on p. 79 "Stand-In Switches" on p. 81
See also "Mirroring” in the FC Controllers manual. FC: CS MIDI
FC: LAYOUTS PAGE Covered in "Control Switches" in
"Edit a Layout” on p. 77 "The Footswitch Functions Guide"
FC: RING COLORS PAGE FC: RESET
"Footswitches" onp. 9 Provides options to load factory layouts.
FC: CONFIG PAGE
PARAMETER Description
Bank Size "Preset in Bank" footswitch functions group presets into dynamic “Banks”

whose size is set by this parameter. Factory Layouts set Bank Size

automatically, but you can change it for use with custom layouts. Bank Size

should typically correspond to the number of “Preset in Bank” switches in

your layout(s).

Bank Switch Limits "Bank Inc/Dec" footswitches have "Upper Limit" and "Lower Limit" settings
(detailed in "The Footswitch Functions Guide"). Setting Bank Switch Limits to

DISABLED, ENABLED DISABLD will cause such limits to be ignored, allowing access to ALL banks.

MLM Switch Combo The Master Layout Menu (aka “MLM”, aka “Layout 9”) provides access to

ENABLED, DISABLED other layouts. This setting disables or enables the special "foot rocking”
switch combination used to display this menu on the FM9 and any connected
FC controllers. See also "The Master Layout Menu" on p. 8.

Hold Function Timeout This sets the time limit before a Hold function is automatically fired,

_ beginning from the moment the switch is depressed. When a Hold function is
0.25-2.00 seconds assigned, a Tap function fires if the switch is released before the press and
hold timeout elapses. See also "The Rules of Switch Timing" on p. 72.

1-12
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PARAMETER

Description

Hold Function Mode

AUTOMATIC,
SWITCH UP

Per-Preset Overrides
ENABLED, DISABLED

Footswitch Tuner Mode

ENABLED, DISABLED
FC-6 Layout Mode

FC MAIN DISPLAY
Show Preset Numbers,
Show Scene Numbers

ON/OFF
Main LCD Display Mode

Message Hold

Ring Intensity Bright,
Ring Intensity Dim
25-100%, 1-50%,
Mini-Display Contrast

Mini-Display + Ring Brightness

Invert Mini Displays

CS1 Exclusive, etc.

Normally, Hold functions fire automatically after a timeout (above). With this
setting changed from AUTOMATIC to SWITCH UP, they wait for the switch to
be released, granting precise control over the timing of a hold function. Now,
you can use HOLD, for example, to change a Scene on the downbeat.

Any preset can override the function of any footswitch in any layout. This
offers extreme flexibility, making it possible to handle exceptions in the
global layouts. This allows you to globally DISABLE Per-Preset overrides to
prevent 3rd party presets from taking over essential footswitches. See "The
Footswitch Functions Guide" for more on per-preset functions.

Turn this feature ON to enable a special mode where the first three
footswitches visually enhance the tuning process.

This changes how layouts are displayed on a connected FC-6. Normally, the
FC-6 shows switches 1-6 from any layout — just as you would expect. If you
design layouts on an FC-12 and then load them on an FC-6, however, this
results in things being arranged differently, especially when Views are used.
To counter this, you can enable FC-12 mode on the FC-6 (Formerly called "FC-
6/FC-12 Compatibility Mode"), illustrated below:

FC-6 Default Mode FC-6 in FC-12 Mode

s JEeE v JFes s JEE P -]
4 5 6 10 11 12 7 8 9 10 11 12
1 2 3 7 8 9 1 2 3 4 5 6
View 1 View 2 View 1 View 2

The main display of a connected FC controller shows the name and number
of the current preset and current scene. These two options allows you to
individually hide the numbers so a greater number of characters can be
dedicated to the names. This has no effect except on a connected FC.

Can be used to force a connected FC to show preset/scene names instead of
Song/Section names when using the Setlist/Song feature.

This determines the duration for special footswitch messages to be shown

in the main display of the FM9 or the display of a connected FC controller.
Example: Effect BYPASSED or ENGAGED)

Each FC footswitch has its own LED ring. These rings change between off,
dim, and bright to show switch states. The Ring Intensity parameters allow
you to independently adjust the brightness of dim and bright states.

This sets the contrast in the onboard mini-displays.
This sets the master brightness of the onboard mini-displays and LED rings.

Turning this ON causes the mini displays to show light text on a dark
background.

Six options allow you to add each of the six Control Switches to a mutually
exclusive group. Any switch with Exclusivity enabled becomes a member of a
group in which only ONE switch can be turned on at once. Turning any switch
in the group ON will turn all others in the group OFF automatically.

For more on Control Switches, see the Footswitch Functions Guide (p. 18)
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THE GLOBAL SETTINGS MENU

& Reminder: You do not need to store settings in the SETUP menu. EXIT twice when finished.

GLOBAL SETTINGS: CONFIG PAGE

PARAMETER

Description

Output 1 EQ Type
Output 2 EQ Type
Output 3 EQ Type
Power Amp Modeling

ON/OFF

Cabinet Modeling
ON/OFF

Tone Control Display
AUTHENTIC/IDEAL

Speaker Impedance Curve

Spillover
OFF/DELAY/REVERB/BOTH

These settings change the global EQs (p. 93) to Graphic EQ, Parametric EQ,
or disabled.

This parameter globally disables power amp simulation in all Amp blocks in all
presets. This can be useful when the FM9 is used with a guitar-oriented/tube
power amp that contributes significantly to tone and dynamics. Having these
characteristics applied twice to the sound—once in the virtual power amp and
once in the real power amp—would result in an over-processed sound. All of
the Amp block parameters that are NOT part of the virtual power amp continue
to work normally while Power Amp Modeling is turned off. Presence and Depth
are disabled, and Master Volume becomes a simple volume control. Remember
that like a real amp, the FM9 has separate preamp and power amp sections.
When you disable Power Amp Modeling, the Amp block still models the preamp,
which includes distortion, the tone stack, and more. It is also possible to
disable power amp modeling in an individual preset using a switch in the Amp
block. See "The Fractal Audio Blocks Guide" for more information.

This parameter conveniently enables or disables Cab block processing in all
presets. Globally disabling the Cabinet Modeling will not cause the Cab block to
appear bypassed on the grid, but it will have no effect on the sound in any way.
This parameter governs the "Tone" page of the amp block. When set to
"AUTHENTIC", (default) only those controls present on the actual amp are
displayed. When set to "IDEAL, all tone controls are displayed. In Authentic
mode, the Bass, Mid and Treble controls are reset to default values when
changing models to ensure accuracy for models that may not have these
controls.

Determines how the Speaker Impedance curve is set when changing Type
(Amp Model) in the Amp Block. When set to "DEFAULT ", the usual matching
impedance curve for the new Type is used. When any other value is set here,
this type will be pre-selected whenever the Amp Type is changed.

Allows delay and reverb “tails” to ring out or spill over across Preset changes.
You can select whether “DELAY”, “REVERB", or “BOTH" effects will spill over.
Setting to “OFF” causes effect tails to be cleared upon preset change. Spillover
when switching Scenes or using “IA” Switches is not affected by this parameter.

See also "Spillover" on p. 121
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PARAMETER Description
Reverb Mix This boosts or cuts the Mix for all Reverb blocks in all presets. Note that this
+/- 50% offset is not reflected in the value shown for the actual Reverb Mix parameter.
° This feature is provided because certain dead or lively performance spaces
may require more or less reverb across all presets.
Remember that Mix generally applies only to Reverb blocks which are wired in
series. Parallel reverbs typically require Mix to be at 100%.
Effects Mix This boosts or cuts the Mix of all blocks in which the Global Mix switch is set
+/-50% to “ON". This switch must be enabled on a per-block/per-preset basis and is
available on the Mix page of the Edit menu for the following blocks:
Chorus Formant Pitch Ring Mod
Delay Multitap Delay Plex Delay Rotary
Flanger Phaser Reverb Ten-Tap Delay
This feature is provided because certain performance spaces may require more
or less of certain effects across all presets.
Noisegate Offset Globally raises or lowers the THRESHOLD of the Noise Gate for all Input blocks.
+/-40.00 dB If the THRESHOLD for a given preset is set to “OFF”, the global Offset will have
' no effect. See "The Fractal Audio Blocks Guide" for more on the noise gate.
Prompt on Edited Preset When set to ON the unit will prompt before changing an edited preset. This may
Change save you from accidentally losing your edits. NOTE: Be sure to change this to
OFF/ON OFF before performing!
Indicate Edited on Scene This determines whether or not the EDITED top panel LED (and corresponding
Change graphic in the editor) is triggered by Scene changes or not. Even if the LED is
OFF/ON disabled, the current scene will still be saved whenever you store a preset.
Display Offset (Also appears in the MIDI/Remote menu) Causes presets numbers to begin
0.1 at 001 instead of 000. This only offsets the display, meaning that it does not

Default Scene
AS SAVED, SCENES 1-8

Tap Tempo
AVERAGE, LAST TWO

Value Knob Push Function

AC Line Frequency

change which preset is actually loaded by a given footswitch or MIDI message.

When set to “As Saved” the scene selected when recalling a preset is the scene
that was active when the preset was last saved. When set to a particular scene
value that scene will always be selected when any preset is recalled.
Determines how the tempo changes when tapping the front panel TEMPO
button or an external tap tempo controller (see p. 100). “AVERAGE” sets the
tempo based on the average of ten taps, meaning taps are more forgiving

but changes are more gradual. “LAST TWOQ" considers only the time interval
between the last two taps, which means taps must be more precise but
changes occur more quickly.

By default, pushing the main “VALUE" knob shows the layout grid. To disable
this feature, change the setting of this parameter to “NONE".

The Noise Gate in the Input Block uses smart EMI filtering to reduce hum and
buzz. For this to work correctly, you must set this parameter to match the power
line frequency of your country (i.e. 60 Hz for North America, 50 Hz for EU, etc.).
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GLOBAL SETTINGS: OUT 1, OUT 2, OUT 3 EQ PAGES

Each of the main output pairs passes through its own global equalizer, with the option for Graphic, Parametric,

or disabled (p. 91). Each EQ also features a master LEVEL adjustment control. Use the global EQs to make
adjustments to the tone or level of ALL presets. This is convenient when you need to compensate for using a
different amp or speakers, or if a particular performance space is overly bright or boomy. The master LEVEL fader
should be used with care as it can cause clipping or sub-optimal signal-to-noise ratio. Global EQ settings apply to
all instances of the analog signal, including the balanced jacks, unbalanced jacks, and headphones jack, but NOT
signals routed to USB or digital outs.

GLOBAL SETTINGS: CUSTOM SCALES PAGE

The Scales page is used to configure scales for the Custom Shifter type in the Pitch block.

See "The Fractal Audio Blocks Guide" for more on this effect.

Scales can also be edited, exported, and imported in the Setup area of FM9-Edit.

PARAMETER Description

Custom Scale Number Selects from among the 32 global custom scales available to edit using the 12
1-32 parameters which follow.

__SHIFT (+/- 24) These 12 parameters are used to set the shift amount for each of the 12 steps

of the chromatic scale. Range is +/-24 semitones (+/- two octaves). To set up
a custom scale, select its number in the field above and then set each of the
12 pitch values as desired. Changes take effect immediately, with no need to
STORE. Soft-buttons provide options to reset a selected value or all values in
the current scale to the default value of +/- 0 semitones.
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THE I/0 MENU

& Reminder: You do not need to store settings in the SETUP menu. EXIT twice when finished.

1/0: INPUT PAGE

The Input page of the I/0 menu contains three parameters that scale the input to the A/D converters:
Input 1/Instrument Level, Input 2 Level, and Input 3 Level.

Remember that, except at very low settings (5% or less), input level adjustments do not affect gain levels or what
you hear. This is because as you adjust the level to the input of the A/D converter, the output of the converter
compensates accordingly, so your guitar signal level remains exactly the same when it reaches the grid and any

virtual amps or effects.

The global Input 1 Gain control adjusts the gain globally for In 1/Instrument. Use this, for example, to
compensate for a lower output guitar. This adjustment happens prior to the IN 1 Gate. The default is 1.000.

1/0: AUDIO PAGE

PARAMETER Description

Word Clock This selects the clock source for the A/D and D/A converters as follows:
INTERNAL “INTERNAL’: uses the internal clock.

SPDIF IN

Digital Input Source

SPDIF Out Source
Output 1 or 2, Input 1, USB 7/8
USB 7,8 Record Source

Input 2, Input 3
USB Output Mapping

USB Buffer Size
8-256

Input Source (1, 2, 3)

ANALOG, DIGITAL

Input 2 Mode
Input 3 Mode

STEREO
LEFT ONLY
RIGHT ONLY
SUM L+R

“SPDIF IN": uses the clock from the current digital input. A valid 48 kHz data
stream must be present at the SPDIF input for the FM9 to operate properly.

Sets the digital input signal to SPDIF, or USB Channels 5/6.
See "Input Source" parameters, below, for more on this.

This allows you to specify which signal should be transmitted at the SPDIF
digital output. Options include Output 1, Output 2, Input 1 or USB 7,8.

See "Digital Output Sources” on p. 117 for details.

This determines whether USB 7,8 inputs of the host will record the signal from
FM9 Input 2 or Input 3.

Determines whether the first two pairs of computer USB audio playback
outputs are mapped to Out 1 L+R and Out 2 L+R (in that order) or vice versa.

Set this to lower values for less latency with USB Audio, set to higher values
if you are experiencing distorted audio. Stop USB audio streaming when
changing this value so as to allow the buffer to reset properly. Streaming
can be stopped by closing the application sending data to the FM9 or by
disconnecting the USB cable.

These three settings determine whether each input grid block is fed by the
corresponding analog input jacks, or by the current digital input source (see
above). See "Digital Qutput Sources" on p. 117 for details.

These settings determines globally how the FM9 handles signals received at
the Input 2 or Input 3 jacks, determining whether they should be processed in
stereo or mono—and, if mono, how. The outputs of a connected device and the
nature of the source material will determine which setting is best.

It is important that you choose the setting which corresponds to your actual
physical connections. Setting an input to “STEREQ” and then not connecting
one of the two jacks will result in reduced levels.
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PARAMETER Description

Output 1 Mode These parameters determine how signals at the corresponding outputs will
Output 2 Mode be processed. This control makes it easy to use the same presets in a variety
Output 3 Mode of stereo and mono performance or recording environments. The decision
STEREO between the mono options “SUM L+R" or “COPY L>R” should be based on the
SUM L+R source material.

COPY L>R See "Mono vs. Stereo” on p. 6 for more information on these options.

Output 1 Level
Output 2 Level

-10dBV
+4 dBu

Output 1 Phase
Output 2 Phase
Output 3 Phase

NORMAL, INVERT
Output 3 Boost/Pad

0,6,12,0r 18dB

Output 2 | Copy Output 1

OFF/ON

Output 3 | Copy Input 1

OFF, ON

USB Audio goes directly to the converters and is NOT affected by this setting.
These parameters set the nominal levels of their respective outputs.

Use “-10 dBV" for consumer-grade equipment including many guitar products.
Use “+4 dBu“ with professional audio equipment.

The product manual for your connected device should indicate whether it
operates at +4 dBu or -10 dBV (Default). (Some devices are switchable.)

USB Audio levels are affected by this setting.

These parameters determine whether signal at the corresponding outputs
will be normal or phase-inverted. This lets you compensate for unwanted
inversions elsewhere in the signal chain.

This engages a boost/pad combination which can help lower the noise floor
of Output 3. This can be useful when connecting to a "gainy" tube amp or
modeler, where even a low noise floor can be greatly amplified.

Boost/Pad helps optimize D/A performance without affecting levels, since a
boost at the converter’s input is paired with a corresponding cut at its output.
Be watchful, however, as boosting makes it easier to clip the converters.
Watch the meters and if clipping occurs, reduce levels within your preset or
turn this setting down.

Enabling this option creates a copy of the Output 1 signal at Output 2. Use this
for the convenience of having an extra copy of the Output 1 mix with separate
front panel level control—without the need to insert an additional output block.

This setting does NOT copy USB audio, and only works when the Output 2
block is NOT present on the grid for the current preset!

Enabling this option creates a copy of the Input 1 signal at Output 3. Use this
for the convenience of having an extra copy of Input 1 or to create an analog
DI. This setting only works when the Output 3 block is NOT present on the grid
for the current preset.
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1/0: USB PAGE

The USB page of the I/0 menu contains parameters to adjust the levels of USB inputs.

USB 1/2, 3/4, 5/6, 7/8 - These parameters adjust USB playback levels from -40 to +20 dB. Normally you would
set computer audio playback levels in the computer, but these controls are handy when you need a boost or cut.

SPDIF - This scales levels at the SPDIF input.

1/0: PEDAL PAGE

The Pedal page of the I/0 menu contains parameters to set up expression pedals or switches at the Pedal jacks
on the rear panel of the FM9. Expression pedals should have a linear resistance taper and max resistance of
10kQ to 100kQ. Fractal Audio Systems EV-1 and EV-2 expression pedals are recommended. An external switch
can also be used, as long as its contacts make and break the connection between tip and sleeve. A regular 1/4"
guitar cable can be used with switches. Expression pedals must be used with Tip-Ring-Sleeve (TRS) cables. See

"Expression Pedals" on p. 10 for more.

PARAMETER Description
Pedal # Type Set this according to whether you are connecting an expression pedal or an
EXPRESSION external footswitch.
SWITCH
Calibrate PEDAL # Calibrate expression pedals connected to an onboard Pedal jack.
First select this menu choice, then:
» Press ENTER.
» Move the pedal through its full range of motion several times.
» Press ENTER again when finished.
Switches, unlike pedals, do not need to be calibrated.
Switch Polarity Match the setting for any switch to the type of switch connected.

OPEN (Momentary Make)
CLOSED (Momentary Break)

Switch Behavior
FOLLOW HARDWARE
VIRTUAL TOGGLE

This determines how a connected switch interacts with the FM9.
Use the "virtual toggle" setting to cause a connected momentary switch to
behave like a latching/toggle switch. See also "External Switches" onp. 12
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THE MIDI/REMOTE MENU

The MIDI/Remote menu contains global MIDI-related settings, and allows you to make assignments for Global
Controller functions including Block Bypass, Block Channels, Looper, External Controllers, and more.

& Reminder: You do not need to store settings in the SETUP menu. EXIT twice when finished.

LEARN MODE

The MIDI Remote menu features a hidden Learn Mode function for controller assignments. Rather than using the
knobs to assign a pedal, switch, or MIDI CC, you can use Learn Mode. This is quick and also potentially saves you from
needing to know which MIDI CC is assigned to a button or pedal on a remote device. Here's how it works:

Navigate to the entry you want to assign: for example, "External Control 1" or "Tempo Tap".
1. Press ENTER to activate Learn Mode.

2. Move the remote pedal, knob, switch, etc. so Learn Mode can detect its activity.

3. The controller will be assigned automatically to your function.
If not, try again, troubleshooting the remote device as necesary, or press Exit to cancel.

MIDI/REMOTE: GENERAL PAGE

PARAMETER Description

MIDI Channel Sets the channel on which the FM9 will receive MIDI messages.

1-16, OMNI OMNI” causes the unit to respond to incoming messages on any channel.

MIDI Thru This enables or disables MIDI thru, which causes messages received at

Off, On the 5-pin MIDI In port to be merged with any internally generated MIDI and
forwarded to the MIDI Out/Thru port.

Display Offset (Also appears in the Global menu) Causes presets numbers to begin at 001

0.1 instead of 000. This only offsets the display, meaning that it does not change

Scene Revert
ON/OFF

Effect Bypass Mode
VALUE/TOGGLE

Send Realtime Sysex

which preset is actually loaded by a given footswitch or MIDI message.

Selects between two different ways for scenes to work when you change them
via a Footswitch or MIDI:

“OFF" (Default): Scene edits are RETAINED across Scene changes as long as
you do not change PRESETS. So if you tweak Scene 1, switch to Scene 2, then
switch back to Scene 1, your tweaks will still be intact.

“ON”": Scene edits are LOST if you change the Scene without saving. So if you
tweak Scene 1, switch to Scene 2, then back to Scene 1, Scene 1 will have
reverted to its previously saved state. This makes Scene changes feel more like
traditional preset changes.

See also "Scene Revert" on p. 55

This setting determines how MIDI messages set the Bypass State of a block.
When set to “Value” the bypass state is controlled by the CC value (0-63=0FF,
64-127=0N). When set to “Toggle” the bypass state toggles whenever the CC
message is received, regardless of the value (0-127).

Causes the FM9 to transmit MIDI messages for Tap Tempo and Tuner so a 3rd
party MIDI controller can display this information.
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PARAMETER

Description

Program Change

ON/OFF
Ignore Redundant PC

ON/OFF

Send MIDI PC

1-16
OMN|
OFF

MIDI PC Offset

PC Mapping

INITIAL VALUE:
External Control 1-16

Determines whether the FM9 will process or ignore incoming MIDI Program
Change messages.

This setting determines whether the FM9 should ignore an incoming PC
message that would reload the current preset. With this setting “OFF”, a preset
will be reloaded and all changes discarded. This allows you, for instance, to
load a preset, use various “Instant Access” switches to bypass effects, and
then reload the preset to have it revert to its saved state. With this setting “ON”,
redundant PC messages are ignored. When PC mapping is used, if the current
Scene has changed, the preset will not reload but the Scene will still change
back to the scene that is set in the map.

Determines whether or not the FM9 will automatically transmit a MIDI Program
Change message at its MIDI OUT port when a new preset is loaded.

This is the easiest way for most people to operate a single connected MIDI
device while changing presets on the FM9. Any custom MIDI mapping is left to
the downstream device. To use this feature you simply select which channel
you want the message to be transmitted on. The “OMNI” setting transmits the
message on all channels.

Adds a specified value to all incoming MIDI Program Change requests before
they are processed. This makes it possible, for instance, to address alternate
presets in different “registers.” You might use the same MIDI messages to
access presets 1-16 for a gig with one guitar, and —by specifying an offset
of +16— use presets 17-32 for a different guitar without reprogramming your
controller.

PC Mapping determines whether incoming MIDI Program Change messages
load presets 1-for-1, or load other presets and scenes instead. With PC
Mapping turned “OFF”", presets are loaded 1:1 based on incoming MIDI bank
Select and Program Change messages. With custom PC Mapping enabled,
incoming Program Change messages are remapped according to the values in
the table on the Custom page of the MIDI/Remote menu (see below).

These sixteen parameters specify the initial value to be used for each of the

16 External Controllers (p.69) when the FM9 is powered on. This value

persists until data is received from the MIDI controller. This is especially useful
when an external MIDI controller is absent. For example, if you normally use an
expression pedal to control the volume in your presets, a missing pedal might
make the preset get “stuck” in a muted position. Setting an initial value of 100%
for the External Controller mapped to that pedal would ensure that when the
pedal is not connected, the volume will stay at 100% instead of 0%. This setting
is only for controllers with a MIDI CC# assignment. It does not apply to local or
FC pedals or switches.
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MIDI/REMOTE: MAPPING PAGE

With PC Mapping(previous page) set to ENABLED, incoming Program Change messages are remapped according
to the values in the table in this section.

PARAMETER Description
Map to Preset When PC Mapping is turned “ON", the parameters in this table specify which
Map to Scene preset and scene are loaded for each incoming MIDI PC message.

See also "Program Change Mapping" on p. 53

MIDI/REMOTE: BYPASS PAGE

The Bypass page of the MIDI menu allows you to map MIDI CC messages—or connected pedals and switches—
to bypass or engage blocks. CC messages can be sent by a MIDI controller or computer connected to the MIDI
IN jack. Each of these settings is global. In every case, the method for mapping a controller to one of these
functions is the same:

1. Use the NAV knob to select the desired function.
2. Use the VALUE knob to assign a controller to the function:

Select "NONE" to remove all assignments from the selected item.

PEDAL 1, 2, 3 - for an expression pedal or a switch connected at the corresponding jack.

FC__ PEDAL 1-4 to assign a pedal connected to the corresponding pedal jack of the designated FC controller.
FC__SW 1-4 to assign a switch connected to the corresponding switch jack of the designated FC controller.
1-127 to assign a MIDI CC#.

MIDI/REMOTE: CHANNEL PAGE

The Channel page works exactly like the Bypass page except the entries are used to set the Channel of each
block instead of its bypass state. The value of the CC message sets the channel as follows:

0 =ChannelA 1=ChannelB 2=ChannelC 3 =ChannelD

The series continues, repeating A, B, C, D for values up to 127 (D).
For additional information, see "Selecting Scenes & Channels While Playing" on p. 52

MIDI/REMOTE: EXTERNAL PAGE

Controller assignments for the sixteen External Controllers used in Modifiers (See Section 9: Modifiers).

MIDI/REMOTE: LOOPER PAGE

Controller assignments for the functions of the Looper.
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MIDI/REMOTE: OTHER PAGE

Controller assignments for various other functions of the FM9.

PARAMETER Description

Tempo Tap Provides the ability to tap the tempo using an external controller.
Learn more in Section 11: Tempo.

Tuner Use this to remotely enter or exit the Tuner. See Section 12: Tuner.

Tuner on Heel Down

Preset Inc/Dec
Preset Inc/Dec Start/Stop

Scene Select

Scene Increment
Scene Decrement

Input 1,2,3 Volume
Output 1,2,3 Volume

Output 1 Volume Increment,
Output 1 Volume Decrement,
Output 2 Volume Increment,
Output 2 Volume Decrement

This causes a controller such as an expression pedal to automatically display the
tuner when the value of the controller is less than 5%. This allows the tuner to be
activated, for example, whenever a volume pedal is pulled all the way back.

These allow you to step up or down through a sequence of presets with pre-
defined start and end points. Preset mapping and offsets are ignored.

Don't confuse this with the Preset Inc/Dec function of the FM9's onboard
footswitches. This setting is used only for changing presets via MIDI.

This assigns a controller for the selection of specific Scenes. The controller value
(NOT the CC number) determines which Scene is loaded:

2 =Scene 3 4 =Scene 5 6 = Scene 7
3 =Scene 4 5 =Scene 6 7 =Scene 8

The series continues, cycling through scenes 1-8 for values up to 127 (Scene 8).

For more, see "Selecting Scenes & Channels While Playing” on p. 52
The Scene Increment and Decrement functions allow you to step up or down
through scenes. These functions are triggered by CC data values above 63.

These parameters allow you to globally control the levels of the corresponding
Input or Output blocks.

These options provide a convenient way to permanently increase or decrease the
MAIN output volume for the Out 1 or Out 2 Blocks in the currently loaded preset.
Each time Volume Increment is triggered, the MAIN is increased by 1.0 dB and
the preset is saved. This is the same for Volume Decrement, except it decreases
volume.

0 = Scene 1
1 =Scene 2

A IMPORTANT! Any unsaved changes such as altered effect parameters or
bypass states will also be stored when either of these functions is triggered!

&These functions are designed for use with momentary footswitches set up to
send a CC# value of 127 for “ON” and 0 for “OFF." Do not use an expression pedal
or you may change levels +/-20 dB with a single sweep!

—
o
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THE UTILITIES MENU

UTILITIES: DISPLAY PAGE

Provides a slider to adjust contrast/viewing angle for the built-in LCD display.

UTILITIES: ADC LEVELS PAGE

Shows Analog-to-Digital Converter levels for the front panel Level knobs and rear panel Expression jacks for
troubleshooting. You can set the output level here at an exact percentage. The internal temperatures are also
displayed.

UTILITIES: RESET PAGE

This page provides a tool to set parameters in the SETUP menu back to factory default values.

Reset system parameters is one of the first steps of troubleshooting. It never deletes or modifies your presets but
it DOES clear all footswitch layouts. You will be prompted to press ENTER to confirm.

Be very careful with this option. Resetting system parameters is irreversible!

A utility provides the ability to Clear all Presets. You will be prompted to press ENTER to confirm.

Be very careful with this option. Erasing presets is irreversible!

A utility provides the ability to Clear all User Cabs. You will be prompted to press ENTER to confirm.

Be very careful with this option. Erasing cabs is irreversible!

UTILITIES: USB

Two meters show USB buffer levels, used for troubleshooting.

UTILITIES: VERSION PAGE

This page indicates which firmware version the FM9 is running.

USB firmware version is also shown.

—
—
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This page is left blank to preserve
facing in the printed manual.

—
NS
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14 ADDITIONAL TOPICS
FRACTAL-BOT

Fractal-Bot is required for Updating Firmware (p. 104) and can also be used for
Backing up and Restoring sounds and settings (below), Transmitting Presets, and
Installing User Cabs (p. 108). FM9-Edit also covers these latter functions.

Fractal-Bot is self-explanatory and has instructions built in.

Windows users will need to install a driver to enable USB communications.
The Windows driver is available at https:/www.fractalaudio.com/FM9-downloads/

Computers running 0S X do not require a driver.

Fractal-Bot is built in to FM9 Edit: https://www.fractalaudio.com/fm9-edit
A standalone version is also available on our web site at https://www.fractalaudio.com/fractal-bot

BACKING UP & RESTORING

It is strongly recommended that you back up your FM9 regularly. Fractal-Bot makes it very easy to do this.

BACKING UP

Fractal-Bot automates the backup process. Select the RECEIVE tab and follow the built-in instructions. Here are
some things to consider when using Fractal-Bot:

» The FM9 itself doesn’'t make a clear distinction, but its Presets are actually divided into banks of 128.
To backup all of your presets, backup all of the banks: A (0-127), B (128-255), C (265-383) and D (384-511).

» A backup of the SYSTEM includes all of the custom settings in the SETUP menu:
FC Controllers, Global, 1/0, MIDI/Remote, and Tuner settings.

» User Cabs are backed up in one bank.

» In Fractal-Bot, you will need to specify a location for the backup files. It is wise to prepare this in
advance. We recommend a consistent naming system for backup folders: “yymmdd - FM9” (two
digit year, two digit month, two digit day). In addition to the backup files, a text file stating which
firmware version was installed when the backups were created can be helpful in case you forget.

RESTORING

Fractal-Bot is also used to restore backup files to your FM9. The process is less automated but still very easy.
Simply send each of the files from your backup set one by one. When the first file completes, send the next file,
and so on, until all files have been sent. Remember to reboot the FM9 after the System file has been sent to it.
(Fractal-Bot will remind you.)

You can use the same process to install presets or cab files you download.

MIDI

On the FM9, backing up is not supported over 5-pin MIDI. You can try to restore files to the unit this way, but
because the transfer rate is so slow, this can take a long time and is not recommended.
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FIRMWARE UPDATES

Fractal Audio Systems products are upgradeable, and we use this capability to deliver continual improvements.
Our highly anticipated updates add new amps, cabs, effects, features, fixes, and more. We recommend keeping
the firmware in your FM9 up to date as new versions are released. Firmware is technically software — the
“operating system” of your FM9 — tracked using version numbers: 1.00, 1.01, 2.00, etc. Every FM9 is shipped from
the factory with the latest version installed. You can check your version any time by pressing the SETUP button
(Push-knob E) on the Home page. The version is displayed at the top left of the SETUP menu.

UPDATING

Updating is safe, easy, and quick with Fractal-Bot (see previous page). Use the version built in to FM9-Edit or quit
FM9-Edit before using Fractal-Bot standalone. Quit any other applications which might interfere, including any
DAW software or audio/MIDI applications.

1. Download the latest firmware from https:/www.fractalaudio.com/FM9-downloads/

2. Unzip the download file. The archive may contain various documents in addition to the actual firmware—a
MIDI System Exclusive or “SysEx” file. Unzip the .syx file where you can easily find it (Desktop? Downloads?).
Do not double-click the .syx file. Fractal-Bot will prompt when it is needed.

3. Read the Release Notes included with the firmware download. They'll et you know what’s new and alert you
to anything you may need to be know before updating to the new version.

4. Before performing a major firmware update, it is recommended to back up your FM9 (see previous page).
5. Launch Fractal-Bot and proceed through the self-explanatory steps.

6. Firmware updates will occasionally be accompanied by new versions of the FM9 Factory Presets. These will
be available on our web site support page and can also be installed using Fractal-Bot.

FIRMWARE Q&A

Q: How do | know the upgrade worked?

A: Check your firmware version anytime by pressing the SETUP button (Push-knob E)
on the Home page. The version is displayed at the top of the SETUP menu.

Q

Can | skip versions to go from a very old firmware version to a much newer one?

A: Yes, you can upgrade from any version to any other version. When you skip versions it is recommended that
you also read the Release Notes for all interim versions, all of which are included with every firmware release.

Q

Will updating my firmware erase, modify or upgrade my presets?

A: Firmware updates do not erase customized presets. However, firmware updates may
alter the sound of existing presets. Always read Release Notes before updating.

= Saving presets after a firmware update can render them incompatible with previous versions
= We sometimes also update the factory presets. These are released as a separate update on our web site .
The firmware update failed mysteriously. What should | do?

A: If the FM9 still boots normally, just try the update again. If successive failures occur, please delete and
re-download the update file before trying again. Trying a different USB port or cable can also solve issues.

Q

Q

After updating, my FM9 will no longer boot normally.
A: Don't worry: see “Recovery” on the next page.

—
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RECOVERY

PROBLEMS DURING/AFTER FIRMWARE UPDATE

The FM9 has a built-in recovery system known as the “Emergency Boot Loader” to protect you against mishaps
during firmware update. To boot from the emergency boot loader:

1. Power down the unit and wait five seconds.
2. Power on holding both PAGE LEFT and PAGE RIGHT buttons until the Emergency Utility page appears.
3. Update as you normally would using Fractal-Bot.

PROBLEMS WITH A SINGLE PRESET

If your FM9 will not boot normally, the problem may be just the current preset.
You can force the unit to load an empty initialized preset as follows:

1. Power down the unit and wait five seconds.
2. Power on holding HOME until the boot-up progress bar first appears.

The FM9 will boot with an empty initialized preset in location “000". You can STORE this to any other location to
overwrite a problematic preset.

PROBLEMS WITH GLOBAL SETTINGS OR PARAMETERS

It is very unlikely that System Parameters could prevent the FM9 from booting normally, but the following process
is provided to allow you to perform Reset System Parameters without using the SETUP: Reset page.

1. Power off the unit and wait five seconds.
2. Power on holding EDIT until the boot-up progress bar first appears.

You can hold both HOME and EDIT at the same time to reset the current preset and reset System
Parameters.

GETTING HELP

Our forum is a source of great advice ranging from product Q&A to tutorials and more. Fractal Audio staff
participate in the conversations, and response times can be very fast. Find it at https://forum.fractalaudio.com

Our wiki, maintained by members of the Fractal Audio community, is also an excellent resource:
https://wiki.fractalaudio.com

You can get support directly from Fractal Audio Systems at: https://support.fractalaudio.com
or internationally via our dealers listed at https://www.fractalaudio.com/international-ordering.

—
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OPTIONAL OFM9G LAYOUTS

Many who use the Fractal Audio FM3 with an FC-6 enjoy a special set of custom layouts cheekily called “OMG9”.
We created a special FM9 version of this system called “OFM9G” and it can be installed using these simple steps.

Loading OFM9G will overwrite your current footswitch layouts. If you're
using the Factory Default layouts, those can be reinstalled easily using
using SETUP: FC Controllers: Reset. If you are using customized layouts,
you can back them up by choosing “Export All Layouts” in FM9-Edit.

LAYOQUTS

AUTOMATIC INSTALLATION
On the FM9, select SETUP: FC Controllers: Reset: Load “OFMG9” Footswitch Layouts Layouts & Settings

THE BASIC IDEA

The basic idea behind the OMG9 and this FM9 version is that the footswitches are divided into two “zones.”

In OFM9G, the top three footswitches are used to change the functions of the bottom six footswitches. The
Master Layout Menu is not used: OFMG9 is entirely self-contained. Despite all of its power, it is very simple to
use. There are almost no “press and hold” functions, so there’s less to remember, and sound changes fire on the
switch “downstroke” for tight musical timing. The use of color reduces the need to read. In other words, this is a

1”

setup for those who live by the dictum, “Don’t make me think!

The basic idea is illustrated below, and individual layouts used are shown on the next page.

Press THESE three switches...

EFFECTS MODE
C Hold for LOOPER )( PRESETS MODE )

rrrrr

SCENES MODE
Hold for PER-PRESET

ENTER EXIT  <<PAGE PAGE»>

arn ame  ours 2N 172\ 17\

OO0O000 OO0
3 )

17\
7

...to change what THESE six switches do.

—
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Next Bank
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Tap “MORE" to toggle between
these FX and Comp1, TremPan 1,
Flanger 1, Pitch 1, and Rotary 1.

Reverb 1 )(«MORE»)

( Drive 1 )( Phaser 1 ;

Chorus 1 )( Delay 1 )

LOOPER MODE
O 7 =2
oooooDoDoDoD & © @

( Record )(Play/Stop

Reverse )(Erase/Undo)

; ( Once )(Half Speed) _

PER-PRESET MODE

In Per-Preset Mode, the six bottom switches are “Per-Preset Placeholders” for PP#1—PP#6 with both tap and hold.
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LOADING USER CABS

In addition to thousands of onboard cabs preloaded in its factory banks, the FM9 allows you to store up to 1,024
cab Impulse Responses (“IRs") in user memories. “User Cabs” allow you to personalize your FM9 with custom
tones. They can be transferred to the FM9 easily:

1. First, you'll need an impulse response file in SysEx format (.syx). FM9-Edit can also load .wav and .ir formats.

» Fractal Audio Systems offers various professional Cab Packs at https://shop.fractalaudio.com
These include creations by Fractal Audio as well as third-party producers.

= Axe-Change, our file sharing site, is a great resource for FREE cabs. https://axechange.fractalaudio.com
2. Using Fractal-Bot or FM9-Edit, transmit the file to your FM9.

= Fractal-Bot - This basic utility can send individual SysEx files or entire Cab Banks. To transmit a file
IR, Launch Fractal-Bot and make sure the FM9 is the selected device. Then Browse to the file and click
“Begin”. For single IRs, Cab-Lab will ask you to select a User location by its number.

= FM9-Edit - The easiest way to import a single IR is to click the Cab block, select a user location, and then
drag and drop your cab file to the name field (the green “<empty>" text or the green or violet name of an
existing User Cab if you want to overwrite one).

= FM9-Edit also has a tool called Manage Cabs. This allows you to drag and drop user cab files one at a time
or in bulk to numbered memory slots. You can also manage entries already in the memory of the FM9 with
operations like copy, paste, rename, and drag-and-drop reordering. When you purchase a Cab Pack, this is
the best and easiest way to load multiple IRs at once into your FM9, audition the results, and organize your
favorites. When you finish importing or rearranging, press the “Save” button to commit your changes.

3. To select a user cab, click the Cab block in FM9-Edit and use the “Picker” to select it. You can also load User
IRs from the front panel of the FM9 by selecting the Cab block on the grid, pressing EDIT, changing to the
“Cabs” menu page, selecting the User bank and choosing the desired IR.

NOTE: In comparison to older Fractal Audio systems products, user cabs are NOT included in a backup of the
SYSTEM area of the FM9. This also means that restoring a System backup will never overwrite user cabs.

Cab-Lab is a full-featured 8-channel
IR mixer and toolbox in standalone
and plug-in formats.

For decades, artists, producers
and engineers have created tones
using a mixer to blend the sounds
of different mics or speakers.
While the FM9 provides two mixer
slots, Cab-Lab has EIGHT, and has
additional options and tools, with
the ability to export Cab files and
save mix sessions.

Learn more at:
www.fractalaudio.com/cab-lab-3
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AXE-CHANGE

Axe-Change is the official source for sharing or downloading shared Preset and Cab files for Fractal Audio
Systems products. You can upload your own FM9 presets or browse what others have contributed including some
high profile artists. Axe-Change is also a great source for free Cabs!

Find Axe-Change at https://axechange.fractalaudio.com

AXE-CHANGE

MIAARD DOFSEETE ©

POPULAR DOWNLOADS
—— v e '
B o s "l A Fambu

= ity O Bete Fulifia Exciiery

- S [resepese
Parmbey
Famee
oy
LR e
8 SF
Les ]
PFavmbery

Excimiey

mFa i

ARTIST LUPLOADS

WISIT THE FRACTAL FOSHIM



https://axechange.fractalaudio.com

14 ADDITIONAL TOPICS

SETLISTS & SONGS

INTRODUCTION

Firmware 3.0 added this exciting new feature to the FM9. In the world of musical performance, a “Setlist” is a list
of songs to be performed in order. A setlist creates the structure for a show, letting you plan ahead how to start
strong, avoid lulls, and finish memorably. A setlist also helps band members (and crew/techs) to be ready instead
of asking questions or struggling with settings on the fly. A short “singer/songwriter” Setlist might contain 4
songs. A typical modern rock/pop concert setlist might have from 12-25 entries. A working cover band might play
four different sets covering a total of 100+ songs.

The Fractal Audio Setlist/Song feature provides a way to prepare an ordered Setlist of named Songs. FC
footswitches can then change songs in order and present the various sounds needed for their named Song
Sections (intro, verse, solo, etc.). Song footswitches allow you to select songs. Section footswitches load
sections from the current song. Setlist footswitches allow you to change the “Active Setlist”.

Like FC Layouts, Setlists and Songs can be edited through the front panel of your product, or in its editor software,
which also includes convenient utilities for import, export, and more.

The Setlists/Songs feature requires an FM9 firmware 3.0 or newer.

CREATING SONGS & SETLISTS

The Setlists/Songs feature can be accessed through a new area of the global SETUP menu called FC Setlists/
Songs. To use this feature, you must first create one or more Songs, then add them to a Setlist in the desired
order. Assign FC Switches to any FC layout to access the various Sections of the current Song.

NOTE: Setlists, Songs and Sections are like other areas of “Setup” in that all changes take effect immediately and
they do not need to be stored. They are also included in a Fractal-Bot “System” backup.

SONGS & SECTIONS

= Each song has a number, a name (10 chars) and contains six numbered Sections.

= Each section has a number, a name (10 chars), and a designation
of one Preset and one Scene (1-8 or DEFAULT

= Up to 128 songs can be created in total.

For Example, imagine Song 1, named “I Want”

» Section 1: named “Intro” loads Preset 1, Scene 1

» Section 2: named “Verse” loads Preset 1, Scene 2

» Section 3: named “B-Section” loads Preset 3, Scene 1

» Section 4: named “Chorus” loads Preset 510, “Default Scene”

» Section 5: named “Solo” loads Preset 1022, Scene 6

» Section 6: is not used in this song. Its “Preset” is “NONE", which disables the section.

—
—
o



14 ADDITIONAL TOPICS

TO CREATE A SONG:

Creating a song is easy: enter a name and define up to six sections:

4
4

Open SETUP: FC Setlists/Songs and page right to “Songs”.

Navigate to any Song and press NAME SONG (push knob C). Enter a name using
controls that work identically to those for presets and scenes.

Next, press Enter or EDIT SONG (push knob B). Define each of up to six Sections by using
the controls to enter a PRESET number, a SCENE number, and a section NAME.

Press Exit when finished to return to the master Songs list.

SETLISTS/SONGS Setlists

SONG 1 All | Want
SONG 2 Astray
SONG 3 So Blind
SONG 4 Astray
SONG 5 Back 2 Zero
SONG 6 In My Mind
SONG 7 Meters
SONG 8 In Lovew U
SONG 9 Leader
SONG 10 Play It Loud
SONG 11 Set Me Free
SONG 12 Dreaming

& Nav -- --
RESET SONG || EDIT SONG NAME SONG

Fig 1: The Songs page of the Setlists/Songs menu, aka the “Master Songs List”

EDIT SONG 1: All | Want Sections

PRESET NAME

1 Intro

1 Verse

3 DEFAULT B-Section
1 Chorus
6 Solo
DEFAULT

(> Nav Preset =
RESET SECT EXIT NAME SECTION

Fig 2: The Edit Song page of the Setlists/Songs menu, where Song Sections are created.
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ABOUT SETLISTS

Each of the four Setlists contains up to 32 songs in numbered positions. A particular song can appear more than
once in the list. Empty slots are permitted only at the end.

* Each Setlist has a number and a name (10 chars).

= The “ACTIVE!" Designation makes any one setlist “active,” determining which list of
songs will be used to populate FC footswitches. Most people will only ever use one
Setlist. Others might use different Setlists for different bands/gigs. Others might play
epic shows and need to activate different set lists as the show proceeds.

» To change the active Setlist, open SETUP/FC Setlists/Songs, and turn Knob C
to move the “ACTIVE!” marker, or use FC “Setlist” footswitches.

SETLISTS/SONGS

Setlists  Songs

SETLIST 1 Active Set!
SETLIST 2
SETLIST 3

SETLIST 4

Bar Gig
Church Gig
Jamming
Setlist 04

(> Nav -
RESET SET EDIT SET

Active Set
NAME SETLIST

Fig 3: The Setlists page of the Setlists/Songs menu, where you can access setlists for editing or change the Active Setlist.

EDIT SET 1: SET NAME

SLOT1 001: | Want
SLOT 2 022: Last Time
SLOT 3 014: You Gave
SLOT 4 002: Astray
SLOT S5 009: Leader
SLOT 6 016: Rewind
SLOT 7 027: Rust

SLOT 8 067: On the Run
SLOT 9 005: Back 2 Zero

SLOT 10
SLOT 11
SLOT 12

(> Nav

0le:
089:
090:

Select Song
EDIT SONG

Dreaming
Shine
Madrigal

Move Song
INSERT

DELETE

Fig 4: The Edit Setlist page of the Setlists/Songs menu allows you to easily insert, remove, or re-order the songs in a Setlist.
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FC SETLIST/SONG FUNCTIONS

The Setlist/Song feature uses three new categories of FC footswitch functions: SETLIST, SONG, and SECTION. Each
function has one or more self-explanatory parameters, plus various options for the FC footswitch “Mini-Display”.
These are fully detailed in the Fractal Audio Footswitch Functions Guide, but a short overview follows.

SETLIST FUNCTIONS

Three “SETLIST” functions change the Active Setlist:

=  SETLIST: SELECT : This makes the designated Setlist “Active” by its number, 1-4.

= SETLIST: TOGGLE : This toggles between two setlists, making them “Active”.

= SETLIST: INC/DEC. : This incrementally steps through the Setlists to select one as Active.

* You can also change the Active Setlist on the Setlists page of SETUP: FC Setlists/Songs, or in Axe-/FM9-Edit.

SONG FUNCTIONS

Three “SONG” functions load Songs based on their numbered positions within the Active Setlist.

= SONG: SELECT IN SET : This loads a song by its numbered position (1-32) in the Active Setlist.

= SONG: TOGGLE IN SET : This toggles between two songs by their numbered positions in the Active Setlist.

= SONG: INC/DEC IN SET : This incrementally steps forward or backward through all of the
non-empty songs in the Active Setlist. (Empty songs are skipped automatically, and any
empty songs at the beginning or end of the list are skipped when the list “wraps.”)

SECTION FUNCTIONS

Three “SECTION” functions load sections from the current song. Whenever a Song Section is loaded, the main
display of the FC changes to show the name of the current song, and the name of the current section.

Three functions select songs from within the current Active Setlist.
= SONG SECTION: SELECT : This loads a Section by its number in the current Song.
= SONG SECTION: TOGGLE : This toggles between two Sections of the current Song.

= SONG SECTION: INC/DEC : This incrementally steps forward or backward through all of the
Sections in the current Song. (Empty Sections are skipped automatically, and any empty
Sections at the beginning or end of the list are skipped when the list “wraps.”)

—
—
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PERFORMANCE CONTROL PAGES

INTRODUCTION

The FM9 is easy to edit with its intuitive system of menu pages and parameters, but you can't really do this mid-
performance. Musicians sometimes do adjust their equipment while playing, however (during a break or even mid-
song). Traditional analog gear is very accommodating: amp knobs are at arm’s length, and you can easily reach
down and tweak a pedalboard effect.

The Performance control pages of the FM9 are designed for exactly this kind of easy, direct adjustment
without menu-diving. Each of the two Performance Control Pages (aka “Perform Pages”) hosts ten controls
of your choice. The FM9s five “ABCDE" knobs provide instant access to five parameters, with a second five
just one button tap away. 5 knobs x 2 rows x 2 pages = twenty controls in all! You can even add custom labels.
Performance Control pages stay conveniently “parked” on the screen when you change presets or scenes,
creating an experience just like what you get with dedicated hardware controls.

The Global Performance Control Page (Perform-Gbl) stays the same even when you change presets. Factory
default settings show basic amp controls here: Bass, Mid, Treble, Depth, Presence, Drive, Master and Level.

The Per-Preset Performance Control Page (Perform-PP) uses assignments stored in the current preset. One
preset might show Drive pedal controls, while a different preset shows various effect Mix controls. It's totally up
to you. Most Factory Presets already have “Perf-PP" assignments for you to explore and try.

DISPLAYING A PERFORMANCE PAGE

Displaying a Performance page is easy: just press Home followed by Page Right to the Per-Preset or Global
perform page. These pages stay “parked” on the screen until you manually change to another page, so you can
change presets or scenes and still have your custom Performance Control options ready to use.

In summary, Performance Control pages provide an easy and intuitive way to interact with your FM9 just as you
would with traditional analog gear.

ADJUSTING PERFORMANCE CONTROLS

Using these controls is easy. They behave exactly like the knobs, switches and selectors of the normal edit pages.
While displaying a Performance Page, just use the A,B,C,D or E knobs or NAV and VALUE to make changes. Use
the NAV up or down keys to change rows.

A performance control is a stand-in or “alias” for the same control in its usual place. For example, adjusting Amp
Level on the global performance control page is the same as adjusting Amp Level wherever else it may be found
in the edit menu of the amp block. If you change on a Performance control and then store the preset, the change
is saved.

—
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TUTORIAL: HOW TO SET UP PERFORMANCE CONTROLS

Performance Controls must be set up using FM9-Edit, the companion editor/librarian software for the FM9.
The following tutorial includes multiple examples.

1. First, let’s edit the Global Performance page. To display it, tap Home, then tap Page Right twice. Notice that
the factory default settings place the basic knobs of the AMP block here: Bass, Mid, Treble, Presence, Depth,
Drive, Master Volume, Level. There are also two empty spots. We'll fill one of them here with the Delay Mix
control so you can quickly adjust delay levels when you play.

2. Connect your FM9 over USB to a compatible Mac or Windows computer and Launch FM9-Edit (see p. 13).
(Remember, you will need a driver if you are running Windows. See Section 3: USB).

In FM9 Edit, load Factory Preset 001 or any preset that contains the Delay 1 block.
Once this preset loads, click on the delay block to select it in the grid.

Switch to the Performance Page editor in FM9 Edit by clicking the Perform button above the grid.

o g~ W

Drag and Drop the Mix parameter of the delay block to an empty slot in the Global Performance Controls
area.

7. You can exit the Perform Page editor now by clicking again on the Perform button above the grid

NOTE: Since we've only changed a Global Performance Control, there is no need to store anything.
In comparison, when you edit the Per-Preset Performance page you must save the preset to commit changes.

8. Let's add Reverb Mix to the remaining empty slot on the Perform-Gbl page. We must first change to the
reverb block to drag-and-drop from its edit menu. Of course we could mometarily return to the grid, but there’s
a way to change the current block without doing this. A dropdown menu in FM9-Edit lists every block in the
current preset. Find it left of the large block icon in the lower panel of FM9-Edit (shown at right, highlighted
in green). Select Reverb 1 from this list and then drag its Mix parameter to the
Performance Page editor as you did with the Delay Mix.

9. You can also use drag-and-drop to rearrange controls on performance pages. Drag one
control onto another to swap them. Try this out on the Reverb Mix and Delay controls.
Decide how you like this and then move on.

TIP: To remove a control, click it and then press Delete/Backspace on your keyboard.

10. You can change the two line label for any control by double-clicking on the existing
name. Type your desired text and then press Enter/Return on your keyboard to confirm.
Test this by changing the first line of the delay control to “DELAY” instead of “DLY1".

You have reached the end of this tutorial. Test your changes on the FM9.

—
—
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DIGITAL INPUT SOURCES

The FM9 allows incoming digital signals from SPDIF or USB 5/6 playback to be routed to your choice of input
blocks 1, 2 and/or 3 on the Layout grid. This supports a range of applications such as digital reamping, digital
send and return, and processing of digital sources.

Each FM9 input has a corresponding Input Source parameter found in the INPUT CONFIGURATION section of
SETUP: 1/0: Audio. Set a source to “ANALOG" if you want the corresponding grid block to utilize signal from the
analog input jacks. Set a source to “DIGITAL" for digital input, and then set the global Digital Input Source to your
choice of “SPDIF” or “USB 5/6". Multiple inputs can be set to use the same digital source at the same time. All
inputs default to ANALOG. The diagram below illustrates these options.

A fourth grid input block, “IN USB" always uses USB 7/8 as its source. Additional USB input options are detailed
in Section 3: USB

ﬂ Optimal performance of multiple digital devices requires synchronized clocks. See the FAQ on the next page.

, :

Analog Digital
o
o .N
Input 1 Source

( )
— @)
m ( SPDIF  USB5/6
(@) (@)

Analog Digital
Input 2 Source Digital Input Source

Analog Digital
@]

@
[

| Input 3 Source

USB 7/8

—
—
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DIGITAL OUTPUT SOURCES

The FM9 can produce both USB and SPDIF digital output signals. USB is detailed in Section 3: USB
The SPDIF out can transmit your choice of signals derived from Output 1, Output 2, Input 1, or USB 7,8.

OUTPUT 1 - Outputs the signal from the OUT 1 grid block. This will be the most common setting, where the SPDIF
output is used instead of or in addition to the main analog outs. This might be used when connecting the FM9 to
the SPDIF inputs of an audio interface, digital mixing console, or other device.

OUTPUT 2 - Outputs the signal from the OUT 2 grid block. Use this option when you want a digital signal that
differs from the signal at analog output 1. This might be the case when you're using a SPDIF send and return, or
when you want to use different processing options on analog and digital outs.

INPUT 1 - Outputs the signal from IN 1 instrument jack without any processing. Use this option when you want a
digital copy of the input for recording or reprocessing using a 3rd party device over SPDIF.

USB 7/8 - Outputs incoming USB 7/8 playback signals from a connected computer directly to the SPDIF Out.

FAQ ° WHAT IS SPDIF WORDCLOCK?
® |nterconnected digital devices require synchronized clocks to work correctly. Wordclock

makes this possible with the correct connections and settings on both the FM9 and the connected device.

WHEN USING THE FM9 SPDIF OUTPUT
When the SPDIF output of the FM9 is connected to the SPDIF input of another device, there are two options:

1) Use the FM9's internal clock. Set SETUP: 1/0: Audio: Word Clock to “INTERNAL". Set the connected
device to use external clock and it should lock to the 48 kHz clock of the FM9.

2) Use the clock of the connected device: Set the external device to use its own internal clock. Connect a
second SPDIF cable from the output of the second device to the SPDIF input of the FM9. On the FM9, set
SETUP: 1/0: Audio: Word Clock to “SPDIF”. A valid 48 kHz data stream must be present at the SPDIF input
for the FM9 to operate properly.

WHEN USING THE FM9 SPDIF INPUT
When the SPDIF output of another device is connected to the SPDIF input of the FM9, there are two options:

1) Use the clock of the connected device. Set the external device to use its own internal clock. On the FM9,
set SETUP: 1/0: Audio: Word Clock to “SPDIF”. A valid 48 kHz data stream must be present at the SPDIF
input for the FM9 to operate properly.

1) Use the FM9's clock. Set SETUP: 1/0: Audio: Word Clock to “INTERNAL". Connect a second SPDIF cable
from the output of the FM9 to the SPDIF input of the second device. Set the connected device to use
external clock and it should lock to the FM9's 48 kHz clock.

—
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FREQUENTLY ASKED QUESTIONS

Q:
A:

Q

2R =R

Q

» R

2R =R

Why all the technical terminology?

The language of the FM9 is for the most part the universal language of professional audio. This allows the
FM9 to be used by casual and professional players, producers, engineers, and beyond. The terminology
and concepts you will use and learn are accordingly not unique to the FM9. Understanding them will help
you to master the craft of pro audio and to communicate with others. At the same time, the FM9 is easier
than ever, with dedicated controls and a clear interface that doesn't distract or disrupt the creative flow.

What is “FRFR"?

FRFR stands for “full-range, flat response.” This acronym is used to describe a “neutral”
speaker or speaker system that is designed to reproduce the entire audible spectrum of
20 Hz - 20kHz without emphasis. Examples of FRFR systems would include high-quality
studio monitors and properly designed PA systems or monitors. Many manufacturers are
also now offering FRFR systems designed specifically for direct guitar applications.

How do | upgrade the firmware of my FM9?
Use Fractal-Bot. See p. 103.

Can | load my presets from the Axe-Fx Il or FM3 into the FM9 (or vice versa)?

Yes! Axe-Edit, FM3-Edit, and FM9 Edit are mostly cross-compatible. The FM9 will do its
best to interpret larger Axe-Fx Ill presets but you should always check the results.

= The Axe-Fx Il has a larger inventory. Any missing blocks will be replaced by shunts.

= When converting an Axe-Fx Ill preset it is possible to have more blocks than the CPU can handle. If this
happens, the FM9 will display a blinking red banner in the top-left of the HOME screen that reads “CPU
Limit - Muted”. The FM9 will stop processing audio but allow you to delete and/or reconfigure the blocks
as needed.

= Certain CAB block settings must also be considered. An Axe-Fx Ill preset that has bank USER 2 selected
will be changed to USER 1 since the FM9 has only one bank. Also note, that “Cab 3" and “Cab 4" settings
from an Axe-Fx Ill preset will NOT be imported since the FM9 allows only two IRs per Cab block.

What about presets from the Axe-Fx Il, AX8 or FX8?

No, these presets are not cross-compatible, but you can generally transfer parameter settings
by hand with good results. As of this writing, all of the same amp models are present, and
“factory” speaker cabs of the older products are present in the “Legacy” bank on the FM9.

My expression pedal isn't working. What should | do?

Expression pedals need to be calibrated and assigned to a parameter, controller or remote function. See
“Expression Pedals” on p. 10 for a basic overview. Are you using a TRS cable? Is it connected to the correct
port on the FM9? Is it actually an expression pedal? Did you set up a Modifier as described in Section 9.

My FM9 won't start up correctly.
Please see “Recovery” on p. 105.

My FM9 seems quiet at default settings.

By default, analog outputs 1 and 2 are set to -10dBV. To change to +4dBu,
use the Output Level parameters in Setup: 1/0: Audio.

—
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Can | use a computer or external MIDI controller to remote control the FM9?

The FM9 has a rich MIDI spec which allows it to be remote controlled. Any 3rd party MIDI
controller can be used, but please note that an FC-6 or FC-12 connected via FASLINK offers many
advantages over traditional 5-pin MIDI. The FM9 is also a computer USB MIDI Interface. A third-
party MIDI interface is required for a DAW or other computer application to control the FM9.

I'm hearing click and pops.

First, check all cables. You'd be surprised by how often a short can be found in a brand new or trusted cable.
Then, check to see whether you are clipping the FM9 inputs or outputs (p. 5).

Excessive CPU usage may also be to blame. Is the CPU meter at or near 80%? If so, you've overloaded the
current preset. Try removing one or more blocks and review “Preset CPU Limits” on p. 48 for useful tips.

One or more of my presets produces no sound.

This might be any one (or several) of a number of things. Is every other component in your rig working
correctly? Are the FM9’s top panel LEVEL knobs turned up? Often, problems like this turn out to be
caused by a faulty or disconnected cable. Checking the FM9 with headphones can help rule out a

lot of possibilities. Do some presets work? If so, have you double-checked to ensure that each has a
complete path from the input to the output? Does every preset begin and end with Input and Output
blocks corresponding to inputs and outputs connected to other equipment? Could the problem be the
setting in one block? Try replacing them one-by-one with shunts (save Cab and Amp for last). Is there a
Modifier assigned to a volume or level control while the pedal or external switch is not present? You may
simply need to change the INITIAL VALUE for an external controller from 0% to 100% (p._98). Does

the preset require a USER CAB which is not loaded? Try changing the Cab block to a Factory cab.

Why would | place certain effects before or after an Amp and Cab?

Sonically speaking, the main reason to care about effect placement is that a given
effect will sound different when placed before or after distortion.

How does this difference sound? If you've ever switched the sequence of traditional drive and wah pedals,
you've heard an excellent example. In the case of wah before overdrive, the resonant filter of the wah
“excites” the overdrive in a cool way while still retaining a natural overall tone. When the wah follows
distortion, you might hear a more dramatic sweep that almost sounds synth-like and might be considered
less “classic.” It's not surprising then that wah would traditionally be a run as a “pre” effect between
guitar and amp. The amp’s distortion follows the wah. Many other effects fall in this same category.

A different example is found in overdrive with reverb or delay. In the natural world, reverb and echo occur
because of open spaces around your guitar amp - like a club or concert hall. These effects would therefore
NOT be heard before a distorted amp, but after it. Recording studios often add these kinds of effects “post,’
i.e. at the console—after the mic has recorded up the distorted sound from the guitar amp. If you wanted

to simulate this natural sounding reverb or delay these effects would likely be run “post.” This is not to

say that delay or reverb before distortion is a “no-no.” Many “legendary” tones came from echo units in
front of an amp—but this is very different from “post” delay, both tonally, but also in terms of dynamics.

The good news is that the FM9 allows you to experiment easily and find what combinations
of pre- and post-effects work best for you. Creativity begins where conformity ends.

Anything else | should know?
The Layouts and Footswitches section includes its own FAQ. See “FM9 Footswitch FAQ” on p. 84

—
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SHORTCUTS

The FM9 has several shortcuts and hidden features. These are summarized below.

IN GENERAL

= Press EDIT to jump to the Edit menu for the currently selected
block. Press repeatedly to step through all blocks.

ON THE HOME PAGE
= Press ENTER or push the VALUE knob to show the Layout Grid for the current preset.
= Use NAV LEFT/RIGHT to select presets and press NAV UP/DOWN or turn knob A to select scenes.

IN THE AMP BLOCK
»  Onthe Output EQ page, press NAV UP/DOWN to change the number of bands.

IN THE CAB BLOCK
= NAV to the Cab Number field and press ENTER to enter a “Cab Picker” for the selected slot.

ON THE GRID

= With any block selected, press-and-hold ENTER to create a series of shunts and cables to bridge
empty space to the right. This will also CLEAR existing connectors between a series of blocks.

TO OPEN THE CONTROLLERS MENU
= Press the TEMPO button once.

ON THE SEQUENCER PAGE OF THE CONTROLLERS MENU

=  With any Stage selected, press ENTER to randomize the values of all stages.

—
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SPILLOVER

Spillover allows delay and reverb tails to “ring out” when an effect is bypassed or when you change channels,
scenes, or presets. This section covers how to set up spillover in different scenarios.

WHEN BYPASSING AN EFFECT...

Effect block spillover is easy and requires only a particular setting in the block. For tails to ring out when an
individual block is bypassed, set that block’s Bypass Mode to “MUTE FX IN”. If an effect is running in parallel, use
“MUTE IN" instead. Be aware that different channels share effect memory, so channel changes that affect delay
time, reverb size, etc, may cause a glitch or “sweep” in the tail. For best results, use multiple blocks.

WHEN SWITCHING SCENES...

Switching Scenes provides one of the most commonly used ways to achieve spillover. Since Scenes simply
bypass or engage blocks one-by-one or in groups, just refer to the instructions above for all blocks in your preset.

Note that this also provides a great way to get gapless amp changes: set each Amp block’s bypass mode to MUTE
and then switch between amps—one for clean, for example, and one for dirty.

WHEN CHANGING PRESETS...

Spillover across different presets is a bit more involved. The first step is to open the SETUP: Global Settings:
Config and set the Spillover parameter to determine whether “DELAY”, “REVERB", or “BOTH" will spill over when
you change presets. This setting is OFF by default.

You must then also ensure that the same Delay or Reverb blocks exist in each of your presets where you want
spillover. These need to be the same block and the same number (i.e. Delay 1 spills over only through Delay 1,
Delay 2 through Delay 2, etc.).

For spillover to work perfectly, the blocks must also have similar settings and placement on the grid. As
mentioned above regarding channel changes, using different setting such as time, size, etc. can cause glitches or
sweeps. For example, if you change from a preset where Delay 1 has a time of 500 ms to a preset where Delay 1
time is 100 ms, the tails will suddenly be heard as 100 ms echoes instead. You would also hear a difference in the
tail, for instance, if a delay were placed after a clean amp block in one preset, and before an overdriven amp block
in another. Bypass states and Bypass Mode settings must also be considered.

For a simple preset spillover experiment, create a preset, then save an exact copy to a new location and
test spillover. Then begin making changes as needed to settings outside of those blocks that you want
to spill over. FM9-Edit also makes it easy to copy and paste a block from one preset to another.

—
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SENDING AND RECEIVING MIDI

MIDI Messages are received at the MIDI In port and transmitted at the MIDI OUT/THRU port of the FM9.
Use 5-pin MIDI cables between the FM9 and the MIDI ports of other devices.

RECEIVING MIDI

The FM9 responds to MIDI Program Change Messages, MIDI CC messages — which can be used for a wide variety
of purposes including Scene Select, Effect Bypass/Engage, Modifier Control, and more.

The FM9 also synchronizes its own Tempo value to incoming MIDI beat clock signals.

The FM9 is a USB MIDI Device. It will appear as a MIDI device in a DAW or other MIDI program. You can use
automation and other MIDI messages to control the FM9.

MIDI THRU

The FM9 MIDI Qut port also features a soft “MIDI Thru” capability. This merges any data received at the MIDI In
port with any generated MIDI messages at the MIDI Out port.
This option must be enabled. See “The MIDI/Remote Menu” on p. 97 for more on this feature.

TRANSMITTING MIDI PC WHEN YOU CHANGE PRESETS

The simplest MIDI capability of the FM9 is transmitting a single MIDI program change message (“PC") each time
a new Preset is loaded—whether via the front panel, using an FC Footswitch, or in any other way. To enable this,
open the SETUP | MIDI/Remote menu and page to the “General” tab. Set Send MIDI PC to the desired channel.

TRANSMITTING MIDI PC AND/OR CC MESSAGES WITH THE MIDI BLOCK

A more sophisticated MIDI tool is the Scene MIDI Block. Once you place this block on the grid, it transmits MIDI
messages automatically whenever a new scene is loaded—whether via the front panel, with a footswitch, or by
any other means. The Scene MIDI block can transmit up to eight total custom PC or CC messages. Remember
that a “default scene” loads automatically when you select a new preset, so any FC footswitch that selects a new
Preset or a new Scene can also cause the FM9 to send a burst of MIDI messages.

See “The Fractal Audio Blocks Guide” for more on the Scene MIDI Block.

—
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TRANSMITTING MIDI WITH A CONTROL SWITCH

Another way for the FM9 to transmit MIDI messages using Control Switches. While the primary function of a
Control Switch is to operate as a Modifier source to control FM9 parameters, each of the six Control Switches
also has the capability to transmit a custom “payload” of MIDI data every time the switch is turned ON or OFF.
This isn't tied to another event such as a Preset or Scene change, so Control Switch MIDI is more flexible.

Control Switches can be momentary or latching (and even mutually exclusive), so the CS MIDI system is very
versatile. You might change a connected MIDI-controlled amp, operate a remote processor, control a sequencer,
switch a lighting system, and more.

See “The Fractal Audio Blocks Guide” for more about Control Switches. Here is a summary:
» The Control Switch function can be placed as TAP or HOLD of any switch in any FC Layout.

» Control Switches 1-6 appear in the list of Modifier sources on the FM9. The role of a switch as
a modifier source is not compromised if you also use it to transmit MIDI. The same switch can
simultaneously control the FM9 and a connected device. See Section 9: Modifiers to learn more.

» Each Control Switch has its own global MIDI Payload containing up to four Program
Change (“PC") or Control Change (“CC) messages on any MIDI Channels, with custom
values from 0-127, or disabled (“-") for both the ON and OFF states of the switch.

» Each MIDI Payload also has a “master switch” allowing it to be enabled or disabled.

SETTING UP THE MIDI PAYLOAD FOR A CONTROL SWITCH:

» Open SETUP: FC Controllers and page to the “CS MIDI” tab.

» Use NAV buttons and the VALUE wheel to get around the page.

» Select the desired control switch at the top of the menu. (CS1, CS2, etc.)
» Make sure ENABLED is set to “YES” if you want the switch to send MIDI.

» NAV through the table and create your desired MIDI Payload of up to
four commands, with different values for ON and OFF.
= For each command, select whether you want a Program Change (PC) or Control Change (CC) message.
Set the MIDI Channel for that command as desired from 1-16.
If you chose a CC Command, set the CC Number.
Set the desired Values for when the switch is ON and when it is OFF.
* You can select values from 0-127, or “-" which means “send nothing.”
» There is no need to save CS MIDI settings. They take effect immediately.

See the “The Footswitch Functions Guide” for more on Control Switches.

@ Control Switches can be triggered manually using a footswitch, or automatically by Scenes.

—
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MIDI REFERENCE TABLES

MIDI BANK & PROGRAM CHANGE

The following table lists the MIDI Bank and Program Change messages required to select FM9 presets.
MIDI Bank Select (CC#0) Value , Midi Program Change = FM9 Preset Number.

0,0 =0 0,42 = 42 0,84 = 84 0,126 = 126 1,40 = 168
0,1 =1 0,43 = 43 0,85 = 85 0,127 = 127 1,41 = 169
0,2 =2 0,44 = 44 0,86 = 86 1,0 = 128 1,42 = 170
0,3 =3 0,45 = 45 0,87 = 87 1,1 =129 1,43 = 17
0,4 =4 0,46 = 46 0,88 = 88 1,2 = 130 1,44 = 172
0,5 =5 0,47 = 47 0,89 = 89 1,3 = 131 1,45 = 173
0,6 =6 0,48 = 48 0,90 = 90 1,4 = 132 1,46 = 174
07 =17 0,49 = 49 0,91 = 9 1,5 = 133 1,47 = 175
0,8 =38 0,50 = 50 0,92 = 92 1,6 = 134 1,48 = 176
0,9 =9 0,51 = 51 0,93 = 93 1,7 =135 1,49 = 177
0,170 = 10 0,52 = 52 0,94 = 94 1,8 = 136 1,50 = 178
0,11 =M 0,53 = 53 0,95 = 95 1,9 = 137 1,51 = 179
0,12 = 12 0,54 = 54 0,96 = 96 1,10 = 138 1,52 = 180
0,13 = 13 0,55 = 55 0,97 = 97 1,11 = 139 1,53 = 181
0,14 = 14 0,56 = 56 0,98 = 98 1,12 = 140 1,54 = 182
0,15 = 15 0,57 = 57 0,99 = 99 1,13 = 1M 1,55 = 183
0,16 = 16 0,58 = 58 0,700 = 100 1,14 = 142 1,56 = 184
0,177 = 17 0,59 = 59 0,101 = 101 1,15 = 143 1,57 = 185
0,18 = 18 0,60 = 60 0,102 = 102 1,16 = 144 1,58 = 186
0,19 =19 0,61 = 61 0,703 = 103 1,17 = 145 1,59 = 187
0,20 = 20 0,62 = 62 0,104 = 104 1,18 = 146 1,60 = 188
0,21 = 21 0,63 = 63 0,105 = 105 1,19 = 147 1,61 = 189
0,22 = 22 0,64 = 64 0,706 = 106 1,20 = 148 1,62 = 190
0,23 = 23 0,65 = 65 0,107 = 107 1,21 = 149 1,63 = 191
0,24 = 24 0,66 = 66 0,108 = 108 1,22 = 150 1,64 = 192
0,25 = 25 0,67 = 67 0,709 = 109 1,23 = 151 1,65 = 193
0,26 = 26 0,68 = 68 0,110 = 110 1,24 = 152 1,66 = 194
0,27 = 27 0,69 = 69 0,111 = 111 1,25 = 153 1,67 = 195
0,28 = 28 0,70 = 70 0,112 = 112 1,26 = 154 1,68 = 196
0,29 = 29 0,71 =T 0,113 = 113 1,27 = 155 1,69 = 197
0,30 = 30 0,72 = 72 0,114 = 114 1,28 = 156 1,70 = 198
0,31 = 31 0,73 =73 0,115 = 115 1,29 = 157 1,71 = 199
0,32 = 32 0,74 = 74 0,116 = 116 1,30 = 158 1,72 = 200
0,33 = 33 0,75 =75 0,117 = 117 1,31 = 159 1,73 = 201
0,34 = 34 0,76 = 76 0,118 = 118 1,32 = 160 1,74 = 202
0,35 = 35 0,77 =77 0,119 = 119 1,33 = 161 1,75 = 203
0,36 = 36 0,78 = 78 0,120 = 120 1,34 = 162 1,76 = 204
0,37 = 37 0,79 =79 0,121 = 121 1,35 = 163 1,77 = 205
0,38 = 38 0,80 = 80 0,122 = 122 1,36 = 164 1,78 = 206
0,39 = 39 0,81 = 81 0,123 = 123 1,37 = 165 1,79 = 207
0,40 = 40 0,82 = 82 0,124 = 124 1,38 = 166 1,80 = 208
0,41 = 41 0,83 = 83 0,125 = 125 1,39 = 167 1,81 = 209
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1,82 = 210 2,6 = 262 2,58 = 314 2,110 = 366 3,34 = 418 3,86 = 470
1,83 = 21 2,7 = 263 2,59 = 315 2,111 = 367 3,35 = 419 3,87 = 471
1,84 = 212 2,8 = 264 2,60 = 316 2,112 = 368 3,36 = 420 3,88 = 472
1,8 = 213 2,9 = 265 2,61 = 317 2,113 = 369 3,37 = 421 3,80 = 473
1,86 = 214 2,10 = 266 2,62 = 318 2,114 = 370 3,38 = 422 3,90 = 474
1,87 = 215 2,11 = 267 2,63 = 319 2,115 = 371 3,39 = 423 3,91 = 475
1,88 = 216 2,12 = 268 2,64 = 320 2,116 = 372 3,40 = 424 3,92 = 476
1,8 = 217 2,13 = 269 2,65 = 321 2,117 = 373 3,41 = 425 3,93 = 477
1,90 = 218 2,14 = 270 2,66 = 322 2,118 = 374 3,42 = 426 3,94 = 478
1,91 = 219 2,15 = 271 2,67 = 323 2,119 = 375 3,43 = 427 3,95 = 479
1,92 = 220 2,16 = 272 2,68 = 324 2,120 = 376 3,44 = 428 3,96 = 480
1,93 = 221 2,17 = 273 2,69 = 325 2,121 = 377 3,45 = 429 3,97 = 481
1,94 = 222 2,18 = 274 2,70 = 326 2,122 = 378 3,46 = 430 3,98 = 482
1,95 = 223 2,19 = 275 2,71 = 327 2,123 = 379 3,47 = 431 3,99 = 483
1,96 = 224 2,20 = 276 2,72 = 328 2,124 = 380 3,48 = 432 3,100 = 484
1,97 = 225 2,217 =271 2,73 = 329 2,125 = 381 3,49 = 433 3,101 = 485
1,98 = 226 2,22 = 278 2,74 = 330 2,126 = 382 3,50 = 434 3,102 = 486
1,99 = 227 2,23 =279 2,75 = 331 2,127 = 383 3,51 = 435 3,103 = 487
1,100 = 228 2,24 = 280 2,76 = 332 3,0 = 384 3,52 = 436 3,104 = 488
1,101 = 229 2,25 = 281 2,77 = 333 3,1 = 385 3,53 = 437 3,105 = 489
1,102 = 230 2,26 = 282 2,78 = 334 3,2 = 386 3,54 = 438 3,106 = 490
1,103 = 231 2,27 = 283 2,79 = 335 3,3 = 387 3,55 = 439 3,107 = 491

1,104 = 232 2,28 = 284 2,80 = 336 3,4 = 388 3,56 = 440 3,108 = 492
1,106 = 233 2,29 = 285 2,81 = 337 3,5 = 389 3,57 = 441 3,109 = 493
1,106 = 234 2,30 = 286 2,82 = 338 3,6 = 390 3,58 = 442 3,110 = 494
1,107 = 235 2,31 = 287 2,83 = 339 3,7 = 391 3,59 = 443 3,111 = 495
1,108 = 236 2,32 = 288 2,84 = 340 3,8 = 392 3,60 = 444 3,112 = 496
1,109 = 237 2,33 = 289 2,85 = 341 3,9 = 393 3,61 = 445 3,113 = 497
1,110 = 238 2,34 = 290 2,86 = 342 3,10 = 394 3,62 = 446 3,114 = 498
1,111 = 239 2,35 = 291 2,87 = 343 3,11 = 395 3,63 = 447 3,115 = 499
1,112 = 240 2,36 = 292 2,88 = 344 3,12 = 39 3,64 = 448 3,116 = 500
1,113 = 241 2,37 = 293 2,89 = 345 3,13 = 397 3,65 = 449 3,117 = 501
1,114 = 242 2,38 = 294 2,90 = 346 3,14 = 398 3,66 = 450 3,118 = 502
1,115 = 243 2,39 = 295 2,91 = 347 3,15 = 399 3,67 = 451 3,119 = 503
1,116 = 244 2,40 = 296 2,92 = 348 3,16 = 400 3,68 = 452 3,120 = 504
1,117 = 245 2,41 = 297 2,93 = 349 3,17 = 401 3,69 = 453 3,121 = 505
1,118 = 246 2,42 = 298 2,94 = 350 3,18 = 402 3,70 = 454 3,122 = 506
1,119 = 247 2,43 = 299 2,95 = 351 3,19 = 403 3,71 = 455 3,123 = 507
1,120 = 248 2,44 = 300 2,96 = 352 3,20 = 404 3,72 = 456 3,124 = 508
1,121 = 249 2,45 = 301 2,97 = 353 3,21 = 405 3,73 = 457 3,125 = 509
1,122 = 250 2,46 = 302 2,98 = 354 3,22 = 406 3,74 = 458 3,126 = 510
1,123 = 251 2,47 = 303 2,99 = 355 3,23 = 407 3,75 = 459 3,127 = 511
1,124 = 252 2,48 = 304 2,100 = 356 3,24 = 408 3,76 = 460

1,125 = 253 2,49 = 305 2,101 = 357 3,25 = 409 3,77 = 461

1,126 = 254 2,50 = 306 2,102 = 358 3,26 = 410 3,78 = 462

1,127 = 255 2,51 = 307 2,103 = 359 3,27 = 411 3,79 = 463

2,0 = 256 2,52 = 308 2,104 = 360 3,28 = 412 3,80 = 464

2,1 = 257 2,53 = 309 2,105 = 361 3,29 = 413 3,81 = 465
2,2 = 258 2,54 = 310 2,106 = 362 3,30 = 414 3,82 = 466
2,3 =259 2,55 = 311 2,107 = 363 3,31 = 415 3,83 = 467

2,4 = 260 2,56 = 312 2,108 = 364 3,32 = 416 3,84 = 468
2,5 = 261 2,57 = 313 2,109 = 365 3,33 = 417 3,85 = 469

125



14 ADDITIONAL TOPICS

CC VALUE TO SCENE

When selecting Scenes using the global options found on the Other page of the MIDI/Remote menu under SETUP,
the value of the designated CC# determines the Scene:

0........ 1 16....... 1 32....... 1 48....... 1 64....... 1 80....... 1T 96....... 1T 1M2...... 1
T 2 17....... 2 33....... 2 49....... 2 65...... 2 81....... 2 97....... 2 1M3...... 2
2........ 3 18....... 3 34....... 3 50....... 3 66....... 3 82....... 3 98....... 3 114...... 3
3. 4 19....... 4 35....... 4 51....... 4 67....... 4 83....... 4 99....... 4 115...... 4
4........ 5 20....... 5 36....... 5 52....... 5 68....... 5 84....... 5 100...... 5 116...... 5
S5 ... 6 21....... 6 37....... 6 53....... 6 69....... 6 85...... 6 101...... 6 117...... 6
6........ 7 22....... 7 38....... 7 54....... 7 70....... 7 86....... 7 102...... 7 118...... 7
7.0 .. 8 23....... 8§ 39....... 8 55....... 8 T71....... 8 87....... 8§ 103...... 8 119...... 8
8........ 1T 24....... 1 40....... 1 56....... 1 72....... 1 88....... 1 104...... 1 120...... 1
9........ 2 25....... 2 4. 2 57....... 2 T73....... 2 89....... 2 105...... 2 121...... 2
10....... 3 26....... 3 42....... 3 58....... 3 T4....... 3 90....... 3 106...... 3 122...... 3
Mmoo 4 27....... 4 43....... 4 59....... 4  T75....... 4 91....... 4 107...... 4 123...... 4
12....... 5 28....... 5 44 ... 5 60....... 5 76....... 5 92....... 5 108...... 5 124...... 5
13....... 6 29....... 6 45....... 6 61....... 6 77....... 6 93....... 6 109...... 6 126...... 6
14....... 7 30....... 7 46....... 7 62....... 7 78....... 7 94....... 7 110...... 7 126...... 7
15....... 8 31....... 8 47....... 8 63....... 8 79....... 8 95...... 8 111...... 8 127...... 8
CC VALUE TO CHANNEL

When changing Channels using the global options found on the Channel page of the MIDI/Remote menu under
SETUP, the value of the designated CC# determines the Channel:

0........ A T6....... A 32....... A 48....... A 64...... A 80....... A 96....... A 112...... A
T B 17....... B 33...... B 49....... B 65....... B 81....... B 97....... B 113...... B
2. C 18....... C 34...... C 50....... C 66....... C 82....... C 98...... C 14...... C
3. D 19....... D 35...... D 51....... D 67....... D 83...... D 99....... D 15...... D
4........ A 20....... A 36....... A 52....... A 68....... A 84....... A 100...... A 116...... A
S B 21....... B 37....... B 583....... B 69....... B 85...... B 101...... B 117...... B
6........ C 22....... C 38...... C b54...... C 70....... C 86....... c 102..... C 18...... C
7........ D 23....... D 30....... D 55...... D 71....... D 87....... D 103...... D 119...... D
8........ A 24...... A 40....... A 56....... A T72....... A 88....... A 104...... A 120...... A
9........ B 25....... B 41....... B 57....... B 73....... B 89....... B 105...... B 121...... B
10....... C 26....... C 42....... C 58...... C 74...... C 90....... C 106...... C 122...... C
M. D 27....... D 43....... D 59....... D 75....... D 91....... D 107...... D 123...... D
12....... A 28....... A 44....... A 60....... A T76....... A 92....... A 108...... A 124...... A
13....... B 29....... B 45....... B 61....... B 77....... B 93....... B 109...... B 125...... B
14....... C 30....... C 46....... C 62....... C 78....... C 94...... C 110...... C 126...... C
15....... D 31....... D 47....... D 63....... D 79....... D 95....... D 11...... D 127...... D
126
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15 SPECIFICATIONS

INSTRUMENT INPUT

Connectors:
Impedance:
Max. Input Level:

ANALOG INPUTS 2 & 3

Rear 1/4" phone jack, unbalanced, with “Secret Sauce”

1MQ
+16 dBu

Connectors: (2) 1/4" phone jack balanced (TRS)
Impedance: 1 MQ

Max. Input Level: +20 dBu

A/D CONVERSION

Bit Depth: 24 bits

Sample Rate: 48 kHz

Dynamic Range: 114 dB

Frequency Response:

20 - 20kHz, -0.01 to +0.01 dB

Crosstalk: 110dB (typ) Interchannel Isolation
ANALOG OUTPUT 1
Connectors: (2) XLR balanced with Ground Lift
Selectable between -10 dBV and +4 dBu in software
and (2) 1/4" phone jack unbalanced (Humbuster™)
Impedance: 600 Q
Max Output Level: +20 dBu
ANALOG OUTPUT 2
Connectors: (2) XLR balanced with Ground Lift
Selectable between -10 dBV and +4 dBu in software
Impedance: 600 Q
Max Output Level: +20 dBu

ANALOG OUTPUT 3 Unity Gain with Out 3 knob turned fully clockwise
Connectors: (2) 1/4” phone jack unbalanced (Humbuster™)
Impedance: 600 Q

Max Output Level: +20 dBu

HEADPHONE OUTPUT

Connector: 1/4" stereo phone jack

Impedance: 35Q

D/A CONVERSION

Dynamic Range: 114 dB

Frequency Response:

20Hz-20kHz, +0 /-1 dB

DIGITAL INPUT & OUTPUT

Connectors: RCA Coaxial Type for S/PDIF
Format: Uncompressed PCM

Sample Rate: 48 kHz fixed

—
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USB AUDIO
Format: USB Audio Class 2.0 compliant
Channels: 8 input, 8 output
USB Audio Clock: 48 kHz fixed
MIDI INTERFACE
Input Connector: (1) 5-pin DIN
Out/Thru Connector: (1) 5-pin DIN
MIDI Over USB YES
PEDAL INTERFACE
Connectors: (3) 1/4" TRS phone jack
Format: Pedal: 10-100 kQ max or Switch: SPST, momentary or latching
FASLINK Il INTERFACE
Connectors: (1) XLR-F

WARNING: Connect ONLY to the FASLINK Il connector on a Fractal Audio FC controller
GENERAL
Finish: Powder-coated steel chassis
Controls: 12 buttons, 9 knobs (6 with “push” functions)
Display: 800x480 high contrast color LCD
Dimensions: 20.2"W. x 3.5"H.x9.3"D.

51.3cm W. x 8.9cm H. x 23.7cm D.

Weight: 11 Ibs 15.8 0z (5.44 kg)
Input Voltage: 90-264 VAC, 47 - 63 Hz (universal input)
Power Consumption: <40 W
Backup Battery Life: >10 years
Backup Battery Type: CR-2032
Ventilation: Onboard fan with side and bottom venting. WARNING: Do not block vent holes!
ENVIRONMENTAL

Operating Temperature:

Storage Temperature:
Humidity:

32t0 122 °F (0 to 50 °C)
-22t0 167 °F (-30to 70 °C)
Max. 90% non-condensing

—
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15 SPECIFICATIONS

MIDI IMPLEMENTATION

The FM9 features a robust MIDI implementation detailed below.

Function Tx Rx | Remarks
Basic Channel Default 1 1
Changed 1-16 | 1-16
Note Number True Voice X X
Velocity Note ON X X
Note OFF X X
After Touch Keys X X
Channels X X
Pitch Bend X X
Control Change 0 0 Receivable CCs are globally soft-assigned to
functions via the MIDI/Remote menu under SETUP.
These include Input and Output volumes, Tap Tempo,
Tuner, 16 “External Controllers” (assignable as
modifiers to one or more parameters on a per-preset
basis), some Scene functions, all Looper functions,
and all block BYPASS and CHANNEL switches.
MIDI CC Transmit is performed using the Scene MIDI
Block or Control Switch MIDI.
Program Change True Number 0 0 The FM9 can transmit PC messages upon preset
Bank Select X 0 | change, or via the Scene MIDI Block or Control
Switch MIDI.
System Exclusive Fractal Audio 0 0 | SysExis used extensively for FM9-Edit.
Real time 0 X
Non-Real time X X
System Common Song Position X X
Song Select X X
Tune Request X X
System Real time Clock X 0 [ FM9 Global Tempo syncs to MIDI Clock.
Commands X X FM9 does not transmit MIDI clock.
Auxiliary Messages | Local ON/OFF X X
All Notes OFF X X
Active Sense X X
Reset X X

—
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WARRANTY

WARRANTY

Fractal Audio Systems warrants that your new Fractal Audio Systems product shall be free of defects in materials
and workmanship for a period of one (1) year from the original date of purchase.

During the warranty period, Fractal Audio Systems shall, at its sole option, either repair or replace any product that
proves to be defective upon inspection by Fractal Audio Systems.

Fractal Audio Systems reserves the right to update any unit returned for repair and to change or improve the
design of the product at any time without notice. Fractal Audio Systems reserves the right to use reconditioned
parts and assemblies as warranty replacements for authorized repairs. This warranty is extended to the original
retail purchaser for units purchased directly from Fractal Audio Systems or one of its authorized distributors or
resellers.

This is your sole warranty. Fractal Audio Systems does not authorize any third party, including any dealer or sales
representative, to assume any liability on behalf of Fractal Audio Systems or to make any warranty for Fractal
Audio Systems. Fractal Audio Systems may, at its option, require proof of original purchase date in the form of a
dated copy of original authorized dealer’s invoice or sales receipt. Service and repairs of Fractal Audio Systems
products are to be performed only at the Fractal Audio Systems factory or a Fractal Audio Systems authorized
service center. Fractal Audio Systems may require advanced authorization of repairs to authorized service
centers. Unauthorized service, repair or modification will void this warranty.

DISCLAIMER AND LIMITATION OF WARRANTY

THE FOREGOING WARRANTY IS THE ONLY WARRANTY GIVEN BY FRACTAL AUDIO SYSTEMS AND IS IN LIEU OF
ALL OTHER WARRANTIES. ALL IMPLIED WARRANTIES, INCLUDING WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR ANY PARTICULAR PURPOSE, EXCEEDING THE SPECIFIC PROVISIONS OF THIS WARRANTY ARE
HEREBY DISCLAIMED AND EXCLUDED FROM THIS WARRANTY. UPON EXPIRATION OF THE APPLICABLE EXPRESS
WARRANTY PERIOD (1 YEAR), FRACTAL AUDIO SYSTEMS SHALL HAVE NO FURTHER WARRANTY OBLIGATION OF
ANY KIND, EXPRESS OR IMPLIED. FRACTAL AUDIO SYSTEMS SHALL IN NO EVENT BE LIABLE FOR ANY SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES SUFFERED BY THE PURCHASER OR ANY THIRD PARTY, INCLUDING
WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS OR BUSINESS, OR DAMAGES RESULTING FROM USE OR
PERFORMANCE OF THE PRODUCT, WHETHER IN CONTRACT OR IN TORT. FRACTAL AUDIO SYSTEMS SHALL NOT
BE LIABLE FOR ANY EXPENSES, CLAIMS, OR SUITS ARISING OUT OF OR RELATING TO ANY OF THE FOREGOING.
Some states do not allow the exclusion or limitation of implied warranties so some of the above limitations and
exclusions may not apply to you. This warranty gives you specific legal rights, and you may also have other rights,
which vary, from state to state. This warranty only applies to products sold and used in the USA and Canada.
Fractal Audio Systems shall not be liable for damages or loss resulting from the negligent or intentional acts of
the shipper or its contracted affiliates. You should contact the shipper for proper claims procedures in the event
of damage or loss resulting from shipment.
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EULA

EULA

BY ACCEPTING, INSTALLING OR USING ANY PART OF THIS PRODUCT YOU ARE CONSENTING TO ALL OF THE TERMS AND CONDITIONS OF THIS ENTIRE END USER LICENSE AGREEMENT (“EULA"). IF YOU
DO NOT AGREE TO ALL THE TERMS AND CONDITIONS OF THIS ENTIRE AGREEMENT, ARE UNABLE OR UNWILLING COMPLY WITH THESE TERMS AND CONDITIONS, YOU MUST DISCONTINUE USE OF THE
PRODUCT IMMEDIATELY AS YOU HAVE NO AUTHORITY OR LICENSE TO USE THE PRODUCT.

TERMS AND CONDITIONS
1) GRANT OF LICENSE FOR PRE INSTALLED OR USER UPGRADED FIRMWARE (“THE SOFTWARE")

Subject to the terms and conditions set forth herein, Fractal Audio Systems, (“FAS”) grants you an individual, personal, non-sub licensable, nonexclusive license to use this product in accordance with the
applicable end user documentation, if any (the “License”). The user will not, directly or indirectly, reverse engineer, decompile, disassemble or otherwise attempt to discover the source code or underlying
ideas or algorithms of the Software; modify, translate, or create derivative works based on the Software; or copy (except for archival purposes), rent, lease, distribute, assign, or otherwise transfer rights to the
Software (except as expressly authorized by this Agreement); remove any proprietary notices, comments, terms and conditions and or labels on or in the Software. As between the parties, you acknowledge
that FAS and its licensors retain their respective ownership of the Software, any portions or copies thereof, and all rights therein throughout the world. Upon termination of this Agreement for any reason, the
License and all rights granted to you under this Agreement will terminate and you will cease to use the Software. You may permanently transfer the limited rights of use of the Software granted to you under
this Agreement only as part of a permanent sale or transfer of the hardware device containing the software, and only if the recipient agrees to be bound by the terms and conditions of this Agreement. You
acknowledge that you have no rights in or to, and may not transfer or otherwise authorize the use of, any “beta” or “preview” software of FAS and its licensors. THIS LIMITED LICENSE TO USE AND TRANSFER
THE SOFTWARE IS PROVIDED AS-IS AND IS SUBJECT TO THE RESTRICTIONS, INDEMNITY AND WARRANTY DISCLAIMERS AND LIMITATIONS OF LIABILITY SET FORTH BELOW.

2) RESTRICTIONS, WARRANTY DISCLAIMERS AND INDEMNITY OBLIGATION AGREED TO BY YOU IN EXCHANGE FOR LIMITED GRANT OF LICENSE.

YOU WILL ONLY USE THE SOFTWARE FOR LAWFUL PURPOSES AND IN COMPLIANCE WITH ALL APPLICABLE LAWS. YOU HEREBY AGREE TO DEFEND AND INDEMNIFY FAS AND ITS LICENSORS AGAINST ANY
CLAIM OR ACTION THAT ARISES FROM YOUR USE OF THE SOFTWARE IN AN UNLAWFUL MANNER (INCLUDING, WITHOUT LIMITATION, ANY CLAIM OR ACTION ALLEGING INFRINGEMENT OF ANY PATENT,
COPYRIGHT, TRADEMARK, TRADE SECRET, OR OTHER INTELLECTUAL PROPERTY; UNFAIR COMPETITION; VIOLATION OF GENERAL BUSINESS LAWS; OR VIOLATION OF ANY OTHER LAWS OR RIGHTS) OR ANY
OTHER USE OF THE SOFTWARE NOT EXPRESSLY AUTHORIZED PURSUANT TO THIS AGREEMENT.

3) IMPULSE RESPONSE EXPORT FOR COMMERCIAL USE

Offering for sale any Impulse Response data (e.g. “Tone Match Export/Save/Dump”, “User Cab Export/Save/Dump”) created, converted or modified using Fractal Audio Systems hardware and/or software
requires a commercial use license. Recording studios, consultants, and other commercial entities may use these features in conjunction with work performed for their commercial customers, but the resulting
data files created may not be offered for sale or gifted to their commercial customers or other third parties without a commercial license from FAS and its licensors where applicable. Contact sales@
fractalaudio.com to obtain a commercial license.

4) IMPULSE RESPONSE DATA EXPORT FOR NON-COMMERCIAL USE

You are free to export Impulse Response data for non-commercial use. This includes producing, converting, or modifying Impulse Response data for yourself, or offering/distributing such data at no charge to
third parties. Files created without a commercial license cannot be included for free with another product or package that is offered for sale. Contact sales@fractalaudio.com to obtain a commercial license.

5) SUPPORT

Subject to the terms hereof, FAS will provide you with e-mail support services for the Software. Under no circumstances will FAS have any obligation to provide you with hard-copy documentation, upgrades,
enhancements, modifications, or telephone support for the Software.

6) TERMINATION

This Agreement is effective until terminated. Either party may terminate this Agreement upon written notice to the other party. FAS may also terminate this Agreement immediately, without prior notice or
liability, if you breach any of the terms or conditions of this Agreement. All sections of this Agreement which by their nature should survive termination will survive termination, including, without limitation,
warranty disclaimers and limitations of liability and limitations of use and transfer of the Software.

7) WARRANTY DISCLAIMER

The software is provided as is without warranty of any kind. FAS disclaim all warranties, expressed or implied, including but not limited to implied warranties, fitness for a particular purpose, and non-
infringement. Some states do not allow limitations on how long an implied warranty lasts, so the above limitation may not apply to you.

8) LIMITATION OF LIABILITY

NOTWITHSTANDING ANYTHING CONTAINED IN THIS AGREEMENT OR OTHERWISE, YOU AGREE THAT FAS AND ITS LICENSORS WILL NOT BE LIABLE WITH RESPECT TO THE SUBJECT MATTER OF THIS
AGREEMENT UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY, INFRINGEMENT OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY INCIDENTAL, CONSEQUENTIAL, EXEMPLARY OR PUNITIVE
DAMAGES OF ANY KIND. SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE MAY NOT APPLY TO YOU.

9) EXPORT RESTRICTIONS

You acknowledge that the Software, or any part thereof, or any process or service that is the direct product of the Software (the foregoing collectively referred to as the “Restricted Components”) are of U.S.
origin. You agree to comply with all applicable international and national laws that apply to these products, including the U.S. Export Administration Regulations, as well as end-user, end-use and destination
restrictions issued by U.S. and other governments.

10) MISCELLANEOUS

The failure of either party to exercise in any respect any right provided for herein will not be deemed a waiver of any further rights hereunder of FAS and or its licensors. If any provision of this Agreement

is found to be unenforceable or invalid, that provision will be limited or eliminated to the minimum extent necessary so that this Agreement will otherwise remain in full force and effect and enforceable.

This Agreement will be governed by and construed in accordance with the laws of the state of New Hampshire without regard to the conflict of laws provisions thereof. You agree that this Agreement is the
complete and exclusive statement of the mutual understanding of the parties and supersedes and cancels all previous written and oral agreements, communications and other understandings relating to the
subject matter of this Agreement, and that all modifications to this EULA, or any commercial license that you may have obtained from FAS and or its licensors must be in a writing signed by you, FAS and or its
licensors, where applicable, except as otherwise provided herein. No agency, partnership, joint venture, or employment is created as a result of this Agreement and you do not have any authority of any kind to
bind FAS and or its licensors in any respect whatsoever. In any action or proceeding to enforce rights under this Agreement, the prevailing party will be entitled to recover costs and attorneys’ fees. All notices
under this Agreement will be in writing and will be deemed to have been duly given when received, if personally delivered; when receipt is electronically confirmed, if transmitted by facsimile or e-mail; the day
after it is sent, if sent for next day delivery by recognized overnight delivery service; and upon receipt, if sent by certified or registered mail, return receipt requested.
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